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About this guide

The One Identity Manager Operational Guide provides an overview of the tasks and
features that will be of assistance to you during normal operation of One Identity Manager.

The guide explains how to analyze and monitor changes to data in the Manager. It
describes how you schedule activation times for operations. Basic tasks in

One Identity Manager, such as editing schedules and mail templates as well as creating
password policies, are explained. The guide also describes simple procedures that are used
to export and import application data.

It explains how to declare changes to the configuration in the system, how to check data
consistency and how to exchange custom changes between the development database,
test database, and production database.

This guide is intended for end users, system administrators, consultants, analysts, and any
other IT professionals using the product.

NOTE: This guide describes One Identity Manager functionality available to the default
user. It is possible that not all the functions described here are available to you. This
depends on your system configuration and permissions.

This guide does not describe the Operations Support Web Portal. For information about
this, see the One Identity Manager Operations Support Web Portal User Guide.

Available documentation

You can access One Identity Manager documentation in the Manager and in the Designer by
selecting the Help > Search menu item. The online version of One Identity Manager
documentation is available in the Support portal under Technical Documentation. You will
find videos with additional information at www.YouTube.com/Oneldentity.

@NE IDENTITY One Identity Manager 9.3 Operational Guide
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Simulating data changes in the
Manager

Using the simulation mode in the Manager, you can record and analyze the effects of
comprehensive data changes to begin with before finally applying the changes.

The following information is recorded during the simulation:
e Calculation tasks for the DBQueue Processor resulting from the change
e Trigger changes that result from the change
e Processes that are generated as a result of the change

e Objects that are affected by the change

Detailed information about this topic

e Prerequisites for simulation in the Manager on page 9
e Starting and ending simulation in the Manager on page 10
e Evaluating the simulation data on page 11

e Exporting simulation data on page 13

Prerequisites for simulation in the
Manager

To use the simulation mode in the Manager, the following prerequisites apply:
e A user with a minimum access level of Configuration user is required.
e Users require the Common_Simulation program function.

e To ensure that the users can export the simulation data, enable the Common |
Simulation | ExportReport configuration parameter in the Designer.

@NE IDENTITY One Identity Manager 9.3 Operational Guide
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Starting and ending simulation in the
Manager

'y

CAUTION: You should only use the simulation mode in exceptional
circumstances. During a simulation, the objects you are editing are locked
for other users. Work on individual administration tools may be restricted.
Under certain circumstances, the One Identity Manager Service stops
running further processes during the simulation phase. Depending on the
scope of the changes, the entire One Identity Manager environment can
come to a standstill.

To run a simulation in Manager:

In the Manager, select Database > Start simulation.
Confirm the security prompt with OK.
The program switches into simulation mode.

NOTE: The enable simulation mode is displayed in Manager by the symbol & in the
status bar and a red status bar displayed.

Make your desired changes.
To stop the simulation, click Database > Stop simulation in the Manager menu.
The program switches to standard working mode and shows the simulation log.

(Optional) After stopping the simulation, you can save the changes. In the Manager,
select the Object > Save or Object > Specify activation time menu item.

NOTE: To prevent an excessively long blockade of the overall system, simulation mode
ends after 5 minutes if no data change is saved.

Related topics

e Prerequisites for simulation in the Manager on page 9
e Evaluating the simulation data on page 11

e Exporting simulation data on page 13
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Evaluating the simulation data

When the simulation ends, the recorded modifications are loaded and displayed in the
Manager as a protocol.

Table 1: Logging simulation data

View Description Displayed information

Overview This gives you an overview of which Number of applied changes for
actions the applied changes will trigger. each action.

You can export the simulation data and
display the report.

DBQueue The DBQueue log shows the following Operation Calculation tasks
information. You can show the additional to be run.
information from the context menu.

Sort order  Sort order to
process the
calculation task.

Process ID Unique process
ID.

Object Unique object
ID.

Child object Unique ID of the
child object.

Generated Shows processes and process steps Process Name of the

process generated during simulation due to the generated
changes. The individual properties of the process.
processes and process steps are also
displayed with their actual values. Process Name of the

steps generated
process step.

Property Processes
property or
process step
property.

Value Property value.

Trigger Shows all changes made to objects that Table Display text of

changes have been triggered during the simulation. the table to

(GNE IDENTITY

Quest

which the record
belongs. This is
used to group
the objects.
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View Description Displayed information

Object

Column

Old value

New value

Changed Shows objects and their properties if they  Table
objects were affected by the changes made during
simulation.

Object

Column

Old value

New value

Related topics

e Prerequisites for simulation in the Manager on page 9
e Starting and ending simulation in the Manager on page 10

e Exporting simulation data on page 13

Object affected
by the change.

Column that was
changed.

Column value
before the
change.

Column value
after the change.

Display text of
the table to
which the record
belongs. This is
used to group
the objects.

Object affected
by the change.

Column that was
changed.

Column value
before the
change.

Column value
after the change.
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Exporting simulation data

You can export the simulation log as a report in PDF format.

To export and display the simulation data as a report:

In the simulation log, select the Overview view.
2. Click the k&l button next to the list of actions.

Use the file browser to select the directory path for the report and enter a file name

for the report.
4. To generate the PDF file, click Save.

5. Click Yes to show the report now.

Related topics

» Prerequisites for simulation in the Manager on page 9
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Scheduling operations activation
times

In addition, in the Manager, you can create, change, or delete an object at a specified point
in time. The DBQueue Processor checks regularly whether scheduled operations exist.
When the scheduled time is reached, the operation is run by the

One Identity Manager Service.

To run operations at a specified point in time

e In the Designer, check if the Common | DeferredOperation configuration
parameter is set. Check the value of the configuration parameter and adjust it
if necessary.

Permitted values are:

e 1 (default): In the Manager, you can schedule the activation time for creating,
changing, or deleting an object.

e 0: Deferred deleted operation are carried out, such as, deferred deletion of user
accounts. It is not possible to schedule the activation time in the Manager.

You must recompile the database if you enable or disable the configuration
parameter.

If you disable the configuration parameter at a later date, model components and
scripts that are no longer required, are disabled. SQL procedures and triggers are still
carried out. For more information about the behavior of preprocessor relevant config-
uration parameters and conditional compiling, see the One Identity Manager
Configuration Guide.

e In the Designer, check the Common | DeferredOperation |
AllowUpdateInInsertMode configuration parameter and adapt it to the
required behavior.

 If this configuration parameter is disabled, an error occurs during processing if
you try to insert an object that already exists in the database.

 If this configuration parameter is enabled, when you insert an object that
already exists in the database, the object is updated.

e In the Designer, check the Common | DeferredOperation |
IgnoreMissingOnDelete configuration parameter and adapt it to the required

@NE IDENTITY One Identity Manager 9.3 Operational Guide 14
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behavior.

 If this configuration parameter is disabled, an error occurs during processing if
you try to delete an object that no longer exists in the database.

» If this configuration parameter is enabled, missing objects are ignored
during deletion.

Related topics

* Planning activation times for actions in the Manager on page 15

» Displaying scheduled operations in the Manager on page 16

Planning activation times for actions in
the Manager

In addition, in the Manager, you can create, change, or delete an object at a specified
point in time.

To plan a activation time for creating and changing an object

1.

N oA wN

In the Manager, select the object for which you wish to specify an activation time.
Select the Change main data task.

Change the values you wish to edit.

Select the Object > Specify activation time menu item.

In the Activation time section, specify the date and time of the change.

In the Remarks section, enter additional information about running the operation.
Click Save.

To schedule a deletion time for an object

A A

In the Manager, select the object for which you wish to schedule a deletion time.
Select the Object > Set deletion time menu item.

In the Activation time section, specify the date and time for the deletion.

In the Remarks section, enter additional information about running the operation.
Click save.

Confirm the security prompt with Yes.

Related topics

» Displaying scheduled operations in the Manager on page 16

» Labeling input fields and assignments with planned changes on page 18
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Displaying scheduled operations in the
Manager

The scheduled operations with their activation times are displayed in an overview. If the
scheduled activation time of an operation has passed or an error occurred when the
operation ran, the corresponding entry is marked in red in the overview.

To display all scheduled operations
e Inthe Manager, click the Database > Show deferred operations menu item.

In the overview, the planned operation are displayed with the following information.

Table 2: Information on data changes

Information Meaning

Table Name of the table to which the data record belongs. This is used to
group the objects.

Object Object affected by the operation.

Operation Operation that is run for the object. Permitted operations are Add
object, Change object, Delete object, Generate event, and Call
method.

Activation time Time at which the operation should be run.

Comment Additional comment on the operation.
| TIP: Click a remark to show the remark in full.

Created by User who created the scheduled operation.

Table 3: Meaning of icons in the form toolbar

Icon Meaning

e} Load and display the selected object.

| 4 Run scheduled operations now

8 Delete selected objects.

&l Re-enable selected objects. If an error occurred during the operation, you can
run the change again.

e Reload the data.

h i Filter view.

@NE IDENTIOTY One Identity Manager 9.3 Operational Guide 16
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Related topics

» Limiting the display of scheduled operations on page 17

Limiting the display of scheduled

operations

To limit the information for scheduled operations using defined filter conditions, use
predefined filters. You can filter according to the statuses of the scheduled operations, or

by scheduled operations.

To limit the display of scheduled operations

1. Inthe Manager, click the Database > Show deferred operations menu item.

2. Inthe overview of schedule operations, open the Filter view menu.

3. Select one or more filters under the State or the Operation item.

TIP: To display all scheduled operations, go to the Filter view menu and

select Show all.

Table 4: Predefined filters
Filter

Meaning

State Outstanding
operations

Expired opera-
tions

Operation Create object
Change object
Delete object
Generate event

Calling methods

Show all

(GNE IDENTITY
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Shows or hides pending operations.

Shows or hides operations whose activation time has
already expired.

Shows or hides all entries with the Add object
operation.

Shows or hides all entries with the Change object
operation.

Shows or hides all entries with the Delete object
operation.

Shows or hides all entries with the Generate event
operation.

Shows or hides all entries with the call method
operation.

All scheduled operations are displayed.

One Identity Manager 9.3 Operational Guide 17
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Labeling input fields and assignments
with planned changes

In the Manager, input fields and assignments with changes planned for a specific time, are
labeled with additional icons. The new values are not shown for security reasons.

Table 5: Labeling of input fields and assignments with planned changes

Icon Meaning

_ The change in value is planned for a specific date and time. You can change the
value only at the specified time.

The change in value is planned for a specific date and time.

One Identity Manager 9.3 Operational Guide
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Re-applying templates in the
Manager

NOTE: Re-applying templates may result in a large number of dependent objects being
changed and processes being generated.

You can use templates in One Identity Manager to populate columns with default values or
to map a column value from another column. For more information about templates, see
the One Identity Manager Configuration Guide.

In the Manager, you can re-apply the templates to the objects. This may be necessary
if you have changed a template. In this case, column values determined by a template
are updated by re-applying it. Column values of an object are also filled even if they
are not visible on the current form in the Manager. Templates defined in customizers
are also run again.

To re-apply a template to an object in the Manager
In the Manager, select the object to which you wish to reapply the template.
Select the Change main data task.

In the menu, select the Object > Reapply templates menu item.

R W N R

Save the changes.
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Exporting data with the Manager

You can use the Manager to export application data. An export form in CSV format supports
the data export. You can process the data further using a program such as Microsoft Office
Excel or import it into another One Identity Manager database. You can export all data of a
base table. In addition, you can export the data of tables that are linked by a foreign key
relation to the base table.

You can save the export definition as a report that can be viewed and subscribed to in the
Web Portal.

| NOTE: To export data, user require the Common_DatabaseExport program function.

Detailed information about this topic

» Creating data exports in Manager on page 20
» Saving export definitions as simple reports on page 22
e Saving export definitions in files on page 23

» Saving export definitions in the user settings on page 24

Creating data exports in Manager

Create an export definition and export the data to further process it with something such as
Microsoft Office Excel or to import it into another One Identity Manager database.

NOTE: You can also export the file by selecting a menu item in the Manager navigation
view. By default, the entries on the result list of the selected menu item are applied to
the export. Under certain circumstances, the generated filter for the data set to be
exported cannot be edited using the database query wizard. In this case, change the
condition directly.

To create an export

1. In the Manager, select the Database > Export data menu item to open the
export form.

@NE IDENTITY One Identity Manager 9.3 Operational Guide
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In the Column selection pane in the Base table drop-down, select the table from
which the data is exported.

The database columns that can be exported are loaded and displayed in tabular form.
The columns of the selected base table are displayed. In addition, all tables linked by
a foreign key relation to the base table are displayed.

Select the columns that you wish to export and click the Export option.

TIP: To mark all columns, use the & button in the toolbar. To clear all selected
columns, click the [l button. You can use the B button to display the display names
or the technical names.

Use the Export display value option to set whether you wish to export actual
values from the column or the display name. This may be necessary for database
columns with special formatting, such as multilingual entries or a specified number of
decimal places.

(Optional) In the Columns to export pane, use the zi, 1, and ¥ buttons to adjust
the sort order of the export columns.

(Optional) In the Condition pane, create a condition for further limiting the data
records to be exported. The condition is defined as a valid where clause for database
queries. You can enter the SQL query directly or with a wizard. Click & next to the
field to open the wizard.

. Inthe Export data pane, select the time zone for the export and create a preview of
the export using the & button.

NOTE: If you are exporting dates, such as the date of birth or leaving date, you can
specify how blank dates are handled during export. To do this, use the button .

The records that meet the export criteria are displayed in tabular form. Change how
the data is sorted, if necessary. Click a column in the table header of the result list to
sort by the selected column.

NOTE: The sort order of the preview is not only used for display purposes, but also
affects the data export. The data is exported as displayed in the preview.

In the Export data pane, use the B button to start the export. Use the file browser
to select the directory path for the export and enter a file name for the export.

. To generate the .csv file, click Save.

Related topics

» Saving export definitions in the user settings on page 24

» Saving export definitions in files on page 23

» Saving export definitions as simple reports on page 22
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Saving export definitions as simple
reports

| NOTE: This function is only available if the Report Subscription Module is installed.

This creates a simple report using the export definition. This report can be displayed and
subscribed to in the Web Portal.
Prerequisite

e To create a simple report in the Manager, enable the Data export as report plugin
in the program settings in the Manager.

To create a simple report in the Manager

1. In the Manager, select the Database > Export data menu item to open the
export form.

2. Create the export.
3. Click B in the title bar of the export form.
4. Enable Simple list report.
5. Click the # button next to the report definition drop-down and enter the following
information:
e Name: Name of the report.
» Description: Additional information about the report.
6. Click OK.
7. Click Save.

You make this report available to Web Portal users. Assign the report to the identities. For
more information about editing reports and assigning them to identities, see the

One Identity Manager Report Subscriptions Administration Guide and the

One Identity Manager Web Portal User Guide.

You can use simple reports that you create in the Manager for statistics in the Manager's
info system. For more information about how to implement statistics in the user interface
for using in simple reports, see the One Identity Manager Configuration Guide.

Related topics

e Saving export definitions in the user settings on page 24
« Saving export definitions in files on page 23

» Creating data exports in Manager on page 20
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Saving export definitions in files

To make an export definition available to other users, save the export definition as
a .xml file.

To save the export definition to a file:

1. In the Manager, select the Database > Export data menu item to open the
export form.

2. Create the export.

3. Click B in the title bar of the export form.

4. Enable the Save to file option.

5. Open the file browser by pressing the button next to Filename, select the directory
path and enter a name for the export definition.

6. Click Save.
The .xml file is generated. This closes the file browser and displays the path and file
name under File name.

7. Click Save.

To load an export definition from a file:

1. In the Manager, select the Database > Export data menu item to open the
export form.

2. Click @ in the title bar of the export form.
Enable the Load from file option.

4. Open the file browser by pressing the button next to Filename, select the directory
path and the file with the export definition.

5. Click Open.

The .xml file is loaded. This closes the file browser and displays the path and file
name under File name.

6. Click Open.

Related topics

» Saving export definitions in the user settings on page 24
» Saving export definitions as simple reports on page 22

» Creating data exports in Manager on page 20
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Saving export definitions in the user
settings

You can save an export definition in the user account configuration and reload it from there.
If you store an export definition in the user account configuration, this export definition is
only available to you.

To save an export definition to the user settings:

1. In the Manager, select the Database > Export data menu item to open the
export form.

2. Create the export.

3. Click B in the title bar of the export form.

4. Enable the Save in user settings option.

5. Click the button Ef beside the Export name input field and enter a name for the
export definition..

6. Click Save.

To load an export definition from the user settings;

1. In the Manager, select the Database > Export data menu item to open the
export form.

Click @ in the title bar of the export form.
Enable the Load from user settings option.
Select the export definition from Export name.
Click Open.

v AW N

To delete an export definition from the user settings:

1. In the Manager, select the Database > Export data menu item to open the
export form.

Click B in the title bar of the export form.
Select Save in user settings.
Select the export definition from Export name.

Click @ next to Export name.

o Uk LN

To close the dialog, click Cancel.

Related topics

» Saving export definitions in files on page 23
» Saving export definitions as simple reports on page 22

» Creating data exports in Manager on page 20
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Analyzing data and data changes

In One Identity Manager, you can analyze data and data changes using different methods.

Reports

One Identity Manager provides several reports that present information about objects and
their relations to other objects in the One Identity Manager database. For example, there
are reports about identities and their user accounts, company structures, resources, and
system entitlements, attestation, and compliance rule violations integrated into

One Identity Manager. Identification, analysis, and summaries of relevant data are
supported with the help of these reports.

The reports analyze data from both the One Identity Manager database and the
One Identity Manager History Database. For more information, see Analyzing data changes
in reports and the TimeTrace on page 27.

Use the Report Editor to create reports. For more information, see the

One Identity Manager Configuration Guide. You can view reports in the Manager. For more
information, see Displaying reports in the Manager on page 26. Reports about system
configuration are supplied in the Designer. For more information, see the

One Identity Manager Configuration Guide.

Report subscriptions

You can also send reports to specified email addresses using scheduled subscriptions.
Web Portal users request subscribable reports and configure their own personal report
subscriptions. The reports are delivered to Web Portal users by email as specified in a
personally configured schedule.

For more information, see the One Identity Manager Report Subscriptions
Administration Guide and the One Identity Manager Web Portal User Guide.

TimeTrace

Use the TimeTrace function to track changes to an object that were made up to any point
in the past.

In its analysis, the TimeTrace function includes the data changes saved to the
One Identity Manager database as well as the records stored in a One Identity Manager
History Database. You can use this to find out who had which permissions at which point in
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time. You can apply historical data to the current object and restore the object to the status
prior to the change. For more information, see Analyzing data changes in reports and the
TimeTrace on page 27.

In the Manager, you can see the change data in the TimeTrace view. For more information,
see Displaying change information in the Manager's TimeTrace on page 28.

Statistics

Statistics are recalculated at regular intervals and visualized in the user interface in various
diagrams. This provides you with an overview of the system status at a glance.

In the Manager, you can see statistics in the Info system. For more information, see The
Info system in the Manager on page 30. More statistics are available in the Web Portal.

Displaying reports in the Manager

The Manager contains various reports about identities and their user accounts, company
structures, resources and system entitlements, attestations and compliance rule violation
evaluation.

To display a report in the Manager
1. In the Manager, select the object for which you want to see the report.
2. Inthe task view in the Reports section, select the report.
This generates and displays the report.
TIP:

e Use the tooltip in the task view to show a more detailed description of the report.
e You can find additional report in the My One Identity Manager category.
e You can cancel the report while it is generating by clicking Cancel button.

In the report form you can change the window size and switch between pages. The
following table shows other features.

Table 6: Functions for displaying reports

Button Description Shortcut
Print Print report. Ctrl + P
Save Save report. There are additional save options on the menu.

NOTE: A report can be exported in a given format with just
one click if it is configured to do so. For more information
about configuring reports, see the One Identity Manager
Configuration Guide.
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Button Description Shortcut

Send by Send report by email.

email

Page size Change page size. Ctrl + Shift
+S

Bookmarks Set bookmark. Ctrl + B

Parameters  Show the parameters applied when generating the report. Ctrl +
Enter

Find Search in the report. Ctrl + F

Full screen Show full screen preview. F2

Single page  Show a single page. F3

Page width Change the page width. F5

Fallback font for displaying reports

If reports have to be displayed in different languages, some characters may not be
displayed correctly in all the languages. Use the Common | UI |
ReportAlternateFontname configuration parameter to define a font that is available on
all web servers and clients. Then this font is used to display the reports. If necessary, set
the configuration parameter in the Designer and adjust the value.

Analyzing data changes in reports and
the TimeTrace

In reports and in the TimeTrace, an analysis is carried out of the data changes saved
in the One Identity Manager database and those stored in a One Identity Manager
History Database. You can use this to find out who had what permissions at which
point in time.

Figure 1: Analyzing data changes

—
-
ﬁ U Al‘chiving =
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Analvsis One Identity u
(Time'slfrace, Manager Database History Database
Reports)
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Prerequisite for analyzing historical data in reports and in the TimeTrace is the recording of
data changes within process monitoring. Data changes that are saved in the

One Identity Manager database, can be immediately included in the analysis. To use
archived data, the One Identity Manager History Database must be declared in the

One Identity Manager database.

Prerequisites for analyzing data changes

« The Common | ProcessState configuration parameter is set and a method for
recording the data changes with process monitoring is configured.

For more information about logging changes to data, see the One Identity Manager
Configuration Guide.

e To access archived data in the TimeTrace and in reports, the One Identity Manager
History Database must be declared in the One Identity Manager database.

For more information about declaring the One Identity Manager History Database
and archiving data, see the One Identity Manager Data Archiving
Administration Guide.

» To display the TimeTrace in the Manager, users require the Common_TimeTrace
program function.

e To evaluate of the effectiveness of the assignments (XIsInEffect column) in
reports, in the Designer check the Common | ProcessState | PropertylLog
| ShowEffectiveAssignmentsOnly configuration parameter and change it if
necessary.

e To display only the effective assignments when evaluating historical
assignments in reports, set the configuration parameter (default).

e To show all assignments as effective, regardless of their effectiveness, do not
set the configuration parameter.

NOTE: The effectiveness of assignments (XIsInEffect column) is logged in the
history as of One Identity Manager version 8.1.5. Older assignment data is always
presented as effective, regardless of its actual effectiveness.

Related topics

e Displaying change information in the Manager's TimeTrace on page 28

Displaying change information in the
Manager's TimeTrace

NOTE: To display the TimeTrace in the Manager, user require the Common_TimeTrace
program function.
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To display an object's change data:

1. Inthe Manager, open the time trace using the View > TimeTrace menu item.
2. Select the object whose change information you want to display.

3. Activate the change history for this object in the TimeTrace view using the
& button.

4. Inthe TimeTrace view, use the Y (time range) filter in the toolbar to specify the
time range for which the change information is loaded. The changes are determined
from the One Identity Manager database and the connected One Identity Manager
History Database databases.

All change time stamps in the time frame that has been loaded are now shown in the
overview below the timeline.

NOTE: To display changes of assignments to an object, such as the identity assignment
to a department or a resource assignment to an organization, select the relevant
assignment form in the task view of the Manager. In the TimeTrace view, you can then
also select a source for which to display the changes. An additional Source drop-down is
offered, in which you can select the respective assignment or the base object.

To select a change time stamp on the timeline:

e To display a part of the timeline in greater detail, click a marking below the timeline.

e Each change time stamp has a label showing the date and time. There is a tooltip for
each change, showing which items of data were changed and by whom.

e Select a change time stamp on the timeline or on the label.

o If there are multiple change time stamps which are very close together, when you
select a time stamp a context menu appears from which you can choose the specific
change time stamp.

e Click the timeline or Ctrl + mouse wheel to zoom in or zoom on the display of
several time change stamps that are close together.

When you select a change time stamp in TimeTrace, the program's document view opens
the object's main data form or the assignment form. Use the timeline or quick edit a label to
choose if you want the object settings or assignments to be displayed in the main data form
before or after the changes have been made.

If a property of an object shows a historical value, it is marked by an & icon. A tooltip
shows the current value of the property. Use the Show property change history context
menu to display the recorded data for this property.

You can apply historical data to the current object and restore the object to the status prior
to the change.

To apply the historic values:

1. Click the B icon in front of the modified property. The following information is
displayed.
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* Property: These properties are changed once the historical value is
transferred. The changes are made immediately or by templates.

 New value: Value of the property after the historical value has been saved.

e Old value: Current value of the property. This value is overwritten once the
historical value is saved.

2. Click Save.

The Info system in the Manager

The Manager's info system provides data about the health of the system in the form
of diagrams.

» Topic-specific statistics and cross-functional statistics are displayed on the
Manager home page.

« Within each category, topic-specific statistics are displayed under Info system.

e Topic-specific statistics for all categories are displayed in the My
One Identity Manager category.

Statistics definitions form the basis of the info system. These are created centrally. For
more information about creating statistics definitions, see the One Identity Manager
Configuration Guide.

Every user can set which statistics they want to see and in which order. Use the settings to
do this. The changes are saved to the user configuration so that the last setting used is
shown when the program is restarted.

All the available statistics are grouped by topic in the settings. Each statistic has a title and
a description.

To select statistics for display

Show the statistics and click Settings.

2. Enable or disable statistics by clicking the button in front of the name of the statistic.
To restore the default setting, click Restore default.

3. Click OK.
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Figure 2: Statistics settings

‘Ey'Settings
Number of requestabl A ge request
products processing time

Settings

You can hide and show the infosystem statistics here, You can also select more statistics on the infosystermn on the home page.

h Home A
@ MNumber of requestable products Finds the number of requestable service items
@ Average request processing time Finds the average request processing time fron
|:| Employees by functional area Finds the number of employees per functional

alll Active Directory
|:| Locked user accounts of enabled employees (Active Directory) Finds the number of blocked Active Directory o
|:| Entitlements without requests (Active Directory) Finds the number of entitlements assigned to t
|:| Groups with / without user account assignments (Active Directory) Finds the number of all groups from Active Dir

alll Attestation
|:| Overdue attestations Finds the number of pending attestations that
|:| Last approvals (attestation) Finds the number of attestation case approvals
|:| Pending attestation cases Finds the number of pending attestation cases
|:| Pending attestation cases within / over the limit Finds the number of pending attestation cases
|:| Attestation approval rates Finds the number of approved and denied atte
|:| Attestation approvals decided within / over the limit Finds the number of approval decisions for atte |
£ — >
Restore default 2} Change sort order Cancel

To change the order in which statistics are displayed:
Display the statistics and select Settings.
Click Change sort order.

Select the statistic that you wish to move. You can select multiple statistics using
Shift + select or Ctrl + select.

4. Move the selected statistics with the arrow keys.

Table 7: Meaning of the buttons for changing the sort order.

Icon Meaning
< Moves the selected statistics up.
v Moves the selected statistics down.

To restore the default setting, click Restore default.
Click OK.
-OR -

If you wish to make more changes, go back to the Assignment view.
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Detailed information about this topic

» Diagram types in the info system on page 32

Diagram types in the info system

There are several diagram types available for visualizing statistics.

Bar chart

A bar chart can be used to visualize comparisons between measurements.

Figure 3: Bar chart example

Top 10 departments with members

Sales (L) 140
Production 00 a3
Bszembling Motorbikes 73

Managerment 00 —— 62
Flanning (US) —jes 42

work Preparation 39

Product Development F2 36

Call Center 34
00 - Custamer Service 33
Accounting and Payroll (US) 32

0 28 56 84 112 140
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Pie chart

A pie chart can be used to visualize the measurements as a percentage of the base
measurement.

Figure 4: Pie chart example

Identities by status

Enabled: 5272 — Temp, disabled: 257

Line diagram

A line diagram can be used to visualize a data sequence over a specified time period.
Click with the mouse on a point of measurement and a tooltip showing the measurement
is displayed.

Figure 5: Line diagram example

New identities per week

[ —#—Employees
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Traffic light

A traffic light diagram can be used to visualize the state of the system. The state is
indicated by the color.

Table 8: Meaning of the colors

Color State

Green correct
Yellow acceptable
Red unacceptable

Figure 6: Traffic light example

Locked identities with
enabled user accounts

- @O0

Employees

Tachometer

A tachometer diagram can be used to visualize the state of the system in more detail than
in a traffic light diagram. The base measurement is also displayed. The state is indicated
by the color.

Figure 7: Tachometer diagram example

Identities without
departments

915
Employees
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Thermometer

A thermometer diagram can be used to visualize the state of the system in more detail that
in a traffic light diagram. The state is indicated by a color scale on the side of the diagram.

Figure 8: Thermometer diagram example

|dentities without user

accounts
5.206
Employees
Table

Choose this diagram type to display the measurements or measurement trends over a
certain timeframe in tabular format.

Figure 9: Table example

Number of identities

21.09.2017
Employees 5.274
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Analyzing process monitoring in
the Manager

In One Identity Manager, you have the option of logging the change history of objects and
their properties. Different methods can be used to track changes within
One Identity Manager.

For more information about the process monitoring methods, see the One Identity Manager
Configuration Guide. For more information about configuring process monitoring of IT Shop
requests, see the One Identity Manager IT Shop Administration Guide.

In the Manager's process view, the system shows the process data from running processes
and process steps, the process data for direct database actions, and the recorded data
changes in graphical format.

Detailed information about this topic

e Prerequisites for displaying the process information on page 36
» Working with the process view in the Manager on page 37

e Opening the process view in the Manager on page 38

e Presenting process information in the Manager on page 40

e Layout of logged data changes in the Manager on page 41

Prerequisites for displaying the process
information

The following prerequisites apply to displaying process information:

e The process view in the Manager is only available if the Common | ProcessState
configuration parameter is enabled and a method for monitoring the process is
configured.
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e The process view shows the process data only if the process data recording
procedure is configured.

e The log is only displayed in the process view if the method for logging changes to
data is configured and the logged in user has at least viewing permissions for the
Dialogwatch* , DialogProcess*, and QBMWatchOperationSummary tables.

e To open the process view in the Manager, users require the Common_ProcessView
program function.

For more information about configuring the process monitoring, see the
One Identity Manager Configuration Guide.

Working with the process view in the
Manager

The process view is divided into two parts.

e The upper part of the process view displays a log containing the logged data changes.
You can view the data changes of a process, a user and an object.

» The process information form is displayed in the lower part of the process view. This
shows you an overview of the actions triggered in the system and the resulting
processes. This displays information for the overall process and for the individual
steps of a process.

You can configure the layout of process information. You can specify the level from which
information is shown, for example, activities, details, or individual steps. You can restrict
the scope of the information shown.

Related topics

» Prerequisites for displaying the process information on page 36

* Opening the process view in the Manager on page 38

» Features in the process view on page 38

» Configuring how process information is presented in the Manager on page 39
* Presenting process information in the Manager on page 40

» Layout of logged data changes in the Manager on page 41
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Opening the process view in the Manager

The Manager displays process information in the process view.

To open the process view:

e Inthe Manager menu, select the View > Process data menu item.

Related topics

» Prerequisites for displaying the process information on page 36
» Features in the process view on page 38
* Presenting process information in the Manager on page 40

» Layout of logged data changes in the Manager on page 41

Features in the process view

Table 9: Meaning of toolbar icons in the process data form

Icon Meaning

o Reload process data.

a Show process data for the current user (object-related process data).

& Show process data for the selected object (object-related process data).

& Show processes for related objects.

8 Show substitute processes.

Y Filter process data by status.

s Show data changes for the current user in the log (user-specific changes).

Show data changes to the object selected in the result list in the log (object-
related changes).

L Configure the process view settings.

Table 10: Items in the process data form context menu

Context Menu Item Meaning

Search The system searches for objects in the process view.
Add to favorites Adds the selected object to your favorites.
Remove from Removes the selected object from your favorites.
favorites
= . . .
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Context Menu Item Meaning

Tasks The object's available forms are shown and you can switch to the
desired form.

Object type: <BaseOb- This shows the base object of the triggered process
ject>

Show process logs The log shows the data changes of the selected process (process-
related changes).

Properties Show other properties of the active object. This menu item is only
available in expert mode.
Table 11: Meaning of toolbar icons in the log

Icon Meaning

& The selected object appears in the document view.

=? The display switches to the originally referenced (old) object and this is shown in
document view.

o2 The display switches to the newly referenced object and this is shown in
document view.

Configuring how process information is
presented in the Manager

You can configure the layout of process information. You can specify the level from which
information is shown, for example, activities, details, or individual steps. You can restrict
the scope of the information shown.

To configure the process display in the Manager

1. Inthe Manager, on the process information form, select .
2. Configure the following settings.
- Display complexity: Set the display range. Permitted values are:
e Activities: Activity information (top hierarchy level) is shown.
e Details: Information about activities and their details is shown.

e Single steps: Information about activities, details, and individual steps
at the selected depth is shown.

» Single step details: Set the depth of detailed information shown for
individual steps. Permitted values are:

@NE IDENTITY One Identity Manager 9.3 Operational Guide

S Analyzing process monitoring in the Manager



e Basic information: Individual steps with a detail depth of basic
information are shown.

e Extended information: Single steps with a detail depth of basic
information and extended information are shown.

e Complete information: Single steps with a detail depth of Basic
information, Supplementary information, and Complete information are
shown (technical view).

 Show whole tree: If this option is activated, the entire hierarchy tree
automatically opens when the process view is loading. If this option is
deactivated, the hierarchy tree is not opened when the process view is loaded.

 Show selected process automatically: If this option is activated, the entire
hierarchy tree automatically opened when a process is selected. If this option is
deactivated, the hierarchy tree is not opened when a process is selected.

3. Save your settings with OK.

Presenting process information in the
Manager

The process information form in the process view provides you with an overview of the
actions triggered in the system and the resulting processes. This displays information for
the overall process and for the individual steps of a process.

To display the recorded process data:

« To show all the current user's processes, click @ (User based) in the process
data form.

« To show all of an object's processes, select the object in the result list and click i3
(object based) in the process data form.

The following process data appears:

Table 12: Logged process data

Information Meaning

Activities Process data display text for the process.
Status Process status.
Triggered by User who triggered the process.

Triggered on Time of action.

Duration Processing time.

More inform- More information on the status, such as attempts to repeat individual
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Information Meaning

ation steps or a start time for deferred steps.

Process ID Unique ID (GenProcID). Changes that can be traced back to a single
cause are given the same Process ID and are grouped in this way.

TIP: To copy a process ID, click to select the process ID and copy the
process ID to the clipboard using Ctrl + C.

The following icons are used to identify process statuses:

Table 13: Meaning of the icons for the process statuses

Icon Meaning
Processing was completed with success (status Finished).
> The process is currently being processed (status Active).
[x] An error occurred during processing (status Error).
i Status of processing (status Pending, Delayed, Frozen or Not reached).
i Process dependent on selected process.
4 Previous substitute process.
2 Next substitute process.

Related topics

* Opening the process view in the Manager on page 38

» Layout of logged data changes in the Manager on page 41

Layout of logged data changes in the
Manager

Individual data changes to the process view are displayed in the document view in the
form of a log.

To show recorded data changes:

e To show all data changes that were run within a process, select the process in the
process data form and click Show logs for this process in the context menu.

« To show all data changes carried out by the current user, click & in the
process data form.
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» To show all of an object's data changes, select the object in the result list and click
in the process data form.

The data changes log shows the following information.

Table 14: Information on data changes

Information Meaning

Change history This shows the affected object and the changed properties. To give a
better overview, objects are grouped according to the table to which the
dataset belongs.

Change date Time of action.

Changed by User who made the changes.
Old value Column value before the change.
New value Column value after the change.

Table 15: Meaning of icons in the log

Icon Meaning
fIE Column

25 Table

=§ Foreign key
T3 Object

To track data changes further, you can use the functions below.

e Show a specific object from the change history

Select the entry for the object in the log and click .. Loads the object and opens the
overview form.

e Show a referenced object from the change history

« Select the entry for the object in the log and click =2. The display switches to
the originally referenced object and opens the overview form.

« Select the entry for the object in the log and click 2. The display switches to
the newly referenced object and opens the overview form.

Related topics

» Opening the process view in the Manager on page 38
» Presenting process information in the Manager on page 40

» Analyzing data changes in reports and the TimeTrace on page 27

@NE IDENTITY One Identity Manager 9.3 Operational Guide 42

S Analyzing process monitoring in the Manager



Schedules in One Identity Manager

Frequently, you need to run processes and calculation tasks at specified time intervals. To
make this possible, you can define schedules in One Identity Manager. For example,
schedules are required for scheduled running of processes within process handling or for
different calculation tasks in One Identity Manager. A schedule can be in control of several
tasks. Activation times are configured in a schedule for the tasks to be run.

You create and edit schedules in the Designer or in the Manager. The Designer displays all
schedules of the system. You can edit individual schedules, such as schedules for
attestations, schedules for compliance calculations, or schedules for dynamic role
calculations, in the Manager. For more information about editing schedules in the Manager,
refer to the administration guides for the modules.

Schedules are already defined in the default installation of One Identity Manager. Configure
these according to your custom requirements.

NOTE: If you run a schedule, all tasks to which the schedule is assigned are run. Before
you use a schedule on a repeated basis, check the effects of the process handling.

Related topics

e Enabling and disabling schedules on page 43

o Zeitplane automatisiert ausfiihren on page 44

e Starting schedules immediately on page 44

e Creating and editing schedules on page 45

e Calculating the activation time of schedules on page 48

e Scheduled maintenance tasks on page 49

Enabling and disabling schedules

You can enable and disable schedules. Only enabled schedules can be run.
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To enable a single schedule in the Designer
1. Inthe Designer, select the Base data > General > Schedules category.
2. Select the schedule.
3. Set Enabled.

4. Select the Database > Save to database and click Save.

To disable a single schedule in the Designer

In the Designer, select the Base data > General > Schedules category.
Select the schedule.

Disable the Enable option.

® N o w

Select the Database > Save to database and click Save.

Related topics

» Starting schedules immediately on page 44

Zeitplane automatisiert ausfiihren

Aktivierte Zeitplane werden automatisiert ausgeftihrt, wenn der Konfigurationsparameter
QBM | Schedules aktiviert ist. In the Designer, check if the configuration parameter is
set. If not, set the configuration parameter.

Um die automatisierte Ausfiihrung aller Zeitplane temporar anzuhalten, deaktivieren Sie im
Designer den Konfigurationsparameter QBM | Schedules. This stops the schedules from
being run automatically. However, you can still start schedules manually.

Related topics

e Enabling and disabling schedules on page 43

e Starting schedules immediately on page 44

Starting schedules immediately

Normally, schedules are started automatically. If necessary, you can start a schedule
manually at any time.

NOTE: Before you start a schedule manually, check whether other processes that also
need to be preprocessed by One Identity Manager will be run as a result.
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To start a schedule in the Designer immediately
1. Inthe Designer, select the Base data > General > Schedules category.
2. Select the schedule.
3. Click Start.
4. Confirm the security prompt with Yes.

| NOTE: The last processing time is not updated when the schedule is started manually.

Related topics

e Enabling and disabling schedules on page 43

o Zeitplane automatisiert ausfihren on page 44

Creating and editing schedules

If necessary, you can change the default schedules or create new schedules.

To create a schedule in the Designer
In the Designer, select the Base data > General > Schedules category.
Select the Object > New menu item to create a new schedules.

Edit the schedule’s main data.

AR W N =

Select the Database > Save to database and click Save.

To edit a schedule in the Designer

1. Inthe Designer, select the Base data > General > Schedules category.
2. Select a schedule.

3. Edit the schedule’s main data.

4. Select the Database > Save to database and click Save.

Related topics

e Properties of schedules on page 46
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Properties of schedules

The following properties are displayed for a schedule:

Table 16: Schedule properties
Property Meaning

Name Schedule ID. Translate the given text using the & button.

Description Detailed description of the schedule. Translate the given text using the &
button.

Table Table whose data can be used by the schedule.

Enabled Specifies whether the schedule is enabled.

NOTE: Only active schedules are run. Enabled schedules are run
automatically if the QBM | Schedules configuration parameter is set.

Time zones  Unique identifier for the time zone that is used for running the schedule.
Choose between Universal Time Code or one of the time zones in the
menu.

NOTE:

When you add a new schedule, the time zone is preset to that of the
client from which you started the Designer.

Start (date) The day on which the schedule should be run for the first time. If this day
conflicts with the defined interval type, the first run is on the next available
day based on the start date.

Validity Period within which the schedule is run.

eriod
P » If the schedule will be run for an unlimited period, select the

Unlimited duration option.

e To set a validity period, select the Limited duration option and
enter the day the schedule will be run for the last time in End
(date).

Occurs Interval in which the task is run. Other settings may be required
depending on the settings.

e Every minute: The schedule is run once a minute. The starting point
is calculated from the rate of occurrence and the interval type.

e Hourly: The schedule is run at defined intervals of a multiple of
hours such as every two hours.

e Under Repeat every, specify after how many hours the
schedule is run again.

e The starting point is calculated from the rate of occurrence
and the interval type.
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Property Meaning

e Daily: The schedule is run at specified times in a defined interval of
days such as every second day at 6am and 6pm.

e Under start time, specify the times to run the schedule.

e Under Repeat every, specify after how many days the
schedule is run again.

* Weekly: The schedule is run at a defined interval of weeks, on a
specific day, at a specified time such as every second week on
Monday at 6am and 6pm.

e Under start time, specify the times to run the schedule.

e Under Repeat every, specify after how many weeks the
schedule is run again.

» Specify the set day of the week for running the schedule.

e Weekly: The schedule is run at a defined interval of months, on a
specific day, at a specified time such as every second month on the
1st and the 15th at 6am and 6pm.

e Under start time, specify the times to run the schedule.

e Under Repeat every, specify after how many months the
schedule is run again.

e Specify the days of the month (1st - 31st of the month).

NOTE: If the Monthly interval type with the sub interval 29, 30 or
31 does not exist in this month, the last day of the month is used.

Example:

A schedule that is run on the 31st day of each month is run on
April 30th. In February, the schedule is run on the 28th (or 29th in
leap year).

e Yearly: The schedule is run at a defined interval of years, on a
specific day, at a specified time such as every year on the 1st, the
100th, and the 200th day at 6am and 6pm.

e Under start time, specify the times to run the schedule.

e Under Repeat every, specify after how many years the
schedule is run again.

» Specify the days of the year (1st - 366th day of the year).

NOTE: If you select the 366th day of the year, the schedule
is only run in leap years.

e Monday, Tuesday, Wednesday, Thursday, Friday, Saturday, Sunday: The
schedule is run on a defined day of the week, in specified months, at
specified times such as every second Saturday in January and June

at 10am.
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Property Meaning

e Under start time, specify the times to run the schedule.

e Under Repeat every, specify after how many days of the
month the schedule is run again. The values 1 to 4, -1 (last
day of the week), and -2 (last day but one of the week) are
permitted.

e Specify in which month to run the schedule. The values 1 to 12
are permitted. If the value is empty, the schedule is run each

month.

Start time Fixed start time Enter the time in local format for the chosen time zone. If
there is a list of start times, the schedule is started at each of the given
times.

Repeat Rate of occurrence for running the schedule within the selected time

every interval.

Last planned Activation time calculated by the DBQueue Processor. Activation times are
run/Next recalculated whilst the schedule is running. The time of the next run is
planned run calculated from the interval type, rate of occurrence, and the start time.

NOTE: One Identity Manager provides the start information in the time
zone of the client where the program was started. Changes due to
daylight saving are taken into account.

Related topics

e Enabling and disabling schedules on page 43

Calculating the activation time of
schedules

The DBQueue Processor performs starts and checks schedules at regular intervals. First, all
schedules are found that are enabled and within the valid time period. A task is queued in
the DBQueue for each schedule to be run. Then the time for the next scheduled run is
calculated and entered in the schedule.

For tasks with the Every minute and Hourly interval types, the next planned activation time
will be determined from the time at which the schedule runs, how often it runs, and the
specified time zone. For schedules with the interval types Daily, Weekly, Monthly and
Yearly, the next planned activation time will be determined from the current day, the
specified subinterval and the start time within the specified time zone.
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Behavior of hew schedules

When a new active schedule is added, the next scheduled run is calculated immediately.
This is calculated on the basis on the start date or the current date of the next scheduled
run. The time between runs is not taken into account.

The task is run if the activation time has been reached. When the next scheduled run is
calculated, this time the interval will be taken into account.

Behavior of modified schedules

If a schedule changes, the next scheduled run is calculated immediately. This is calculated
on the basis on the start date or the current date of the next scheduled run. The time
between runs is not taken into account.

The task is run if the activation time has been reached. When the next scheduled run is
calculated, this time the interval will be taken into account.

Scheduled maintenance tasks

Some calculation tasks for the database are scheduled. There are schedules set up for
these maintenance tasks, which you can customize as required. It is recommended to run
maintenance task outside main working hours of the connected clients.

Table 17: Maintenance tasks for the database

Task Schedule Frequency

Recalculate implementation Recompile all Daily

plans () implementation plans

Reduce size of change Reduce logs Daily

entries

Reduce size of process Reduce logs Daily

tracking logs

Purge dynamic users Reduce logs Daily

Reduce size of process log Reduce logs Daily

entries

Reduce size of process Reduce logs Daily

history

Compress DBQueue Daily maintenance tasks Daily

Populate calendar Daily maintenance tasks Daily

Lock table statistics Daily maintenance tasks Daily
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Task Schedule Frequency

Calculate table statistics Daily maintenance tasks Daily
Rebuild table index *) Daily maintenance tasks Daily
Delete closed cases in the Daily maintenance tasks Daily
IT Shop

Clean up Daily maintenance tasks Daily

DBQueue Processor buffer

Calculate statistics for data  Weekly maintenance tasks ~ Weekly
contents

Set RowLock Weekly maintenance tasks Weekly
*)
NOTE: Reindexing of tables does not take place anymore if they are larger than 1 GB or

have more than 1 million data records. Maintenance of these tables must be performed
by the database administrator within maintenance periods.
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Mail templates in
One Identity Manager

One Identity Manager provides the means to send email notifications. For example,
notifications can be sent from process handling, about attestation or the status of
IT Shop requests.

You use mail templates to design the appearance and content of email notifications. A mail
template consists of general main data such as target format, important, or mail
notification confidentiality and one or more mail definitions. The mail text is defined in
several languages in the mail template. The recipient's language preferences are taken into
account when an email notification is generated.

Create and edit mail templates in the Designer or in the Manager. The Designer displays all
mail templates of the system. You can edit individual mail templates such as mail templates
for requests in IT Shop or mail templates for attestation in the Manager. For more
information about editing mail templates in the Manager, refer to the administration guides
for the modules.

A Designer is integrated in the Manager and in the Mail Template Editor to simplify writing
notifications. In the Mail Template Editor you can create email texts with Microsoft Word
style editing and formatting functions and a preview of the email.

Email notifications are generated through default processes during process handling. To
use email notifications based on mail templates for other business procedures, for
example creating user accounts, you have to create custom mail templates and processes.
Use the MailComponent process component to provide the SendRichMail process task for
this purpose.

Related topics

» Creating and editing mail templates on page 52
» General properties of mail templates on page 53
» Creating and editing mail definitions on page 54

» Email signature configuration for mail templates on page 63
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Creating and editing mail templates

If required, you can change the default mail template or create a new one.

To edit a mail template in the Designer

1. Inthe Designer, select the Mail templates category.
2. Select the mail template and start Mail Template Editor using the Edit mail
template task.

To create a new mail template in the Designer

1. In the Designer, select the Mail templates category.

2. Start Mail Template Editor using the Create a new mail template task.

Related topics

o Copying mail templates on page 52

» Creating mail previews on page 53

Copying mail templates

You can copy an existing mail template and then customize it as required.

To copy a mail template in the Designer

In the Designer, select the Mail templates category.

2. Select the mail template you want to copy and start the Mail Template Editor using
the Edit mail template.

Select the Mail template > Copy mail template menu item.
Enter the name of the new mail template and click OK.

The new mail template is displayed in the Mail Template Editor. Now, you can edit the
mail template.

Related topics

» Creating and editing mail templates on page 52

e Creating mail previews on page 53
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Creating mail previews

You can display a preview while editing your mail template.

To display a mail template preview in the Designer

In the Designer, select the Mail templates category.

2. Select the mail template and start Mail Template Editor using the Edit mail
template task.

3. Select the Mail templates > Mail preview menu item.
4. Select the base object and click OK.

General properties of mail templates

The following properties are displayed for a mail template.

Table 18: Mail template properties

Property

Meaning

Mail template

Base object

Report
(parameter set)

Description

Target format

Name of the mail template. This name will be used to display the mail
templates in the administration tools and in the Web Portal. Translate
the given text using the & button.

Mail template base object. A base object only needs to be entered if the
mail definition properties of the base object are referenced.

Report, made available through the mail template.

Mail template description. Translate the given text using the & button.
Format in which to generate email notification. Permitted values are:

e HTML: The email notification is formatted in HTML. Text formats,
for example, different fonts, colored fonts, or other text
formatting, can be included in HTML format.

e TXT: The email notification is formatted as text. Text format does
not support bold, italics, or colored font, or other text formatting.
Images displayed directly in the message are not supported.

Design type Design in which to generate the email notification. Permitted values
are:
e Mail template: The generated email notification contains the
mail body in accordance with the mail definition.
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Property Meaning

¢ Report: The generated email notification contains the report
specified under Report (parameter set) as its mail body.

e Mail template, report in attachment: The generated email
notification contains the mail body in accordance with the mail
definition. The report specified under Report (parameter set)
is attached to the notification as a PDF file.

Importance Importance for the email notification. Permitted values are Low, Normal,
and High.

Confidentiality = Confidentiality for the email notification. Permitted values are Normal,
Personal, Private, and Confidential.

Can Specifies whether the recipient can unsubscribe email notification. If
unsubscribe this option is set, the emails can be unsubscribed through the

Web Portal.
Deactivated Specifies whether this mail template is disabled.

Mail definition Selects the mail definition in a specific language.

NOTE: If the Common | MailNotification | DefaultCulture
configuration parameter is set, when the template is opened, the
mail definition is loaded and displayed in the email notifications
default language.

Language Language that applies to the mail template. The recipient's language
preferences are taken into account when an email notification is
generated.

Subject Subject of the email message.

Mail body Content of the email message.

Related topics

» Creating and editing mail definitions on page 54

Creating and editing mail definitions

Mail texts can be defined in these different languages in a mail template. This ensures that
the language of the recipient is taken into account when the email is generated.

NOTE: If the Common | MailNotification | DefaultCulture configuration parameter is
set, the mail definition is loaded in the default language for email notifications when the
template is opened.
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To create a new mail definition

In the Designer, select the Mail templates category.

2. Select the mail template and start Mail Template Editor using the Edit mail
template task.

3. In the result list, select the language for the mail definition in the Language
drop-down.

All active languages are shown. To use another language, in the Designer, enable the
corresponding countries. For more information, see the One Identity Manager
Configuration Guide.

4. Enter the subject in Subject.
Edit the mail text in the Mail definition view with the help of the Mail Text Editor.

Save the changes.

To edit an existing mail definition

In the Designer, select the Mail templates category.

2. Select the mail template and start Mail Template Editor using the Edit mail
template task.

In the Mail definition drop-down, select the language for the mail definition.
2. Edit the mail subject line and the body text.

Save the changes.

Related topics

» Defining default fonts and default font sizes for mail templates on page 62

e Creating and editing mail templates on page 52

e Using base object properties in mail templates on page 55

e Using hyperlinks to the Web Portal in mail templates on page 57

o Default functions for creating hyperlinks on page 58

e Using scripts in mail templates on page 60

e Support for dynamically generated HTML code in mail templates on page 61
e Usingprocess parameters in hyperlinks on page 61

» Email signature configuration for mail templates on page 63

Using base object properties in mail
templates

In the subject line and body text of a mail definition, you can use all properties of the object
entered under Base object. You can also use the object properties that are referenced by
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foreign key relation.

To access properties use dollar notation. For more information about using dollar ($)
notation, see the One Identity Manager Configuration Guide.

Example:

An IT Shop requester should receive email notification about the status of the
request.

Table 19: Email notification properties

Property Value

Base object PersonWantsOrg
Subject "$DisplayOrg[D]$" status change

Mail body Dear $FK(UID_PersonOrdered).Salutation[D]$ $FK(UID_
PersonOrdered).FirstName$ $FK(UID_PersonOrdered).LastName$,

The status was changed on the following request on
$DateHead:Date$.

Product: $DisplayOrg[D]$

Requested by: $DisplayPersonlnserted$
Reason: $OrderReason$

Current status of your request:
Approval: granted

Approver: $DisplayPersonHead[D]$
Reason: $ReasonHead[D]$

The generated email notification could look like the following, for example, once it
has been formatted.

Subject: "Service Notebook" status change
Dear Ms Monica Flaster.

The status was changed on the following request on 03/08/2011 11:14:53.

Product: Service Notebook
Requested by: Fletcher, Monica
Reason: For on-gite processing

Current status for your request:

Approval: granted _
Approver: Rippington. Rudiger
Reason: approved
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Related topics

» Creating and editing mail definitions on page 54

Using hyperlinks to the Web Portal in mail
templates

You can add hyperlinks to the Web Portal in the mail text of a mail definition. If the recipient
clicks on the hyperlink in the email, the Web Portal opens on that web page and further
actions can be carried out. In the default version, this method is implemented for IT Shop
requests, in Identity Audit, policy checks and attestations.

Prerequisites for using this method

« The QER | WebPortal | BaseURL configuration parameter is enabled and contains
the URL to the API Server. You edit the configuration parameter in the Designer.
http://<server name>/<application>

with:

<{server name> name of server

<application> = path to the API Server installation directory

To add a hyperlink to the Web Portal in the mail text

1. Click the position in the mail text of the mail definition where you want to insert
a hyperlink.

2. Open the Hyperlink context menu and enter the following information.
» Display text: Enter a caption for the hyperlink.
e Link to: Select the File or website option.

e Address: Enter the address of the page in the Web Portal that you want
to open.

NOTE: One Identity Manager provides a number of default functions that you
can use to create hyperlinks in the Web Portal.

3. To accept the input, click OK.

Related topics

» Creating and editing mail definitions on page 54
» Default functions for creating hyperlinks on page 58

» Usingprocess parameters in hyperlinks on page 61
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Default functions for creating hyperlinks

Several default functions are available to help you create hyperlinks. You can use
the functions directly when you add a hyperlink in the mail body of a mail definition
or in processes

Direct function input

You can reference a function when you add a hyperlink in the Address field of the
Hyperlink context menu.

Syntax

$Script(<Function>)$

Example:

$Script(VI_BuildITShopLink_Show_for Requester)$
$Script(VI_BuildAttestationLink_Approve)$
$Script(VI_BuildCompliancelLink_Show)$
$Script(VI_BuildQERPolicyLink_Show)$

Default functions for requests

The VI_BuildAttestationLinks script contains a collection of default functions for
composing hyperlinks to directly grant or deny approval of requests from email
notifications.

Table 20: Functions of the VI_BuildAttestationLinks script

Function Usage

VI_BuildAttestationLink_Show Opens the attestation page in the Web Portal.

VI_BuildAttestationLink_ Approves an attestation and opens the attestation page
Approve in the Web Portal.

VI_BuildAttestationLink_Deny Denies an attestation and opens the attestation page in
the Web Portal.

VI_BuildAttestationLink_ Opens the page for answering a question in the

AnswerQuestion Web Portal.

VI_BuildAttestationLink_ Opens the page with pending attestations in the

Pending Web Portal.
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Default functions for IT Shop requests

The VI_BuildITShopLinks script contains a collection of default functions for composing
hyperlinks to directly grant or deny approval of IT Shop requests from email notifications.

Table 21: Functions of the VI_BuildITShopLinks script

Function

Usage

VI_BuildITShopLink_
Show_for_Approver

VI_BuildITShopLink_
Show_for_Requester

VI_BuildITShopLink_
Approve

VI_BuildITShopLink_
Deny

VI_BuildITShopLink_
AnswerQuestion

VI_BuildITShopLink_
Reject

VI_
BuildAttestationLink__
Pending

VI_BuildITShopLink_
Unsubscribe

Opens the overview page for request approval in the Web Portal.
Opens the overview page for requests in the Web Portal.
Approves a request and opens the approvals page in the

Web Portal.

Denies a request and opens the approvals page in the
Web Portal.
Opens the page for answering a question in the Web Portal.

Opens the page with denied requests in the Web Portal.

Opens the page with pending requests in the Web Portal.

Creates the link for canceling email notification. This function is
used in processes for unsubscribing email notifications.

Default functions for identity audit

The VI_BuildCompliancelinks script contains a collection of default functions for composing
hyperlinks for exception approval of rule violations.

Table 22: Functions of the VI_BuildComplianceLinks script

Function

Usage

VI_BuildComplianceLink_Show

Opens the exception approval page in the Web Portal.

Default function for policy checking

The VI_BuildCompliancelinks script contains a collection of default functions for composing
hyperlinks for exception approval of policy violations.
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Table 23: Functions of the VI_BuildComplianceLinks script

Function Usage

VI_BuildQERPolicyLink_Show  Opens the exception approval page in the Web Portal.

Related topics

» Creating and editing mail definitions on page 54
e Using hyperlinks to the Web Portal in mail templates on page 57

e Usingprocess parameters in hyperlinks on page 61

Using scripts in mail templates

In mail templates, any parameters can be used when calling a script.
Syntax:
$SCRIPT(ScriptName, "Options")$

The Options parameter is optional and is passed as a string. Custom parameters can be
coded in any way in this string. Quotes ("") are masked by doubling. In the script, the
parameter is passed as the second parameter after the base object. The base object can be
either IEntity or ISingleDbObject.

Example:

Public Function CCC_Script(baseEntity as IEntity, options as String) as
String

Dim arr = options.Split("|"c)
Dim pl = arr(e)
Dim p2 = arr(l)

End Function

Using the script in mail templates.

$SCRIPT(CCC_Script, "Paraml|Param2")$

\.

For more information about using scripts, see the One Identity Manager
Configuration Guide.
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Support for dynamically generated HTML
code in mail templates

In dollar notation, you can select the HTML type. The HTML code is accepted in scripts and
columns but not masked. There is no security check.

Example: Script with HTML code

Public Function CCC_HtmlMailText(obj As IEntity) As String
Return "<hl style='color:red'>" & obj.Display & "</h1>"

End Function

Using the script in mail templates.

$SCRIPT(CCC_HtmlMailText) :HTML$

For more information about using dollar ($) notation, see the One Identity Manager
Configuration Guide.

Usingprocess parameters in hyperlinks

Use this method to pass additional parameters to a function. Email notifications are
generated during the process handling. Use the MailComponent process component to
provide the SendRichMail process task for this purpose.

To compile a hyperlink in a process, for example, cancellation of email notifications, use the
[ParamName 1-n] and [ParamValue 1-n] free process parameters of the process component.

NOTE: By default, 10 pairs of parameters are available. If this number is not sufficient,
you can create additional custom process parameters, which you can then use as
parameters in the Process Editor.

Example: Populating process parameters

ParamNamel: Value = "NoSubscription"

ParamValuel: value = VI_BuildITShopLink_Unsubscribe (values("UID_
RichMail™).ToString())
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UID RichMail is determined by the pre-script for generating within the process and
passed to the function.

Take implementation examples from base object PersonWantsOrg processes that are
triggered by changes to IT Shop requests.

\

The process parameter is referenced when a hyperlink is inserted in a mail definition using
the Hyperlink menu in the Address field.

Syntax

$PC(<ParamName>)$

Example:

$PC(NoSubscription)$

For more information about creating and editing processes, see the One Identity Manager
Configuration Guide.

Related topics

» Creating and editing mail definitions on page 54
» Using hyperlinks to the Web Portal in mail templates on page 57
» Default functions for creating hyperlinks on page 58

Defining default fonts and default font
sizes for mail templates

You can change the default font type and default font size of mail templates.

To define default fonts for mail templates

e Inthe Designer, set the Common | MailNotification | DefaultFont configuration
parameter and enter a font. The default value is Time New Roman.

To define default font sizes for mail templates

e In the Designer, set the Common | MailNotification | DefaultFontSize
configuration parameter and enter a font size. The default value is 12.
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Email signature configuration for mail
templates

Configure the email signature for mail templates using the following configuration
parameters. Edit the configuration parameters in the Designer.

Table 24: Configuration parameters for email signatures

Configuration parameter Description

Common | MailNotification | Data for the signature in email automatically
Signature generated from mail templates.

Common | MailNotification | Signature under the salutation.

Signature | Caption

Common | MailNotification | Company name.
Signature | Company

Common | MailNotification | Link to the company's website.
Signature | Link

Common | MailNotification | Display text for the link to the company's website.
Signature | LinkDisplay

VI_GetRichMailSignature combines the components of an email signature according to the
configuration parameters for use in mail templates.
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Password policies in
One Identity Manager

One Identity Manager provides you with support for creating complex password policies,
for example, for system user passwords, the identities' central password as well as
passwords for individual target systems. Password polices apply not only when the user
enters a password but also when random passwords are generated.

Predefined password policies are supplied with the default installation that you can use or
customize if required. You can also define your own password policies.

Create and edit mail password policies in the Designer or in the Manager. The Designer
displays all password policies of the system. You can edit individual password policies, such
as password policies for target systems or password policies for the central password of
identities, in the Manager.

For more information about password policies for identities, see the One Identity Manager
Identity Management Base Module Administration Guide. For more information about
password policies for user accounts, see the administration guides of the target systems.

Detailed information about this topic

» Predefined password policies on page 65

» Using password policies on page 66

» Editing password policies on page 67

» Creating password policies on page 68

e Custom scripts for password requirements on page 72
» Editing the excluded list for passwords on page 75

e Checking passwords on page 75

» Testing the generation of passwords on page 76

e Password expiry on page 76

« Displaying locked identities and locked system users on page 77
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Predefined password policies

You can customize predefined password policies to meet your own requirements if
necessary.

Password for logging in to One Identity Manager

The One Identity Manager password policy is applied for logging in to

One Identity Manager. This password policy defines the settings for the system user
passwords (DialogUser.Password and Person.DialogUserPassword) as well as the passcode
for a one time log in on the Web Portal (Person.Passcode).

NOTE: The One Identity Manager password policy is marked as the default policy.
This password policy is applied if no other password policy can be found for identities,
user accounts, or system users.

For more information about password policies for identities, see the One Identity Manager
Identity Management Base Module Administration Guide.

Password policy for forming identities' central passwords

An identity's central password is formed from the target system specific user accounts by
respective configuration. The Identity central password policy defines the settings for
the (Person.CentralPassword) central password. Members of the Identity Management |
Identities | Administrators application role can adjust this password policy.

IMPORTANT: Ensure that the Identity central password policy does not violate the
target system-specific requirements for passwords.

For more information about password policies for identities, see the One Identity Manager
Identity Management Base Module Administration Guide.

Password policies for user accounts

Predefined password policies are provided, which you can apply to the user account
password columns of the user accounts. You can define password policies for user
accounts for various base objects, for example, for account definitions, manage levels, or
target systems.

For more information about password policies for user accounts, see the administration
guides of the target systems.

IMPORTANT: If you do not use password policies that are specific to the target system,
the One Identity Manager password policy default policy applies. In this case,
ensure that the default policy does not violate the target systems requirements.
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Using password policies

You can assign password policies to system user passwords, the identities' central
password as well as passwords for individual target systems. Assign a password policy to
the base object to which it should apply.

» The predefined One Identity Manager password policy password policy is
assigned to the (DialogUser.Password and Person.DialogUserPassword) system user
passwords as well as the passcode of the identity (Person.Passcode).

e The predefined password policy Identity central password policy is assigned to
the identity's central password (Person.CentralPassword).

e The password policies for target systems are assigned to the password columns of
the user accounts.

For more information about password policies for identities, see the One Identity Manager
Identity Management Base Module Administration Guide. For more information about
password policies for user accounts, see the administration guides of the target systems.

NOTE:

e In the QBMVPwdPolicyColumns view, you define which base objects and password
columns are permitted for password policies and the order in which the password
policies are to be applied. If necessary, you can add your own references to
customize the view in the Designer.

o If you create new custom tables with password columns, in the Designer, assign
the VI.Common.Customizer.PwdPolicyColumnEntityLogic customizer to the table
definition.

For more information, see the One Identity Manager Configuration Guide.
If you want to apply another password policy to the password columns, change the
password policy assignment to the base object.

To change a password policy's assignment

1. In the Designer, select the Base data > Security settings > Password
policies category.

Select the password policy in the result list.
Select the Assign objects task.
In the Assignments pane, select the assignment you want to change.

i AW N

From the Password Policies drop-down, select the new password policy you
want to apply.

6. Save the changes.
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To reassign a password policy

1. In the Designer, select the Base data > Security settings > Password
policies category.

2. Select the password policy in the result list.
3. Inthe Assignments pane, click Add and enter the following data.

Table 25: Assighing a password policy

Property Description

Password The password column's identifier.
column

Apply to Application scope of the password policy.

To specify an application scope
1. Click the ... button beside the input field.

2. Select the table which contains the password column
under Table.

3. Select the specific base objects under Apply to.
4. Click OK.

4. Save the changes.

Editing password policies

Predefined password policies are supplied with the default installation that you can use or

customize if required.

To edit a password policy

1. In the Designer, select the Base data > Security settings > Password
policies category.

2. Inthe List Editor, select the password policy.
Edit the password policy's main data.

4. Save the changes.

Detailed information about this topic

* General main data of password policies on page 68
e Policy settings on page 69
» Character classes for passwords on page 70

e Custom scripts for password requirements on page 72
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Creating password policies

Predefined password policies are supplied with the default installation that you can use or
customize if required. You can also define your own password policies.

To create a password policy

1. In the Designer, select the Base data > Security settings > Password
policies category.

2. Select the Object > New menu item to create a new password policy.
3. Onthe main data form, enter the main data of the password policy.

4. Save the changes.

Detailed information about this topic

» General main data of password policies on page 68
e Policy settings on page 69
e Character classes for passwords on page 70

e Custom scripts for password requirements on page 72

General main data of password policies

Enter the following main data of a password policy.

Table 26: main data for a password policy

Property Meaning

Display name Password policy name. Translate the given text using the &
button.

Description Text field for additional explanation. Translate the given text

using the & button.

Error Message Custom error message generated if the policy is not fulfilled.
Translate the given text using the & button.

Owner (Application Role)  Application roles whose members can configure the password
policies.

Default policy Mark as default policy for passwords. This option cannot be
changed.

NOTE: The One Identity Manager password policy is
marked as the default policy. This password policy is
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Property Meaning

applied if no other password policy can be found for identit-
ies, user accounts, or system users.

Related topics

» Creating password policies on page 68

Policy settings

Define the following settings for a password policy on the Password tab.

Table 27: Policy settings
Property Meaning

Initial password Initial password for newly created user accounts. The initial
password is used if a password is not entered when you
create a user account or if a random password is not
generated.

NOTE: The initial password is not used as an identity's
system user password. You can implement this behavior by
customizing if required.

Password confirmation Reconfirm password.

Minimum Length Minimum length of the password. Specify the number of
characters a password must have. If the value is @, no
password is required.

Max. length Maximum length of the password. Specify the number of
characters a password can have. The maximum permitted
value is 256.

Max. errors Maximum number of errors. Set the number of invalid

passwords attempts. The number of failed logins is only taken
into account when logging in to One Identity Manager. If the
value is @, the number of failed logins is not taken into
account.

This data is only taken into account if the

One Identity Manager login was through a system user or
identity based authentication module. If a user has exceeded
the maximum number of failed logins, the identity or system
user will not be able to log in to One Identity Manager.

You can use the Password Reset Portal to reset the passwords
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Property

Meaning

Validity period

Password history

Minimum password
strength

Name properties denied

Related topics

of identities and system users who have been locked. For
more information, see the One Identity Manager Web Portal
User Guide.

Maximum age of the password. Enter the length of time a
password can be used before it expires. If the value is @, then
the password does not expire.

Enter the number of passwords to be saved. If, for example, a
value of 5 is entered, the user's last five passwords are
stored. If the value is @, then no passwords are stored in the
password history.

Specifies how secure the password must be. The higher the
password strength, the more secure it is. The value @ means
that the password strength is not tested. The values 1, 2, 3
and 4 specify the required complexity of the password. The
value 1 represents the lowest requirements in terms of
password strength. The value 4 requires the highest level of
complexity.

Specifies whether name properties are permitted in the
password. If this option is set, name properties are not
permitted in passwords. The values of these columns are
taken into account if the Contains name properties for
password check option is set. In the Designer, adjust this
option in the column definition. For more information, see the
One Identity Manager Configuration Guide.

e Creating password policies on page 68

Character classes for passwords

Use the Character classes tab to specify which characters are permitted for a password.

Table 28: Character classes for passwords

Property Meaning

Required Number of rules for character classes that must be fulfilled so that a

number of password adheres to the password policy. The following rules are taken

character into account for Min. number letters, Min. number lowercase, Min.

classes number uppercase, Min. number digits, and Min. number special
characters.
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Property

Meaning

Min. number
letters

Min. number
lowercase

Min. number
uppercase

Min. number
digits

Min. number

That means:

* Value 0: All character class rules must be fulfilled.

* Value »0: Minimum number of character class rules that must be
fulfilled. At most, the value can be the number of rules with a value
>0.

| NOTE: Generated passwords are not tested for this.

Specifies the minimum number of alphabetical characters the password
must contain.

Specifies the minimum number of lowercase letters the password must
contain.

Specifies the minimum number of uppercase letters the password must
contain.

Specifies the minimum number of digits the password must contain.

Specifies the minimum number of special characters the password must

special contain.

characters

Permitted List of permitted special characters.

special

characters

Max. Specifies the maximum number of identical characters that can be present
identical in the password in total.

characters

in total

Max. Specifies the maximum number of identical character that can be repeated
identical after each other.

characters

in

succession

Denied List of special characters that are not permitted.

special

characters

Do not Specifies whether a generated password can contain lowercase letters.
generate This setting only applies when passwords are generated.

lowercase

letters

Do not Specifies whether a generated password can contain uppercase letters.
generate This setting only applies when passwords are generated.
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Property Meaning

uppercase
letters

Do not Specifies whether a generated password can contain digits. This setting
generate only applies when passwords are generated.

digits

Do not Specifies whether a generated password can contain special characters. If
generate this option is set, only letters, numbers, and spaces are allowed in

special passwords. This setting only applies when passwords are generated.
characters

Related topics

» Creating password policies on page 68

Custom scripts for password
requirements

You can implement custom scripts for testing and generating passwords if the password
requirements cannot be mapped with the existing settings options. Scripts are applied in
addition to the other settings.

Detailed information about this topic

e Checking passwords with a script on page 72

e Generating passwords with a script on page 74

Checking passwords with a script

You can implement a script if additional policies need to be used for checking a password
that cannot be mapped with the available settings.

Syntax of check scripts

Public Sub CCC_CustomPwdValidate( policy As VI.DB.Passwords.PasswordPolicy, spwd
As System.Security.SecureString)

With parameters:
policy = password policy object

spwd = password to check
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| TIP: To use a base object, take the Entity property of the PasswordPolicy class.

Example: Script that checks a password
A password cannot start with ? or ! . The password cannot start with three identical
characters. The script checks a given password for validity.

Public Sub CCC_PwdValidate( policy As VI.DB.Passwords.PasswordPolicy, spwd
As System.Security.SecureString)

Dim pwd = spwd.ToInsecureArray()
If pwd.Length>0
If pwd(0)="?" Or pwd(@)="1"

Throw New Exception(#LD("Password can't start with '?' or
I!III)#)

End If
End If
If pwd.Length>2
If pwd(©) = pwd(1) AndAlso pwd(1) = pwd(2)

Throw New Exception(#LD("Invalid character sequence in
password")#)

End If
End If
End Sub

\

To use a custom script for checking a password

1. Inthe Designer, create your script in the Script Library category.
2. Edit the password policy.

a. Inthe Designer, select the Base data > Security settings > Password
policies category.

b. Inthe List Editor, select the password policy.

c. On the Scripts tab, enter the name of the script to be used to check a
password in the Check script field.

d. (Optional) On the Scripts tab, in the Additional requirements field, enter
the description of the additional requirements for the password that are
checked by the script.

e. Save the changes.
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Related topics

» Generating passwords with a script on page 74

» Creating password policies on page 68

Generating passwords with a script

You can implement a generating script if additional policies need to be used for generating
a random password, which cannot be mapped with the available settings.

Syntax for generating script

Public Sub CCC_PwdGenerate( policy As VI.DB.Passwords.PasswordPolicy, spwd As
System.Security.SecureString)

With parameters:

policy = password policy object

spwd = generated password

| TIP: To use a base object, take the Entity property of the PasswordPolicy class.

Example: Script that generates a password
In random passwords, this script replaces the invalid characters ? and ! at the
beginning of a password with _.

Public Sub CCC_PwdGenerate( policy As VI.DB.Passwords.PasswordPolicy, spwd
As System.Security.SecureString)

Dim pwd = spwd.ToInsecureArray()
' replace invalid characters at first position
If pwd.Length>0

If pwd(0)="2" Or pwd(@)="1"

spwd.SetAt(@, CChar("_"))

End If

End If
End Sub

To use a custom script for generating a password

1. Inthe Designer, create your script in the Script Library category.

2. Edit the password policy.
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a. Inthe Designer, select the Base data > Security settings > Password
policies category.

b. In the List Editor, select the password policy.

c. On the Scripts tab, enter the name of the script to be used to generate a
password in the Generating script field.

d. Save the changes.

Related topics

» Checking passwords with a script on page 72

» Creating password policies on page 68

Editing the excluded list for passwords

You can add words to a list of restricted terms to prohibit them from being used in
passwords.

| NOTE: The restricted list applies globally to all password policies.

To add a term to the restricted list

1. In the Designer, select the Base data > Security settings > Password
policies category.

2. Create a new entry with the Object > New menu item and enter the term you want
to exclude from the list.

3. Save the changes.

Checking passwords

When you verify a password, all the password policy settings, custom scripts, and the
restricted passwords are taken into account.

To verify if a password conforms to the password policy

1. In the Designer, select the Base data > Security settings > Password
policies category.

2. Select the password policy in the List Editor.
3. Select the Test tab.
4. Select the table and object to be tested in Base object for test.
5. Enter a password in Enter password to test.
A display next to the password shows whether it is valid or not.
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Testing the generation of passwords

When you generate a password, all the password policy settings, custom scripts and the
restricted passwords are taken into account.

To generate a password that conforms to the password policy

1. In the Designer, select the Base data > Security settings > Password
policies category.

2. Inthe List Editor, select the password policy.
Select the Test tab.
Click Generate.

This generates and displays a password.

Password expiry

Authentication modules that are based on identities or system users, support password
expiry. The columns Person.PasswordLastSet and DialogUser.PasswordLastSet contain the
time and date that the password was last changed.

There are different ways to inform users that their password is going to expire:

e Users are alerted about their password expiring when they log in to
One Identity Manager and can change their password if necessary.

e For identity-based authentication modules, the system sends reminder notifications
in relation to expiring passwords as of seven days in advance of the password
expiry date.

e You can adjust the time in days in the Common | Authentication |
DialogUserPasswordReminder configuration parameter. Edit the
configuration parameter in the Designer.

e The notifications are triggered in accordance with the Reminder system user
password expires schedule and use the Identity - system user password
expires mail template. You can adjust the schedule and mail template in the
Designer if required.

TIP: To prevent passwords expiring for service account, for example, you can set
Password never expires (DialogUser.PasswordNeverExpires) in the Designer for the
affected system users.

For more information about One Identity Manager authentication modules and about
editing system users, see the One Identity Manager Authorization and
Authentication Guide.
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Related topics

» Schedules in One Identity Manager on page 43

* Mail templates in One Identity Manager on page 51

Displaying locked identities and locked
system users

If a user has exceeded the maximum number of failed logins, the identity or system user
will not be able to log in to One Identity Manager.

e Locked identities are displayed in the Manager in the Identities > Locked
identities category. An additional message referring to the locked login is also
displayed on the overview form for an identity.

e Locked system users are displayed in the Designer in the Permissions > System
users > Locked system users category. An additional message referring to the
locked login is also displayed on the overview form for a system user.

You can use the Password Reset Portal to reset the passwords of employees and system
users who have been locked. This unlocks the identities and system users again. For more
information, see the One Identity Manager Web Portal User Guide and the

One Identity Manager Web Application Configuration Guide.
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Working with change labels

Define change labels under which changes are grouped together in order to swap data
between development and test databases as well as the production database. In the
Database Transporter program, change labels are provided as an export criterion for
creating custom configuration packages.

You can select individual objects from any objects in the database and book them to a
change label. In certain cases, it is necessary to add the dependent objects to the change
label as well. For example, if processes are being transported, the dependent process
steps, process parameters, and events should also be transported. This is also true for
approval policies, approval workflows, approval steps, and approval procedures.

Detailed information about this topic

Snapshots of objects or object references on page 79

Tips for working with change labels on page 79

Creating and editing change labels on page 80

Assigning objects and dependencies to change labels on page 82
Editing change labels on page 83

Removing objects from change labels on page 84

Assigning change labels when saving in the Designer on page 84
Displaying content of change labels on page 85

Locking change labels on page 86

Deleting change labels on page 86

Release management on page 87
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Snapshots of objects or object
references

Change labels contain changes to individual properties of an object at a certain point in
time. Change labels may consist of:

e Snapshot of an object at a certain point in time, optionally with dependent
objects (default)

When you create a custom configuration package, the object is added to the
transport package with all its properties. The properties contain the values given at
the time they were added.

e Object reference, optionally with all its dependent objects

When you create a custom configuration package, the object is added to the
transport package with all its properties. The properties are determined at the
time of export.

You specify whether an object is added to a change label as a snapshot or a reference when
you save the assignment.

NOTE: Snapshots of objects and object references cannot be grouped together in one
change label. Use different change labels for this.

Related topics

» Tips for working with change labels on page 79
» Assigning objects and dependencies to change labels on page 82

e Editing change labels on page 83

Tips for working with change labels

You can create and edit change labels in different One Identity Manager tools. Note the
following tips for working with change labels.

e Be consistent about booking all the changes made to one object to the change
label. It is not possible to add changes of individual properties to the change label
at a later date.

e Snapshots of objects and object references cannot be grouped together in one
change label. Use different change labels for this.

» Whether objects are assigned to a change label as snapshots or as references
depends on the selected change labels

» Normally, objects can be assigned to a change label beforehand or on saving. For
example, in the Designer, you can assign a change label when you commit changes
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to the database.

e Inthe Manager and in the Designer, you can assign objects to change labels in their
properties dialog.

e The Manager and in the Designer have their own edit dialog that allows more
comprehensive editing of change labels.

e To use change labels in the Manager, the Manager must be running in expert mode.

Related topics

» Snapshots of objects or object references on page 79
» Assigning objects and dependencies to change labels on page 82
» Editing change labels on page 83

» Assigning change labels when saving in the Designer on page 84

Creating and editing change labels

You can create and edit change labels in different One Identity Manager tools.

To create a change label

1. In the Manager or the Designer, select the Database > Change
management menu item.

2. Inthe Change management dialog next to the Change labels menu, click FY.
In the Change labels dialog, create a new change label by clicking il

Enter the following label data.

Table 29: Change label properties
Property Meaning

Change label Change label name. This name is used to select the change label for
allocating the changes or creating a customer transport package.

Description Detailed description of the change label.

Parent Specifies a parent label (optional).

change label

State Status of object changes, such as Development, Test, Production.

Status Additional comments in relation to the status.

comments

Comment Additional information to enable tracking of changes to a change
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Property Meaning

label.

Label type Label type for more detailed classification. Permitted values are
Change, Other, IT Shop, Keyword, and Release. The Change label type
is used by default.

Suspended Specifies whether the change label is locked or closed. If a change
label is locked, no further changes can be booked to this label. For
example, change labels can be locked and closed after they have
been transported with the Database Transporter.

Sort order Order in which the data is presented. The sort order is used in the
Database Transporter for importing data using change labels.

5. Click the B button.

6. Click OK.
The Change label dialog closes. The change label is pre-selected in the Change
management dialog in the Change label menu.

To edit a change label

1. In the Manager or the Designer, select the Database > Change
management menu item.

2. Inthe Change management dialog next to the Change labels menu, click F¥.

3. Inthe Change management dialog, select the change label and open the edit view
with the & button.

Edit the change label data.
5. Click the B button.
6. Click OK.

The Change label dialog closes. The change label is pre-selected in the Change
management dialog in the Change label menu.

Related topics

e Tips for working with change labels on page 79

» Assigning objects and dependencies to change labels on page 82
» Assigning change labels when saving in the Designer on page 84
» Editing change labels on page 83

» Displaying content of change labels on page 85

» Deleting change labels on page 86

» Release management on page 87
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Assigning objects and dependencies to
change labels

You can select individual objects from any objects in the database and book them to a
change label. For example, use the Designer to book processes and their dependents to
change labels and approval procedures. In the Manager, you can assign approval policies,
approval workflows, approval steps, and approval procedures to change labels.

To assign objects and dependencies to a change label

1. In the Manager or the Designer, select the object and open the Properties
context menu.

2. You can display which change labels the object belongs to on the Change labels tag.

e To create a new change label assign it, select the New change label and
enter a name for the change label in the input field.

e To assign an existing change label, select the Existing change label option
and select a change label from the drop-down.

3. (Optional) To assign dependent objects, click Add dependent objects.

This opens a Add dependent objects dialog in that lists all the dependencies of the
selected object.

a. Click Add dependent objects.
b. Check that all the required dependencies are enable.
c. Enable other dependencies if required.

TIP: Use the {=] button to switch between the relation and the selected
objects and to identify the dependencies.

d. Click OK.

4. Save the change label assignments. Use the arrow drop-down next to the Save drop-
down to select the method.

» Assign object data: (Default) A snapshot of the object is made at a specific
point, with or without dependencies, and assigned to the change label.

e Assign object reference: A reference to an object is created, with or without
dependencies, and assigned to the change label.

5. Click OK.

Related topics

» Snapshots of objects or object references on page 79
» Tips for working with change labels on page 79
e Editing change labels on page 83
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* Removing objects from change labels on page 84

» Creating and editing change labels on page 80

Editing change labels

In the Manager and the Designer, you can edit change label assignments. You can add
objects and dependencies to change labels and remove them again.

To assign objects and dependencies to a change label

1.

In the Manager or the Designer, select the Database > Change
management menu item.

Select the change label in the Change labels drop-down in the Change
management dialog.

In the Table list, select the database table from which you want to copy objects to
the change label.

To limit the number of objects found
a. Next to the Table drop-down, click the button Y.
b. Enter a condition in Filter.

Enter the condition as a WHERE clause for a database query. You can enter the
database query directly as in SQL or use the wizard, which you open by clicking
on the &* button next to the field.

c. Click Apply.
To map dependent objects
a. Next to the Table drop-down, click the button =.

This opens a separate selection window that displays the ChildRelation (CR),
ForeignKey (FK) and many-to-many relations for the selected database table.

b. Select the relevant table relations in Table relations.

The objects that are connected by means of these table relations are also
marked with the change label when an object is selected and assigned.

In the Objects pane, select your objects and assign them to the change label. In this
case, the method depends on the change labels you selected.

« If the change label you select is for snapshots of objects, click #. (Default)
» If the change label you selected already contains object references, click &2,

| TIP: To select more than one object, use Shift + select or Ctrl + select.

Related topics

» Snapshots of objects or object references on page 79

» Tips for working with change labels on page 79
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» Assigning objects and dependencies to change labels on page 82
* Removing objects from change labels on page 84
» Creating and editing change labels on page 80

» Displaying content of change labels on page 85

Removing objects from change labels

If necessary, you can remove individual objects from a change label.

To remove objects from a change label

1. In the Manager or the Designer, select the Database > Change
management menu item.

2. Inthe Change management dialog, use the Change label drop-down to select the
change label.

3. Select the object that you want to remove from the change label.

» If you selected a change label used for snapshots of objects, select the objects
in the Tagged changes pane and click #.

o If you selected a change label used for object references, select the objects in
the Assigned objects pane and click #

| TIP: To select more than one object, use Shift + select or Ctrl + select.

Related topics

» Snapshots of objects or object references on page 79
e Tips for working with change labels on page 79
e Creating and editing change labels on page 80

« Displaying content of change labels on page 85

Assigning change labels when saving in
the Designer

In the Designer, when you save changes to the main database, you can assign a change
label to the changes.
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To assign changes to a change label in the Designer

1. Inthe Designer, select the Database > Commit to database menu item.
2. Inthe toolbar, select the required change label in the Change label list.

3. To assign individual changes to different change labels, use the Special change
label context menu entry in the change log.

4. Save the changes.

Related topics

» Snapshots of objects or object references on page 79
» Tips for working with change labels on page 79
« Assigning objects and dependencies to change labels on page 82

« Editing change labels on page 83

Displaying content of change labels

You can display the content of change labels if required.

To display the contents of a change label

1.

In the Manager or the Designer, select the Database > Change
management menu item.

In the Change management dialog, select the relevant change label in the Change
label menu.

o If you used this change label to take snapshots of objects, the objects assigned
to the change label are shown in the Tagged changes pane. The following
functions are available:

e To search within a change label, use Ctrl +F.

e To restrict the information displayed to a single change label, click the
arrow in the table header of a column and enter a filter text.

e Use the context menu to change the order of the changes within a
change label. This order is taken into account when the changes are
transported.

e The content of a change for an object is defined in XML format. It
specifies whether a property is created, changed, or deleted with a
change. To display an XML definition of a change, select Edit
change data.

o If change labels reference objects, in the Assigned objects pane, you can see
all the objects that are assigned to the change label.
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TIP: In the Designer, you will find an overview of change labels in the Base data >
General > Change label category.

Related topics

e Tips for working with change labels on page 79
e Creating and editing change labels on page 80

e Editing change labels on page 83

Locking change labels

If a change label is locked, no further changes can be booked to this label. For example,
change labels can be locked and closed after they have been transported with the
Database Transporter.

To lock a change label

1. In the Manager or the Designer, select the Database > Change
management menu item.

2. Inthe Change management dialog next to the Change labels drop-down, click I¥.
3. Select a change label from the list and open the edit view using (.

4. Select the value True for the Locked property.

5. Click the B button.

6. Click OK.

Related topics

» Tips for working with change labels on page 79

» Exporting change labels on page 107

Deleting change labels

You can delete a change label if you do not need it anymore.

To delete a change label

1. In the Manager or the Designer, select the Database > Change
management menu item.

2. Inthe Change management dialog next to the Change labels menu, click FY.

3. Inthe Change label dialog, select the change label and click the button #.
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4. Confirm the security prompt with Yes.
5. To close the Change label dialog, click Cancel.
6. To close the Change management dialog, click OK.

Related topics

e Tips for working with change labels on page 79

Release management

You can combine several change labels into one release. There is a report that provides you
with an overview of the changes in a release.

To combine change labels into one release

1. In the Designer, select the Base data > General > Release management
category.

Select the Object > New menu item.

In the edit view, enter a minimum of the following information in the edit view of the
Properties tab.

e Change label: Enter the name of the change label.
e Label type: Select the Release type.
4. Inthe edit view, select the Change label tab and assign the change labels you want
to combine into one release.

To display a report about a release

1. Inthe Designer, select the Basic data > General > Release management >
<name of release> category.

2. Select the Show report task.
This opens the Change management release overview report.

Related topics

e Creating and editing change labels on page 80
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Checking data consistency

The consistency check provides different tests for analyzing data objects and to ascertain
the current state of their data. In addition to predefined tests, you can define your own
tests and, if necessary, run a repair.

You should run a consistency check at regular intervals, as well as after significant changes
to the system configuration.

You can run consistency checks in the Manager and in the Designer. The following special
cases apply:

o Database tests are run in their entirety in the Manager and the Designer.
e Table tests and object tests in the Manager check the application data.

e Table tests and object tests in the Designer check the system data.

Detailed information about this topic

» Notes on the consistency check on page 88

» Specifying test settings for consistency checks on page 89
* Running consistency checks on page 90

» Logging test results on page 93

» Repairing errors in the consistency check on page 93

Notes on the consistency check

Note the following information on consistency checks.

e Itis recommended to run consistency checks with an administrative user. Not all
consistency checks are available for end users and configuration users.

e To use the Consistency Editor, users require the Common_ConsistencyCheck
program function.
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» To use the repair function in the Consistency Editor, users require the Common_
ConsistencyCheck_Repair program function.

» Consistency checks of type Object test are always run in the context of the user
currently logged in. If users do not have any permissions for a certain object, errors
may not be identified or repairing errors may fail.

Specifying test settings for consistency
checks

Define the valid test settings before you run a consistency check.

To configure the settings for testing

1. Inthe Designer or the Manager, start the Consistency Editor with the Database >
Check data consistency menu item.

2. Inthe Consistency Editor toolbar, click &,
3. Enable the test that is to be run and adjust the test settings further if necessary.
4. Click OK.

The tests are grouped according to different criteria.

Table 30: Meanings of the icons used for test settings

Icon Meaning
i Tests are grouped by themes.
2i Tests are grouped by types (database, tables , objects).

o

Tests are displayed as a list.

&8 Tests are grouped by module association.

(%] Tests with Error severity are displayed.

! Tests with Warning severity are displayed.

i ] Tests with Information severity are displayed.

Use user-defined tests to run your own tests. You can use the scripts from the script library
for these tests. All scripts in the script library are provided for custom tests. The method
call of these scripts corresponds to the following syntax.

Database test

Public Sub Methodname (ByRef con As IConnection)
Public Sub Methodname (ByVal con As IConnection)
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Table test

Public Sub Methodname (ByRef dbTable As ITableDef)
Public Sub Methodname (ByVal dbTable As ITableDef)

Object test

Public Sub Methodname (ByRef dbObject As ISingleDBObject)
Public Sub Methodname (ByVal dbObject As ISingleDBObject)

For more information about scripts and the script library, see the One Identity Manager
Configuration Guide.

Running consistency checks

You should run a consistency check at regular intervals, as well as after significant changes
to the system configuration. Tests are performed at database, table, and object level.
There are already predefined tests available. You can run your own custom tests.

To run a consistency check

1. Inthe Designer or the Manager, start the Consistency Editor with the Database >
Check data consistency menu item.

During start up, One Identity Manager schema table definitions are loaded and
database objects are made available for testing.

2. Specify the test settings.
a. Inthe Consistency Editor toolbar, click .

b. Enable the test that is to be run and adjust the test settings further if
necessary.

c. Click OK.

NOTE: In the Designer, the test settings dialog opens immediately after the
Consistency Editor is started.

3. Start the consistency check. The following test procedures are available in the
Consistency Editor for this:

e Checking all test objects

NOTE: To exclude individual test objects from the check, use the Disable
item in the context menu to disable these test objects in the list view before
the check starts.

Use the P button to start the check.

e Checking single test objects
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In the list view, select the relevant test objects and start this check by
selecting Test.

TIP: Use Shift + select or Ctrl + select to select more than one test object
to be checked.

| NOTE: To stop a check that is in progress, click M in the Consistency Editor toolbar.
4. Verify error output.

5. Repair errors if necessary.

Related topics

* Notes on the consistency check on page 88

» Displaying test objects and test status on page 91

» Specifying test settings for consistency checks on page 89
e Logging test results on page 93

» Repairing errors in the consistency check on page 93

Displaying test objects and test status

When Consistency Editor is starting up, One Identity Manager schema table definitions
are loaded and database objects are made available for testing. The database tables,
the number of objects per table and the test status are displayed in the

Consistency Editor’s list view.

| TIP: To sort by a specific column, click on that column in the table header.
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Figure 10: Consistency Editor with Initialized Data
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Table 31: List view information
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State

Skip object

Skip object

Initialized and ready for testing
Initialized and ready for testing
Initialized and ready for testing
Initialized and ready for testing
Initialized and ready for testing
Initialized and ready for testing
Skip object

Initialized and ready for testing
Skip object

Initialized and ready for testing
Initialized and ready for testing
Initialized and ready for testing
Initialized and ready for testing
Initialized and ready for testing
Initialized and ready for testing
Initialized and ready for testing

Column Meaning

Object Test object name.

Count Total number of objects in the database table.

Verified Test progress in percent.

Errors The number of error that occurred during a consistency check.

Status Current test status. The status is updated during the consistency check.

Table 32: Meaning of list view icons

Icon Meaning

Q Test object is currently being test.

v Consistency check was successful for this Test object.

o Consistency check for this test object is complete but errors occurred.

Table 33: List view context menu items

Context menu Meaning
item
Enable Enables selected test object(s) for the period of the consistency
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Context menu Meaning

item
check.

Disable Disables selected test object(s) for the period of the consistency
check.

Test Starts running the consistency check for the selected test object
(s).

Skip Skip the test object during the consistency check.

Logging test results

During the consistency check, the number of tested objects and the test status is updated
in the editor’s list view. Once the test has completed, any error messages are outputted to
the Consistency Editor error log.

Table 34: Meaning of icons in the error log

Icon Meaning

[« 13

Shows all error messages.

Only shows errors in the selected objects list view.

o A full description of the error is shown in a separate window.
L2 Fixes the error.

B Saves the error messages in a log file.

(1] Deletes the error messages.

| TIP: For a detailed description of an error, double-click the error message.

Related topics

» Repairing errors in the consistency check on page 93

Repairing errors in the consistency
check

If automatic error correction is possible, the Consistency Editor error log offers a
Repair button.
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To correct faulty data
1. Select the error entry in the Consistency Editor error log.
| TIP: Use Shift + select or Ctrl + select to select several entries for repair.
2. To start error correction, click Repair.

The correction is made directly in the One Identity Manager database. Resulting data
changes are made using the One Identity Manager Service.

NOTE: When repairing templates, dependent objects can also be changed. In certain
cases, a large number of dependent objects are changed and saved. Additional processes
may be generated.

Related topics

» Notes on the consistency check on page 88
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Compiling a One Identity Manager
database

After changes have been made to configuration data, such as changes to processes,
scripts, templates, object definitions, task definitions or preprocessor-relevant
configuration parameters, you must compile the database with the Database Compiler.

After a schema installation, a schema update or the import of a complete custom
configuration package, the compilation from the Configuration Wizard or the

Database Transporter is started immediately. After importing hotfix packages or restricted
custom configuration packages, compile the database using the Database Compiler.

NOTE: The i icon in the program's status bar indicates that the database needs to
be compiled.

Detailed information about this topic

e Compiling a database with the Database Compiler on page 95

e Output of errors and warnings during compilation on page 96

Compiling a database with the
Database Compiler

Before you begin the compilation, all the DBQueue Processor tasks have to be processed. If
there are still outstanding tasks on the database, you are notified by the
Database Compiler.

NOTE: In the Designer, it is possible start the Database Compiler direct from the
Database > Compile database menu item.
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To compile a database

Start the Launchpad and log in to the One Identity Manager database.

2. In the Change & Extend view, select the Compile database entry and
click Run.

This starts the Database Compiler program.
3. On the Database Compiler home page, click Next.

4. On the Connect to database page, check the One Identity Manager database
connection data and change if necessary.

5. On the Compilation settings page, you can specify which parts of the database are
to be recompiled.

o Compile scripts: Compiles all VB script components. This includes the scripts
from the script library, templates, formatting scripts, task definitions, table
scripts, and processes. By default, this only compiles modified components.

* Rebuild all scripts: Enable this option to ensure that all VB script components
are recompiled.

e Clear NuGet caches: Referenced NuGet packages are kept in a cache. Enable
this option to ensure that NuGet packages are reloaded.

« Mark WHERE clauses as secure: Where clauses are extracted and marked
as trusted.

 Extract language dependent strings: Texts from scripts are extracted
for translation into other languages. The templates are generated for the
translation.

6. To start compiling, click Next.

7. The compiling progress is displayed on the Compiling page. Compiling may take
some time. After you close compiling, click Next.

8. To end the program, click Finish on the last page.

Output of errors and warnings during
compilation

If compiler errors or warnings occur:

1. Correct the error after compilation is finished.

2. Recompile the database.

Errors are displayed in a separate log window during the compilation process in the
Database Compiler.
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e Double-click an error message in the lower part of the log window to jump to the
relevant line in the source code view in the upper part of the log window. You can
only view the source code you cannot edit it.

e Select Save to save the error messages to a file.
e Select Close to close the error log. Then the compilation continues.

Figure 11: Error message log

F:J;E Errors cccurred during compilation - [m} X
Option Explicit ~
Option Strict On
Option Infer On
Imports Microsoft.VisualBasic
Imports System
Imports System.Collections
Imports System.Ling
Imports System.Text
Imports System.Text.RegularExpressions
Imports VI.Base
Imports VI.Base.JobProcessing
Imports VI.DB
Imports VI.DB.Entities
Imports VI.DB.Sync
Imports VI.DB.Model
Imports JP = VI.Base.JobProcessing
Imports VI.DB.JobGeneration
Imports System.IO v
< >
Error Code snippet Line Snippet line
@Value of type "VI.Base MarContext’ cannot be converted ... Generation condition of job Neuer Prozessschritt of chain CCC_Perso... 1115 1
©String constants must end with a double quote, Generation condition of job Neuer Prozessschritt of chain CCC_Perso... 1115 1
©Method arguments must be enclosed in parentheses, Parameter Scriptiame of job Neuer Prozessschritt of chain CCC_Perso... 1197 1
@‘ue' is not declared. It may be inaccessible due to its pr..  Parameter Scripttame of job Neuer Prozessschritt of chain CCC_Persa... 1197 1
@Bra(keted identifier is missing closing 7. Parameter ScriptMame of job Neuer Prozessschritt of chain CCC_Perso.. 1197 1
save e T

All compiler errors and warnings are recorded during compilation. You can view compiler
errors and warnings after compilation is complete.

To display and save messages

e Select the Show button to display a message in the error message window. For more
information about the error message window, see the One Identity Manager
Process Monitoring and Troubleshooting Guide.

e To save all messages to a file, select an entry and then select Save log to file from
the context menu.

e To add a message to the clipboard, select the entry and press Ctrl + C.
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Transporting custom changes

Automatic version control is integrated into One Identity Manager, ensuring that

One Identity Manager components are always consistent with each other and with the
database. If program extensions that change the structure are implemented - for example,
table extensions - the database needs to be updated.

You need to update the database if hotfixes and service packs are available for the version
of One Identity Manager you are currently running or for complete version updates. In
addition, customer-specific changes must be transferred from a development database into
the test database and into the production system database.

Detailed information about this topic

» Types of transport packages on page 98

Basics for transporting modifications on page 99

» General tips for transporting changes on page 101

» Creating transport packages with the Database Transporter on page 103

» Importing transport packages with the Database Transporter on page 116
» Displaying contents of transport packages on page 117

e Creating and using transport templates on page 118

Types of transport packages

You can customize the One Identity Manager schema by loading so-called transport
packages. One Identity Manager recognizes the following types of transport packages that
can be copied to the database depending on requirements.
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Table 35: Transport package

Transport
package type

Description

Tool used

Migration
package

Hotfix package

Custom config-
uration
package

Migration packages are provided by for the
initial database schema installation, for service
pack and complete version updates. A
migration package contains all the necessary
tables, data types, database procedures, and
the default One Identity Manager config-
uration.

Hotfix packages are provided to load individual
corrections to the default configuration such as
templates, scripts, processes, or files into the
database. Multiple hotfix packages are
combined into one cumulative hotfix package.

NOTE: If a hotfix package only contains
changed files, load these files into the
database using the Software Loader file.

A custom configuration package is used to
exchange customer specific changes between
the development, test, and production system
database. This transport package is created by
the customer and loaded into the database.

Configuration Wizard

Database Transporter

Software Loader

Database Transporter

NOTE: If other configuration customizations are to be transferred to a

One Identity Manager database in addition to a hotfix package, you can create a
cumulative transport package to do this and, by using the Database Transporter, import
the transport package into the target database.

Related topics

» Basics for transporting modifications on page 99

e Creating transport packages with the Database Transporter on page 103

» Importing transport packages with the Database Transporter on page 116

Basics for transporting modifications

Different methods are implemented for transporting modifications.
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e Transport of single objects is done through the object layer.

When you import a transport package, the permissions, templates, and customizer in
the target database are taken into account.

This method is used, for example, if you use the Database Transporter program to
create and import custom configuration packages that contain modifications to a
system user, modifications starting from a defined date or to individual objects.

e The transport of the entire system configuration is done through a transfer buffer.

All relevant tables are checked when creating the transport package. The condition
applied to the table, defines which objects are transported. The primary key is used
to establish whether the transport entry has a GUID module and whether it is
transferred to the source database transfer buffer. The transfer buffer is read and
transport package is created. When importing into the target database, the contents
of the transport package is transferred to the target database's transfer buffer. The
information is then transferred to the target tables.

This method is used if you use the Database Transporter program to create and
import custom configuration packages that contain the complete system
configuration.

e The system configuration transport as a delta transport, identifies the differences in
the configuration data between an existing configuration file and the connected
database. These changes are written as insert, update, and delete operations in the
new configuration file. The data is imported faster than if the system configuration is
transported in its entirety.

When a transport package is imported into a One Identity Manager database, the following
operations are carried out:

e Inserting objects

If no object was found in the destination database using the primary key or
alternative key, a new object is created with this key value.

e Updating objects

An object found in the target database using the primary key will be updated. The
update is done using the configuration buffer.

If transporting modifies a default configuration, the default configuration is moved
into the configuration buffer. You can retrieve changes from the configuration buffer
and restore the default configuration in this way.

If, during a One Identity Manager version upgrade, the default configuration is
changed by a service pack, a complete version upgrade or by loading a hotfix
package, a check is made to see if it has already been customized. In this case, the
modified default configuration is copied to the configuration buffer. This ensures that
customizations do not go missing.

e Deleting objects

Objects that are no longer needed are deleted. This operation is always run if the
entire system configuration is transported.
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Related topics

» General tips for transporting changes on page 101
» Creating transport packages with the Database Transporter on page 103

» Importing transport packages with the Database Transporter on page 116

General tips for transporting changes

To exchange customizations between the development database, test database and the
production database, use the Database Transporter to create transport packages. You also
use the Database Transporter to import the transport packages into the target database.

Tips for creating transport packages

e To copy individual objects into a transport package, specify the export criteria in
Database Transporter. For example, you can export all changes made by a
system user, changes made starting from a defined date or change labels. We
recommend that you limit the custom configuration package if you are
transporting individual changes.

» You should only create a transport for the full system configuration if you want to
copy all the adjustments to the system configuration from a test database into an
initial production database.

e To create transport packages with the Database Transporter, users require the
Transport_Export program function.

e The export date, the export description, database revision and the name of the
export file in the source database transport history are recorded when a transport
package is created with the Database Transporter.

Tips for importing transport packages

e Test the changes in a test system before you load a transport package in a live
system. Use a copy of the production database for testing.

e You can display the contents of a transport package with the Database Transporter
before you import.

o Before importing a transport package, you can protect individual properties from
being overwritten in the target database.

e To import transport packages with the Database Transporter, users require the
Transport_Import program function.

» Start Database Transporter on an administrative workstation.

» Depending on the type of transport, the database is set to single-user mode for the
duration of the import. Close as many existing connections to the database as
possible before starting the import. It is not mandatory to close the
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One Identity Manager Service connections. However, ensure that there are no
processes running when the import is going to start.

e When you import a transport package with schema extensions, the database is set to
maintenance mode. Objects cannot be processed in the database during this time.

e When importing a transport of the system configuration into a target database, you
must also follow the Tips for importing the system configuration on page 114.

e To import transport packages that contain system files with older file versions, users
need the Common_FileRevisionDowngrade program function.

e When you import a transport package with the Database Transporter, the import
date and description, the database version, and the transport package name are
recorded in the transport history of the target database.

Related topics

e Protecting individual properties from being overwritten on page 102

» Displaying transport history on page 103

» Creating transport packages with the Database Transporter on page 103

» Importing transport packages with the Database Transporter on page 116

» Displaying contents of transport packages on page 117

Protecting individual properties from being
overwritten

Before importing a transport package, you can protect individual properties from being
overwritten in the target database.

For example, you may want to block processing, as follows:

» Configuration parameters and their values should not be overwritten when a test
environment is transported to a production environment.

e Server configurations should neither be overwritten in the test environment nor the
production system during a transport.

NOTE: To stop properties from being edited, users require the Common_AllowProp-
ertyLocks program function.

If certain users are allowed to lock properties for editing, you can assign the permissions
to the users through permissions groups.

e The QBM_PropertyLock permissions group is provided for non role-based
login. This group owns the program function. Add the system users to the
permissions groups. Administrative system users automatically obtain these
permissions groups.
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e The QER_4_PropertyLock permissions group is provided for non role-based
login. This group owns the program function. The permissions group is linked to the
Base roles | Lock single properties application role. Add the identities to the
application role.

To unlock and unlock a single property

1. Open the object in the Designer or the Manager.

2. Click the property name and select one of the following options from the
context menu:

* Prohibit modification: The property is locked for editing. The input field is
locked and grayed-out.

 Permit modification: The property is unlocked and available for editing.

Displaying transport history

The export date, the export description, database revision and the name of the export file
in the source database transport history are recorded when a transport package is created
with the Database Transporter.

When you import a transport package with the Database Transporter, the import date and
description, the database version, and the transport package name are recorded in the
transport history of the target database.

To display transport history

e Start the Designer and select the Help > Transport history menu item.

Creating transport packages with the
Database Transporter

You create transport packages to exchange custom changes between the development,
test, and production system databases.

To create a transport package

Start the Launchpad and log in to the One Identity Manager database.

2. Inthe Change & Extend > Change, extend and prepare the data model
section, select the Transport custom modifications entry and click Run.

This starts the Database Transporter program.

3. Select Create a transport file on the start page.
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4. On the Select the database connection page, check the One Identity Manager
database connection data and change it if necessary.

5. Enter the information about the transport file on the Define file name page.

a. Enter the name of the transport file and change the output directory as
required.

b. (Optional) To create a log file for the export, set the Create a log file for
data export option.

The log file is saved in the output directory of the transport file.

c. (Optional) To remove sensitive data from the transport, enable the Create an
anonymized transport option.

For example, this will remove information about the database server, the
database, and users.

d. (Optional) Some transport methods set the database to single-user mode for
the duration of the import. Use the Override single-user mode option to
explicitly set whether to use single-user mode. Enable the option and select the
required setting.

6. Enter a description of the transport data on the Show and define transport
parameters page.

7. Select the export criteria for the transport on the Define transport data page.

| NOTE: You can combine multiple export criteria.

Table 36: Export criteria

Export criterion Description

Run SQL statements You can integrate SQL statements in the custom config-
before data import uration package, which are to be run before a data import.

For more information, see Integrating SQL statements in
transport packages on page 106.

Transport of favorite In an initial selection, all modified processes, scripts,

objects reports, and mail templates for a specific timeframe are
offered.
For more information, see Exporting favorite objects on page
107.

Transport by change Transport the changes to objects or object attributes that are

label summarized in a change label.
For more information, see Exporting change labels on page
107.

Transport by change Limit the transportation data by user, timeframe, and

information database tables.
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Export criterion

Description

Transport schema
extensions

Transporting
selected objects and
their dependencies

Transport system
configuration

Transport the
system config-
uration as delta
transport

Transport system
files

Create cumulative
transport

Transport synchron-
ization projects

Run SQL statements
after the data
import

Use a transport
template for
selection

(GNE IDENTITY
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For more information, see Exporting changes based on
change information on page 108.

Transport custom schema extensions, such as tables,
columns, database procedures, functions, triggers, views,
and indexes.

For more information, see Transporting schema extensions
on page 109.

Select single objects and their dependencies for transport.

For more information, see Exporting selected objects and
dependencies on page 110.

Transport the entire system configuration.

For more information, see Exporting the entire system config-
uration on page 112 and Tips for importing the system config-
uration on page 114.

Find the differences in the configuration and create a delta
transport.

For more information, see Exporting system configurations
as delta transports on page 113 and Tips for importing the
system configuration on page 114.

Transport single files.

For more information, see Exporting system files on page
111.

You can group together several custom configuration
packages into one cumulative transport package.

For more information, see Creating cumulative transports on
page 115.

Select the synchronization project for transporting.

For more information, see the One Identity Manager
Target System Synchronization Reference Guide.

You can integrate SQL statements in the custom config-
uration package, which are to be run after a data import.

For more information, see Integrating SQL statements in
transport packages on page 106.

Select a transport template for the transport. The export
criteria are determined from the transport template.

For more information, see Creating and using transport
templates on page 118.
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8. To start the export, click Next.

This create the transport package. The program determines the data to export
and displays the progress of the export in the dialog. The export procedure can
take some time.

9. On the last page, the name and storage path for the transport package are displayed.
You can open the directory path using the link.

10. To end the program, click Finish on the last page.

Related topics

» General tips for transporting changes on page 101
» Importing transport packages with the Database Transporter on page 116

e DBTransporterCMD.exe on page 170

Integrating SQL statements in transport
packages

You can integrate SQL statements in the custom configuration package. The SQL
statements are run before or after a data import. For example, after a schema
extension has been transported an SQL statement may be required for filling initial data
in the new columns.

NOTE: To create transport packages with SQL statements, users require the Transport_
SQL program function.

To run SQL statements within a transport package

1. Inthe Database Transporter, on the Define transport data page, select the export
criteria for running SQL expressions. The following export criteria are available:

* Run SQL statements before data import
e Run SQL statements after the data import

2. Create the SQL statement using the Edit button. Differentiate between SQL
statements for system data transport and user data transport.

a. Enter the SQL statement directly.

- OR -

Use the & button to load a .sql file that contains the statements.
b. Use the B button to save to a file.

3. (Optional) Enable the Ensure single user mode for importing option.
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Related topics

» General tips for transporting changes on page 101
» Creating transport packages with the Database Transporter on page 103

Exporting favorite objects

Use the Transport favorite objects transport method to select the modified processes,
scripts, reports, and mail templates from a specific timeframe.

To transport favorite objects
1. Inthe Database Transporter, on the Define transport data page, select the
Transport favorite objects export criteria.
2. Click Select to select the single objects for the transport.

a. Inthe Object modified in last ... days input field, enter the timeframe for
the object selection.

All objects with a change date and user in the selected timeframe are
displayed.

TIP: To include other processes, scripts, reports, or mail templates in the
transport package, use the Load all entry.

b. Select the object you want and use 2 to add it to the transport package.

TIP: Use Shift + select or Ctrl + select to select multiple objects in the
selection dialog.

The Objects to transport pane lists all selected objects and their
dependencies.

Related topics

» General tips for transporting changes on page 101
» Creating transport packages with the Database Transporter on page 103

Exporting change labels

Several changes to objects or objects properties are grouped together under a change label
and can be swapped between source database and target database in this way. When a
custom configuration package is imported with change labels, new data records are added
to the target database and existing data records are updated. In addition, objects marked
for deletion in the change label are deleted from the target database.

| NOTE: There are no change labels available after initial schema installation.

@NE IDENTITY One Identity Manager 9.3 Operational Guide 107

S Transporting custom changes



To transport by change label

1. Inthe Database Transporter, on the Define transport data page, select the
Transport by change information export criteria.

2. Select the change label from the drop-down.
(Optional) To display the contents of a change label, click Display.
Objects and changes are displayed, which belong to the change label.

NOTE: If a change label still contains references to objects that no longer exist in
the database, remove the assignment using the Repair button.

4. (Optional) For additional settings for change label transport, click Options and
specify the following options.

Table 37: Additional transport settings

Setting Description

Close change label after The change label is completed and locked after transport.
export No more changes can be booked to this change label.
Copy dependent objects Objects that are dependent on the selected object and do
to the transport not have a change label are also copied to the transport.
package

Also display closed Change labels that are already closed are also offered for
change labels selection.

Related topics

» General tips for transporting changes on page 101
» Creating transport packages with the Database Transporter on page 103

e Working with change labels on page 78

Exporting changes based on change
information

Use the Transport by change information transport method to limit transportation data
by user, time period and database tables.
To transport by change information

1. Inthe Database Transporter, on the Define transport data page, select the
Transport by change information export criteria.

2. Specify which changes you want to transport.
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Table 38: User list

Entry Description

me Only the changes by the logged-in user are added.
all users Changes are added from all users.

selected users Changes are added from selected users.

TIP: The User area displays the system users. The ... button
beside the input field allows you to select other users. Use
Shift + select or Ctrl + select to select multiple users in
the selection dialog.

3. Use the date filter to export changes for the selected user(s) from a specified date.
The entries today, yesterday, day before yesterday, this week and last database
migration and time period are available.

4. You can limit transportation data even further by selecting database tables.

5. Table 39: Table selection

Entry Description

Entire system Changes are added from all tables.

System data Changes are added from the tables of the system data part.
User data Changes are added from the tables of the user data part.

Selected tables  Changes are added from specific tables.

TIP: To display objects that match the specified export criteria, click Display. In
this overview, you can exclude individual objects from the transport To do this,
disable the corresponding objects.

Related topics

« General tips for transporting changes on page 101
» Creating transport packages with the Database Transporter on page 103

Transporting schema extensions

Custom schema extensions, like tables, columns, database procedures, functions, triggers,
views, and indexes that you want to add, must distinguished by a custom prefix ccc_.
Furthermore, only custom database procedures, functions, triggers, views, and indexes
that are not encoded and are smaller than 64 kb are included.

Custom database procedures, functions, triggers, and views are always exported in their
entirety. Entries corresponding to custom tables and columns are generated in the
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One Identity Manager schema when the transport package is imported (tables DialogTable,
DialogColumn, QBMRelation).

To transport all schema extensions completely from a test database to a production
database, the following procedure is recommended:

1. Create a transport of schema extensions in the test database and import these into
the production database.

2. Create a transport of the system configuration in the test database and import these
into the production database.

Use the transport options to transport single customizations by change label, change
information or selected objects.

To transport schema extensions

e In the Database Transporter, on the Define transport data page, select the
Transport of schema extensions export criteria.

| NOTE: Use Show to display the schema extensions.

Related topics

» General tips for transporting changes on page 101

» Creating transport packages with the Database Transporter on page 103

Exporting selected objects and
dependencies

Use the Transport selected objects and dependencies transport method to select
individual objects and their dependencies to transport. You can add objects dependent on
the object you want to transport without having to select them individually.

NOTE: The selection for this transport criterion displays all tables not labeled with the No
DB Transport option. If objects of other tables are to be transportable, then disable the
option for the tables in the Designer. For more information about customizing table
definitions, see the One Identity Manager Configuration Guide.

To transport single objects and their dependencies

1. Inthe Database Transporter, on the Define transport data page, select the
Transport of selected objects and dependencies export criteria.

2. Click the Select button to select the single objects for the transport.

a. Inthe Tables pane, select the database table from which you want to copy
objects to the custom configuration package.

b. The Relations pane displays the ChildRelation (CR), ForeignKey (FK) and
many-to-many relations for the selected database table. Enable the required
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relations to copy the connected objects to the transport.

c. The Objects pane displays all the objects of the selected table. Select the
objects you want and add them to the transport.

e To delete superfluous objects when the transport package is
imported, select .

» If you do not want to perform post-processing when the transport
package is imported, select ;.

TIP:

» Use Shift + select or Ctrl + select to select multiple objects in the
selection dialog.

e You can use Y to create a filter to limit the selection.

d. The Objects to transport pane lists all selected objects and their
dependencies.

| TIP: To remove individual object from the transport, select Remove.

Related topics

» General tips for transporting changes on page 101
» Creating transport packages with the Database Transporter on page 103

Exporting system files

Use the Transport system files transport method to transport individual files by
exporting them from the database.

To transport new or modified One Identity Manager files

1. Inthe Database Transporter, on the Define transport data page, select the
Transport system files export criteria.

2. Click Select and select the files to transport.

(Optional) Select a patch for the file. Use the Patch load button to load this file and
incorporate it in the transport.

Related topics

» General tips for transporting changes on page 101
» Creating transport packages with the Database Transporter on page 103

Transporting the system configuration

The following methods are provided for transporting the system configuration:
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e Transport the system configuration: Use this procedure method for the initial
transfer of test database modifications into a production database.

e Transport the system configuration as delta transport: Use this
procedure to determine and transport changes to the system configuration
between two databases.

e To transport individual configuration data to an existing production database,
you can also use transports based on change labels, change information, or
selected objects.

To transport custom database procedures, features, triggers, or views completely from a
test database to a production database in addition to the system configuration:

1. Create a transport of schema extensions in the test database and import these into
the production database.

2. Create a transport of the system configuration in the test database and import these
into the production database.

Importing a transport of the system configuration overwrites the configuration data of the
target database. This also applies to the configuration parameter settings. Before importing
a transport package, you can protect individual properties from being overwritten. After
importing the system configuration into a target database, you should check and, if
necessary, modify the configuration settings.

Related topics

e General tips for transporting changes on page 101

e Exporting the entire system configuration on page 112

e Exporting system configurations as delta transports on page 113
e Tips for importing the system configuration on page 114

e Transporting schema extensions on page 109

Exporting the entire system configuration

Use the Transport the system configuration transport method for the initial transfer of
test database modifications into an operational database.

To create a system configuration transport

1. In the Database Transporter, on the Define transport data page, select the
Transport by change information export criteria.

2. Onthe Determining transport data page, the configuration data is determined.
The process may take some time.

At the end, the program displays the transport data that contains references to
objects that are not going to be transported. These objects must exist in the target
system database for importing. You can delete this data from the transport.
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Related topics

General tips for transporting changes on page 101

Creating transport packages with the Database Transporter on page 103
Transporting the system configuration on page 111

Tips for importing the system configuration on page 114

Exporting system configurations as delta transports on page 113

Exporting system configurations as delta
transports

Use the Transport the system configuration as delta transport transport method to
find changes made to the system configuration and transport them. By using this method,
the data is imported faster than if the system configuration is transported in its entirety.

You have several options to available.

« Export the configuration data from the source database: Determines all the

configuration data of the connected database and writes it to a CustomData.xml
configuration file.

Structure of the CustomData.xml file:
XObjectKey Column Value
XObjectKey Column Value

Create a delta transport file from a configuration file and the database:
Determines all the differences between an existing configuration file and the
connected database. The comparison finds new, changed, and deleted contents.
These changes are written to the new Custombelta.xml configuration file as insert,
update and delete operations.

Structure of the CustomData.xml file:
Operation (I,U,D) XObjectKey Column Value
Operation (I,U,D) XObjectKey Column Value

To export configuration data from the source database

1.

In the Database Transporter, on the Define transport data page, select the
Transport the system configuration as delta transport export criteria.

Select the Export the configuration data from the source database option.

3. Onthe Determining transport data page, the configuration data is determined.

The process may take some time.
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At the end, the program displays the transport data that contains references to
objects that are not going to be transported. These objects must exist in the target
system database for importing. You can delete this data from the transport.

To create a delta transport from a configuration file and the database

1. In the Database Transporter, on the Define transport data page, select the
Transport the system configuration as delta transport export criteria.

2. Select the Create a delta transport file from a configuration file and the
database option.

3. On the Select the source transport file page, select the configuration file.

4. The Determining transport data page, shows the configuration file's data being
determined. The process may take some time.

At the end, the program displays the transport data that contains references to
objects that are not going to be transported. These objects must exist in the target
system database for importing. You can delete this data from the transport.

5. The Calculate data differences page compares the transport data of the
configuration file with the configuration data of the connected database. The
difference is calculated and displayed.

Related topics

« General tips for transporting changes on page 101
» Creating transport packages with the Database Transporter on page 103
» Tips for importing the system configuration on page 114

« Exporting the entire system configuration on page 112

Tips for importing the system configuration

When importing a transport of the system configuration into a target database, you must
follow the instructions described under General tips for transporting changes on page 101
and consider the following special features:

» Before performing the import, protect individual properties of the target database
from being overwritten.

» If you need custom schema extensions, such as database procedures, features,
triggers, or views in the target database in addition to the system configuration, you
should import these schema extensions before importing the system configuration.

o After importing the system configuration, check the configuration settings in the
target database.
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e Check the staging level of the target database.

e Check at least the configuration settings for the DBQueue Processor. The
settings are specified through the database staging level and configuration
parameters.

You can find detailed information about configuring a One Identity Manager database
for test, development, or production in the One Identity Manager Installation Guide.

o After importing the system configuration, release the locked properties for
editing again.

Related topics

e Exporting the entire system configuration on page 112
» Exporting system configurations as delta transports on page 113
« Protecting individual properties from being overwritten on page 102

« Importing transport packages with the Database Transporter on page 116

Creating cumulative transports

You can group together several custom configuration packages into a cumulative transport
package. You can define the sequence in which the transports are imported and, if
required, define import conditions.

To create a cumulative transport

1. Inthe Database Transporter, on the Define transport data, select the Create
cumulative transport export criteria.

2. Click Select and, on the Transport files page, add each transport package. You can
drag and drop the transport packages onto the marked area or click Add to select
them in the Explorer.

3. (Optional) You can use the ™ and ¥ icons to change the import order of the selected
transport. The transport packages are imported in the given order.

4. (Optional) Use the € button to define import conditions for each transport
individually.

 Wait for internal database processing to complete after import.:
Enable this option if there are DBQueue Processor tasks to be processed after
importing the transport package. This can lead to longer import times under
certain circumstances.

« Compile database after this transport has been imported.: Enable this
option to compile the database after importing this transport package has
completed. This can lead to longer import times under certain circumstances.
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» Condition: Set a condition for the import, for example, whether the importing
the transport package depends on another transport package. You have the
following option:

» No condition: No condition is used (default).

* Query condition: Formulate the condition in the One Identity Manager
query language. For more information about the One Identity Manager
query languages, see the One Identity Manager Configuration Guide.

e SQL condition: Formulate the condition as an SQL query.
5. To accept the transports, click OK.

Related topics

« General tips for transporting changes on page 101

» Creating transport packages with the Database Transporter on page 103

Importing transport packages with the
Database Transporter

IMPORTANT: Test the changes in a test system before you load a transport package into
a live system.

To import a transport package

1. Start the Launchpad and log in to the One Identity Manager database.

2. Inthe Change & Extend > Change, extend and prepare the data model
section, select the Transport custom modifications entry and click Run.

This starts the Database Transporter program.
3. Select Import transport file on the home page.

4. On the Select the database connection page, check the One Identity Manager
database connection data and change it if necessary.

5. Select the transport package file browser and click Open.
6. Specify your import options on Select transport file.

» Create an import log file: Enable this option to create a log file for the data
import. The log file is saved in the output directory of the transport file.

- Import objects singly and ignore errors: Enable this option to import
objects individually. Errors, which might occur during importing are ignored
and displayed when importing is complete. If you do not enable this option, the
import procedure is canceled when errors occur.
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7.

» Ignore default data differences: Enable this option to ignore changes to
default data. If you do not enable this option, the import procedure is canceled
if changes to default data are included.

Import steps and import progress are displayed on the Importing transport data
page. The import procedure can take some time. Calculation tasks are queued for the
DBQueue Processor on termination.

NOTE: During import, if the expected value does not match with the actual value in
the database, the Merge conflict dialog opens. For each conflict, you must decide
which value is committed to the database.

o If you want to keep database value, enable Current database value.

o If you want the value from the transport package to overwrite the database

value, enable Transport value.

If changes have been made to the system configuration, for example, processes, or
scripts imported, you have to compile the database after the tasks have been
processed. Compilation is started automatically once importing is complete.

To end the program, click Finish on the last page.

| NOTE: Use the B button to save any errors that occur whilst importing.

Related topics

e General tips for transporting changes on page 101

e Tips for importing the system configuration on page 114

» Displaying contents of transport packages on page 117

Displaying contents of transport
packages

You can display the contents of a transport package with the Database Transporter before
you import.

To display the contents of a transport package

Start the Launchpad and log in to the One Identity Manager database.

2. Inthe Change & Extend > Change, extend and prepare the data model
section, select the Transport custom modifications entry and click Run.
This starts the Database Transporter program.

3. Select Show transport file.

4. Select the transport package file browser and click Open.

5. Click Next on the Select transport file page.

6. The contents of the transport file are displayed on the Show transport file page.
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e To display the sequence in which the objects are imported

1. Click + to select an entry in the transport file and select Sort in import
order from the context menu.

2. Click OK and enter the connection credentials for the database. This step
is only required when you established the first in the order.

The order in which the entry's objects are imported into the
database is found.

3. Repeat this step for all other entries for which you want to determine the
import order.

e To display the objects required for an import in the target environment, select
the entry for the .xml file and select Show required objects from the
context menu.

Objects that are dependent on another object that is not part of the transport
package are highlighted.

7. To end the program, click Finish on the last page.

TIP: You can start the import of the transport package from display mode. On the Show
transport file page, click the name of the transport package and use the Import
context menu.

Related topics

« Importing transport packages with the Database Transporter on page 116

Creating and using transport templates

If you repeatedly need to create transports with certain export criteria, you can use
transport templates. You create transport templates in the Database Transporter.
Configure a transport and mark it as a transport template. This creates a transport
template in XML format.

To create a transport template

Start the Launchpad and log in to the One Identity Manager database.

2. Inthe Change & Extend > Change, extend and prepare the data model
section, select the Transport custom modifications entry and click Run.

This starts the Database Transporter program.
3. Select Create a transport file on the start page.

On the Select the database connection page, check the One Identity Manager
database connection data and change it if necessary.

5. Enter the information about the transport file on the Define file name page.
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a. Enter the name of the transport file and change the output directory as
required.

b. Setthe Create a transport template file option.

c. (Optional) To create a log file for the export, set the Create a log file for
data export option.

The log file is saved in the output directory of the transport file.

d. (Optional) To remove sensitive data from the transport, enable the Create an
anonymous transport.

For example, this will remove information about the database server, the
database, and users.

6. Enter a description of the transport data on the Show and define transport
parameters page.

Select the export criteria for the transport on the Define transport data page.
8. On the Transport template file page, enter the following information.
 Template file name: Transport template file name.
 Export path for template file: Repository for the transport template.

 Description for template file: Detailed description of the transport
template.

9. To start the export, click Next.

This creates the transport template file and the transport package. The program
determines the data to export and displays the progress of the export in the dialog.
The export procedure can take some time.

10. On the last page, the name and storage path for the transport package are displayed.
You can open the directory path using the link.

11. To end the program, click Finish on the last page.

You can use the transport templates when you create transport packages with the
Database Transporter or with the DBTransporterCMD.exe command line program. This loads
the export criteria from the transport template file.

To use a transport template for exporting

1. Inthe Database Transporter, on the Define transport data page, select the Use a
Transporter template for selection export criteria.

2. Select the transport template file and click Open.

Related topics

e DBTransporterCMD.exe on page 170

» Creating transport packages with the Database Transporter on page 103
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Importing data with the
Data Import

With the Data Import program, the One Identity Manager offers a simple means of
importing data from other systems. The program supports importing from .csv files and
importing directly from other database systems. You can import data immediately. You also
have the option to import data from customized processes using the import scripts that are
created. The import definition is saved so that you can use it for future data imports.

The steps in the program are as follows:

Load export definitions
Select the import method
Configure the import

Create an import definition

v AW

Create an import script
6. Startthe import

NOTE:

e For regular data imports into One Identity Manager, you can also use the
ScriptComponent process component.

e The DataImporterCMD.exe program provides support for imports from the
command line.

Detailed information about this topic

» Importing data from a CSV file on page 121

» Importing data from an external database on page 126
» Configuring an import on page 129

» Using an import definition file on page 135

e Importing the data on page 134

e DatalmporterCMD.exe on page 173

@NE IDENTITY One Identity Manager 9.3 Operational Guide 120

by Quest Importing data with the Data Import



Importing data from a CSV file

Prerequisites

The data structure of the import file needs to fulfill the following requirements:

e The data is separated by a delimiter or fixed column widths are used.
e The data records are separated by a new line.
e Data that contains a new line is marked with a text qualifier.

e For more extensive CSV imports, the data in the import file is sorted in advance to
resolve the object dependencies.

NOTE: For imports with small amounts of data, use the sorting options of the
Data Import.

To import data from CSV files into the One Identity Manager database
Start the Launchpad and log in to the One Identity Manager database.

2. Inthe Configure > Data synchronization section, select Configure a data
import and click Run.

This starts the Data Import program.
3. On the Data Import start page, click Next.

4. On the Select the database connection page, check the One Identity Manager
database connection data and change it if necessary.

5. (optional) On the Loading an import definition file page, load the import
definition file, if available.

| NOTE: Leave this field empty if you want to create a new import definition.
6. On the Select data source page, select the Import CSV file method.

7. Onthe Load import file page, load the import file and enter additional data about
the import file.

8. On the File structure page, specify how the file is structured.

9. On the Defining the line structure page, specify the structure of the lines.
10. (Optional) On the Line condition page, specify a condition for importing lines.
11. Configure the import.

a. On the Match target tables and columns page, assign the data for target
tables and target columns of the One Identity Manager database and specify
the key columns.

b. On the Specify hierarchy page, specify the data hierarchy for the import.

c. On the Handling options for data sets page, specify options for
handling the data.

d. Onthe Connection variables page, define variables that are set on import.
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12.

13.
14.

On the Saving the import definition page, save the import definition file and the
import script.

On the Saving the import definition page, start the import.

On the last page of the Data Import, quit the program or start another import.

Detailed information about this topic

Loading the CSV file on page 122

Structure of the CSV file on page 122

Defining a condition for the import on page 125
Assigning target tables and target columns on page 129
Specifying the data hierarchy on page 131

Options for handling records on page 132

Specifying connection variables on page 134

Importing the data on page 134

Using an import definition file on page 135

Loading the CSV file

On the Load import file page in Data Import, enter the following data about the
import file.

Table 40: Import file settings

Property Description

Import file  Path to the .csv file containing the data to be imported. You can use the ...

File

button beside the input field to navigate to and open the file.

Encoding of the . csv file. Encoding of the character set is determined from

encoding the character set on your workstation when the import file is loaded.

File

Change the setting if the file was created with another character set.

Language used to create the file. The language is required in order to read

language local character formats correctly, for example, dates.

Time zone If date and time information is imported, select the time zone of the data.

The time zone is required for converting the data to UTC.

Structure of the CSV file

On the File structure page in the Data Import, specify how the file is structured.
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Table 41: File structure

Property Description

Number of Enter the number of head lines in the .csv file. The header is not imported.
lines in
header

Columns Indicator for column limits.

identified b
Y o Select the Delimiter option if the data is separated by a semi-colon,

comma, space, tab, pipe, or other character. Specify the line
structure.

e Select the Fixed width option if all the data in the columns has the
same length. Specify the line structure.

Detailed information about this topic

» Specifying the line structure for data with delimiters on page 123

» Specifying the line structure for data with a fixed width on page 125

Specifying the line structure for data with
delimiters

In Data Import on the Defining the line structure page, describe how the line structure
is configured. If you have selected the Columns identified by delimiters option for the
file structure, specify the following settings.

NOTE: The Line break preview pane displays the line structure according to the
selected settings.

Table 42: Line structure

Property Description

Delimiter Delimiter used to separate the data in the file. You have the following
options: Semicolon, Comma, Space, Tab, and Pipe.

If the data is separated by a different character, select other: and enter the
delimiter in the input field next to the drop-down.

Text Character enclosing the column text. This text is treated as one value on
qualifier import, even is the text contains the delimiter given as above.

| NOTE: The delimiters are masked by doubling them up.

Example:
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Property Description

Delimiter: Comma (,)
Text qualifier: Quotation mark (")
Value in file: "User,BS"
Value after import: User,BS
Delimiter: Comma (,)
Text qualifier: Not given or other character:
Value in file: "User,BS"
1st value after import: "User
2nd value after import: BS"
Mask Specifies whether the data is separated by several of the same delimiters.

delimiter Data that contains a new line must be marked with a text qualifier.
by doubling Example:

Delimiter: Comma (,)
Mask delimiter by doubling: Enabled
Value in file: User,,BS
Value after import User,BS
Delimiter: Comma (,)
Mask delimiter by doubling: Not set
Value in file: User,,BS
1st value after import: User

2nd value after import:

3rd value after import: BS
Multiple Specifies whether the import contains a multivalued property column (MVP)
valuesin/ and the column should not be imported directly. Individual values are

delimited entries in another table and should be linked through a many-to-many
by table.

» Using the drop-down, specify Multiple values in the column in
question.

» In Delimited by: enter the values' delimiter.
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Property Description

The column values are split up. A new line is generated for each value
although the rest of the columns remain the same.

Example:
The line
Chris;User2;0rg1|0rg2|0rg3
is converted by suitable settings to the import source
Chris;User2;0rg1
Chris;User2;0rg2
Chris;User2;0rg3

Related topics

e Structure of the CSV file on page 122
» Specifying the line structure for data with a fixed width on page 125

Specifying the line structure for data with a
fixed width

In Data Import on the Defining the line structure page, describe how the line structure
is configured. If you have selected the Columns identified by fixed width option for the
file structure, specify the width of the columns.

e Click on the ruler in the Data Import preview to set a separation point. A separation
mark is inserted.

e When you click again on a fixed separation point, the separation mark is deleted.

Related topics

e Structure of the CSV file on page 122
» Specifying the line structure for data with delimiters on page 123

Defining a condition for the import

To exclude individual data records from the import, you can specify a condition for the lines
to be imported on the Line condition page in the Data Import.

Format the condition in VB.Net syntax. The columns are accessed with dollar notation. For
more information about scripts in One Identity Manager, see the One Identity Manager
Configuration Guide.

You can access the columns using the column index (0...n).
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Example:

Do not import the data record if the first column contains the oLD value.
Value = $0%$<>"0OLD"

.

If a header is defined, you can use the column identifier for access.

Example:

Import the data record if the column with the name NewData contains the True value.
Value = $NewData:Bool$

Importing data from an external
database

To import data from an external database into the One Identity Manager
database

1. Start the Launchpad and log in to the One Identity Manager database.

2. Inthe Configure > Data synchronization section, select Configure a data
import and click Run.

This starts the Data Import program.
3. On the Data Import start page, click Next.

4. On the Select the database connection page, check the One Identity Manager
database connection data and change it if necessary.

5. (optional) On the Loading an import definition file page, load the import
definition file, if available.

| NOTE: Leave this field empty if you want to create a new import definition.

6. On the Select data source page, select the Import from database import
method.

7. On the Select external database page, specify the connection data to the
external database.

8. On the Select source data page, formulate the query to determine the data records
from the external database.

9. Configure the import.
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10.

11.
12.

a. On the Match target tables and columns page, assign the data for target
tables and target columns of the One Identity Manager database and specify
the key columns.

b. On the Specify hierarchy page, specify the data hierarchy for the import.

c. On the Handling options for data sets page, specify options for
handling the data.

d. On the Connection variables page, define variables that are set on import.

On the Saving the import definition page, save the import definition file and the
import script.

On the Saving the import definition page, start the import.

On the last page of the Data Import, quit the program or start another import.

Detailed information about this topic

Selecting external databases on page 127

Determining source data on page 128

Assigning target tables and target columns on page 129
Specifying the data hierarchy on page 131

Options for handling records on page 132

Specifying connection variables on page 134

Importing the data on page 134

Using an import definition file on page 135

Selecting external databases

In the Data Import on the Select external database, specify the connection information.
Refer to the documentation of the database provider implemented, for the connection
parameters.
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To set up a connection with an external database

1. Inthe Connection type section, select the provider of the external database.

e A list of the various database providers available is shown.

Supported database provides

Odbc Data Provider

OleDb Data Provider
OracleClient Data Provider
SQLClient Data Provider
dotConnector for Oracle

MicrosoftSQL Server Compact Data Provider

 When you use another database provider, select it using the ... button next to
the input field.

2. Inthe Connection data section, enter the connection data to the external database.
a. Select the ... button and enter the connection data.
b. (Optional) To encrypt the connection data, click .
c. To check the connection data, click Test.

3. If date and time information is imported, select the time zone of the data in the
Other settings section. The time zone is required for converting the data to UTC.

Determining source data

Formulate the query determine the data records from the external database in the
Data Import on the Select source data page.

To determine the data from the external database
e To select the table and columns from the external database directly, activate the
Select source table and columns option and enter the following information.
Table 43: Settings for selecting the table and columns

Property Description

Table Tables whose content is imported.
Columns Columns whose content is imported.
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Property Description

Enter the column relations directly in the input field or use the ...
button to open a dialog window to select the columns.

WHERE Condition to further limit the data to be imported.
clause

Order by The sort order is required if the data records have to be transferred in
a defined sequence, for example, as in hierarchical structures. Format
the sort order as a valid order by statement for a database query.

» To determine the data records with an SQL query, enable the SQL statement option
and formulate the database query in SQL syntax.

Configuring an import

Creating an import configuration includes the following steps:

1. Assigning the data to target tables and columns in the One Identity Manager
database.

2. Specifying the data hierarchy for the import.
3. Specifying options for handling the data.

Defining variables that are set on import.

Detailed information about this topic

« Assigning target tables and target columns on page 129
e Specifying the data hierarchy on page 131
» Options for handling records on page 132

» Specifying connection variables on page 134

Assigning target tables and target columns

On the Match target tables and columns page in Data Import, specify the how the data
is stored in the One Identity Manager database.
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To assign target table and target columns

1. Inthe Target table section, select the target table into which data is imported.

TIP: Use the " button in the Target table section to assign the target columns and
key automatically. You should always check this suggestion.

Assigns a column if one is found in the target table whose nhame matches the name
in the source column.

2. Inthe Target columns and key section, specify the mapping of data in the target
columns of the table.

NOTE: If a target column is not yet assigned, Not assigned is displayed as a
column identifier.

Click the arrow button beside a column identifier to open the assignment wizard and
record the following information for every column.

Table 44: Properties for target columns and keys

Property Description

Use as a key Specifies whether the column is used as a key column.

column More than one key columns can be defined. The data records to

import into the database are determined based on key columns.
Data records should be uniquely identified with these key columns.

Conversion Use the conversion script to modify source column values to match

script the permitted value of the target column. This is required, for
example, if a list of permitted values is defined for the target
columns.

Write the conversion script in VB.Net syntax. You access the values
with the variable value. Use dollar notation to access the source
columns. For more information about scripts in

One Identity Manager, see the One Identity Manager
Configuration Guide.

Target Select the target columns to be imported into the data. All columns
column from the target table are displayed with their data type. Following
applies:

» Compulsory data is labeled with a blue triangle in front of the
data type.

e Columns without sufficient permissions are displayed in gray.

» Columns, deactivated by preprocessor condition, are not
shown.

TIP:

« Use the "\ button to suggest a column if a column whose
identifier matches the designation of the source column is
found in the target table. You should always check this
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Property Description

suggestion.

¢ Use the Show column captions option to switch between
the display name and technical name of the column.

TIP: In the assignment wizard, you can use the > button to switch to the next
column. The Data preview pane contains a preview of the values.

Related topics

e Inserting columns with fixed values on page 131

Inserting columns with fixed values

In Data Import, you can insert additional columns with fixed values in the data import and
import into a defined column.

To insert columns with fixed values

1. Inthe Target columns and key section, click the arrow button beside any column
name to open the assignment wizard.

2. Click the = button.
Enter the value in the Fixed value field.
- OR -

If the value is to be determined from the values in source columns, enter a
conversion script.

4. Assign the target column.

5. Close the system assignment wizard.

Related topics

e Assigning target tables and target columns on page 129

Specifying the data hierarchy

If an import contains data that includes dependencies, you must ensure that the reference
targets are processed before the reference sources.

For example, child departments (Department.UID_Department) are imported after parent
departments (Department.UID_ParentDepartment).
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NOTE:

» Sorting the data into a hierarchical structure can consume a great deal of memory
in the Data Import. Therefore, only use this procedure for imports with small
amounts of data.

e For more extensive CSV imports, sort the data in advance in the import file to
resolve the object dependencies.

e For extensive imports from external databases, use the Order-by clause to
sort the data.

To sort the data in the Data Import hierarchically

1. Onthe Specify hierarchy page, enable the Sort by hierarchy option.

2. Select the Key column in which the data is mapped, for example, Department.UID_
Department.

3. Select the Parent key column, for example, Department.UID_ParentDepartment.

Related topics

» Determining source data on page 128

Options for handling records

In the Data Import on the Handling options for data sets page, specify how new and
existing data records are handled when imported. The import must take several cases into
account and respond accordingly in each case. During the import, the data records of the
source data are compared with the database entries. You can use a condition to further
limit the relevant database entries.

Use the following settings to specify how the data records are processed.

Table 45: Options for handling records

Property Description

Insert new data The data record from the source data does not yet exist in the

set database. If the option is enabled, the data record is inserted in the
database.

Adapting There is an entry in the database that matches the source data record.

existing records If the option is enabled, the data record is updated in the database.

If multiple entries exist in the database, which match the source data
record, an entry is written to the error log.

Delete records The database contains an entry that is not contained in the source
that no longer data. If the option is enabled, the entry is deleted from the database.
exist
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Property Description
Limiting the Use a condition to limit the quantity of relevant database entries. The
target objects condition is tested when importing begins.

There is a wizard available though the & button next to the input field,
to help you formulate your condition.

NOTE: If the Insert new data set option is enabled, source data
records that do not fall within the area of relevant database entries
due to the limit are handled as new data records and inserted in the
database. Under certain circumstances, this can lead to errors such
as duplicate data records.

Example for handling data sets

Case Description

A All objects in the database.

B Database set restricted by condition.

C Entry in source data.

D All entries in the database and in the source data. Typical action: update
all entries in the database.

E Entries that are only in the source data but not in the database. Typical
action: add new entry in the database.

F Entries that are in the database but not in the source data. Typical action:
clean up entries in the database.

G Entries that are in the source data but no in range selected in the
database. These entries are treated as in case E although adding entries
may cause conflicts in certain circumstances.
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Specifying connection variables

Connection variables are set when the import is run immediately and are also added to the
generated import script. You can use the variables in customized processes or templates
that are run after importing.

To define a connection variable in the Data Import
1. Click the < button on the Connection variables page.
2. Click the Name entry and enter the variable name

3. Click the Value entry and enter the value of the variables.

To delete a connection variable in the Data Import

« Click the ® button on the Connection variables page.

Importing the data

The following methods are available to you to import data:

o Start the data import manually in the Data Import. The data records that are
processed during import are logged.

e To run data imports on a regular basis, create an import script.

You can use the import script in custom processes, for example. To create custom
processes to run the import, use the DataImport process task of the ScriptComponent
process component.

For more information about creating and editing processes, see the
One Identity Manager Configuration Guide.
Detailed information about this topic

e Start import immediately on page 134

e Creating import scripts on page 135

Start import immediately

To start the import immediately in the Data Import

1. In Data Import, on the Saving the import definition page, set the Import
data option.

2. To start the import, click Next.
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After importing has finished the processing result are displayed. If errors occur
during the importing process you can view them with Show.

| TIP: Save the import log using the Save log as file context menu item.

Related topics

e Creating import scripts on page 135

Creating import scripts

NOTE: The import script is stored in the One Identity Manager database. To transfer
import scripts to the database, users required the DataImport_CreateScript
program function.

To create an import script

1. In Data Import, on the Saving the import definition page, enable the Create
import script option.

2. Enter a name for the import script in Import script name.

Only the VB name are permitted. If a character is not permitted, the field is
highlighted in red.

3. Select a change label in Add script to tag. Use the ... button to create a new
change label.

4. To create the import script, click Next.
5. Compile the script library after saving the script. Click Yes to start the compiler.

Related topics

» Start import immediately on page 134
« Working with change labels on page 78

Using an import definition file

The import definition provides you with configuration settings for future data imports.
Create the import definition file in the Data Import after creating an import. The import
definition is saved as a .xnl file.

To save an import definition

1. Inthe Data Import, on the Saving the import definition page, enable the Save
import definition file option.

2. Click the ... button beside the input field.
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3. Select the path and enter the file name.
4. Click Save.

Related topics

» DatalmporterCMD.exe on page 173
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16

Importing and exporting individual
files for the software update

To distribute new or modified files, such as files from a hotfix package or custom form
archives, using the automatic software update function to the workstations and
servers, import the files into the Software Loader database using the

One Identity Manager program.

All files of a One Identity Manager installation are stored in the One Identity Manager
database with their name, repository, content, and a hash value. Each file's
assignment to the One Identity Manager tools, such as Manager or

One Identity Manager Service, is logged.

When you import a file, the Software Loader initially determines the file status based on the
file information in the database. To test the file version, the file size and the hash value are
determined and compared to the entry in the database.

After a file is successfully imported into the database, the software revision semaphore
value in the database is updated by the DBQueue Processor. During the next semaphore
test, the file is added to the list of files to be updated and is distributed to the workstations
and servers.

To equip individual Job servers with the latest software revision manually, you can use the
Software Loader program to export individual files from the One Identity Manager
database. During the export, the Software Loader checks whether the file already exists in
the specified export directory. If this is the case, the file is updated; otherwise, a new
version of the file is created.

For more information about updating One Identity Manager and about the automatic
software update function, see the One Identity Manager Installation Guide.

Detailed information about this topic

» Importing custom files into One Identity Manager databases on page 138
» Editing file settings for the automatic software update on page 139

e Exporting files from a One Identity Manager database on page 140
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Importing custom files into
One Identity Manager databases

If you use the Software Loader to import new files into the One Identity Manager database,
you should assign the files to a machine role. This ensures that the file are distributed by
automatic software update.

For more information about machine roles, see the One Identity Manager
Configuration Guide. For more information about automatic software updates, see the
One Identity Manager Installation Guide.

To import files into a One Identity Manager database

Start the Launchpad and log in to the One Identity Manager database.

2. Inthe Change & Extend > Change, extend and prepare the data model
section, select the Import files for software update entry and click Run.

This starts the Software Loader program.
3. Select Import into database on the home page.

4. On the Connect to database page, check the One Identity Manager database
connection data and change if necessary.

5. Specify the file to be imported on Select files.
a. Select the base directory where the files can be found.

The status and file size of all the files in the selected directory are displayed in
the file list.

Table 46: Meaning of the status

State Meaning

Version The file belongs to the known files but has not yet been loaded

unknown into the database. There is no version information in the
database.

Unknown The file is new. The file is in the list of known files but has not
file been loaded in the database yet. There is no version information
in the database.

Version OK The file version matches the version in the database.

Version The file version has changed with respect to the version in the
modified database.

b. Select the files you want to load into the One Identity Manager database.
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TIP:

e Click a column in the table header to order the display by the
selected column.

* Press Shift + select or Ctrl + select to select more than one file.

e To quickly select all files with Changed version as their status, select
Open all directories and Open all modified files in the context
menu. Files in subdirectories are only selected if the higher-level
directories have already been opened.

6. On the Select change label page, assign a change label to make it easier to
exchange files between various databases, such as the test, development, and
production databases.

a. Select Assign files to following change label.
b. Use the button next to the option to select the change label.
7. Thefiles are loaded straight from the One Identity Manager database.
Specify other file settings on Assign machine roles.
a. Assign the files to the machine role.

b. (Optional) For more file settings, click ... next to the file names.

Table 47: Other file settings

Setting Description

Source Path to the installation source directory.

directory

Create A copy must be made of the file during the automatic
backup software update.

No update The file is not updated by the automatic software update.

9. To end the program, click Finish on the last page.

Related topics

e Exporting files from a One Identity Manager database on page 140

» Editing file settings for the automatic software update on page 139

Editing file settings for the automatic
software update

When importing files using the Software Loader program, you specify whether a backup
copy of the existing file is to be created during the automatic software update. You can
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modify these settings later on.

A | CAUTION: Do not change any other file properties as this can lead to errors during
the automatic software update.

To configure the file properties

1. Inthe Designer, select the Base Data > Installation > One Identity Manager
software category.

2. Select afile.
Edit the following main data.

e Create backup: During the automatic software update, a backup of the
existing file is created for files marked with this option.

* No update: Files marked with this option are not updated by the automatic
software update.

Related topics

e Importing custom files into One Identity Manager databases on page 138

Exporting files from a
One Identity Manager database

To export files from a One Identity Manager database

1. Start the Launchpad and log in to the One Identity Manager database.

2. Inthe Change & Extend > Change, extend and prepare the data model
section, select the Import files for software update entry and click Run.

This starts the Software Loader program.
3. Onthe home page, select Export from database.

4. On the Connect to database page, check the One Identity Manager database
connection data and change if necessary.

5. Specify which data to export on the Select files page.
a. Specify the destination directory to export the file to.

The Files tab displays the exported files with their status and file size.
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Table 48: Meaning of the status

State Meaning

Unknown file  The file is not yet exported from the database to the given
directory.

Version OK The file version matches the version in the database.

Version The file version has changed with respect to the version in

modified the database.

b. Mark the files to export.

e To export all the file of a machine role, select the machine role on the
Machine role tab.

e To select single files, select the files on the Files tab.
TIP:

e Click a column in the table header to order the display by the
selected column.

o Use Shift + select or Ctrl + select to select multiple files.

6. The marked files are export to the given directory. This may take some time
depending on the number of files selected. The export steps are displayed on the
page Uploading files. Any export errors are displayed. After exporting is complete,
click Next.

7. To end the program, click Finish on the last page.

Related topics

» Importing custom files into One Identity Manager databases on page 138
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Appendix A

Creating a One Identity Manager
database for test or development
from a database backup

The Configuration Wizard provide you with support for enabling a restored database. The
necessary database users, database roles, and server roles are created and the database
is compiled.

To create a test or development database from a database backup from
another system

1. Create a new database on the database server in the reference environment.

2. Create a database backup of the original database.
3. Restore the backup to the reference database.
4. Start Configuration Wizard on an administrative workstation.

a. On the Configuration Wizard's home page, select the Enable restored
database option and click Next.

b. On the Select database page, select the database and installation directory.

i. Select the database connection in the Select a database connection
pane. Select a user who at least has administrative permissions for the
One Identity Manager database.

ii. Inthe Installation source pane, select the directory with the
installation files.

c. Onthe Database check page, errors are displayed that prevent the database
from being processed. Correct the errors before you continue updating.

d. Onthe Create a new login for administrators page, decide which SQL login
to use for administrative users.

You have the following options:

» Create new SQL logins for the database: Select this option if you
want to work with granular permissions and create a new, administrative
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SQL login.

e Enter the login name, password, and password confirmation for the
new SQL login.

Later on in the process, the Configuration Wizard sets up additional SQL
logins for the configuration user and the end user.

» Use an existing SQL login: Select this option if you have already
created an administrative SQL login and want to use it. Later on in the
process, the Configuration Wizard sets up additional SQL logins for the
configuration user and the end user.

a. Enter the login name, password, and password confirmation for
the SQL login.

b. Setthe Permissions option so that the SQL login obtains
permissions for the database. If this option is not set, only the
permissions are tested.

» Use the current SQL login for the database: When you select this
option, no additional SQL logins are created for the database. In this
case, you cannot work with granular permissions concepts at SQL level.

The user you specified is used to connect to the database.

e. On the System administrator connection page, enter the login credentials
for the database login with system administrator permissions.

NOTE: This page is only shown if you are working with granular permissions
and you have to make changes to the administration user's permissions.

f. The installation steps are shown on the Processing database page.
Installation and configuration of the database are automatically carried out by
the Configuration Wizard.

TIP: Set Advanced to obtain detailed information about processing
steps and the migration log. You can copy messages to the clipboard
with CTRL + C.

i. During the update process, you must log in as an administrative user.

i. Enter a user name and password for the administrative
system user.

ii. Click Connect.
ii. Once processing is complete, click Next.

g. Onthe Create logins for configuration and end users page, enter the
login name, the password, and password confirmation for the SQL logins of
configuration users and end users.

NOTE: This page is only shown if you have chosen granular permissions on
the Create a new login for administrators page and the SQL logins are
not yet available on the database server.
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h. The Processing database tasks page is only shown if there are still
DBQueue Processor tasks queued in the DBQueue that are prerequisite for
installing the database. Once processing is complete, click Next.

i. Onthe Database Agent Service information page, you are instructed to
install the Database Agent Service. Click Next.

j. On the last page of the Configuration Wizard, click Finish.
5. Inthe Designer, adjust the database's staging level.
a. Inthe Designer, select the Base Data > General > Databases category.

b. Select the database and change the value of the Staging level property to
Test environment or Development system.

c. Selectthe Database > Save to database and click Save.
6. Verify in the Designer

7. Customize the synchronization project's connection data in the
Synchronization Editor.
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Appendix B

Initializing DBQueue Processor the

after extending the server hardware

After extending the server hardware for the SQL Server, the DBQueue Processor must be
initialized again.

To initialize the DBQueue Processor manually

1.

(GNE IDENTITY

Wait until all DBQueue Processor tasks have completed. You can do this using the
Job Queue Info.

Start a suitable program for running SQL queries and perform the following
steps one by one.

IMPORTANT: Select a user that you use for migrating the database to run the
SQL queries.

Check whether other database sessions are active.
select *

from sys.sysprocesses p

where dbid = DB_ID()

and spid <> @@SPID

If there are still sessions active, they must be closed first.
Stop all DBQueue Processor components.

exec QBM_PWatchDogPrepare 1

go

exec QBM_PDBQueuePrepare 1

go

Initializing the DBQueue Processor.

exec QBM_PDBQueuePrepare 0,1

go

exec QBM_PWatchDogPrepare

g0
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For more information about using the DBQueue Processor, see the One Identity Manager
Configuration Guide.
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Appendix A

Command line programs

You can use various command line programs to automate different implementations of
One Identity Manager.

Detailed information about this topic

InstallManager.CLI.exe

InstallManager.CLI.exe on page 147
DBCompilerCMD.exe on page 150
Quantum.MigratorCmd.exe on page 153
AppServer.Installer.CMD.exe on page 160
AutoUpdate.exe on page 165
SoftwareLoaderCMD.exe on page 168
DBTransporterCMD.exe on page 170
DatalmporterCMD.exe on page 173
SchemaExtensionCmd.exe on page 176
CryptoConfigCMD.exe on page 178
DBConsCheckCmd.exe on page 180

DatabaseAgentServiceCmd.exe on page 185

Create-web-dir.exe on page 185

The InstallManager.Cli.exe program provides support for the installation of
One Identity Manager. You can run the program from the command line.

| IMPORTANT: Run the installation using the command line console in administrator mode.

Calling syntax

InstallManager.Cli.exe
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-m install|change|remove|uninstall

-r {Directory}

[-i {Directory}]
[-ful

[-mod {ModuleIDs}]
[-d {Targets}]

[-p {Packages}]
[-1 {Path}]

[-fol]

[-cs {Service name} {Properties}]

[-dc]

Table 49: Program parameters and options

Parameter Alternative Description

or option

-m --mode Installation mode. Permitted values are

e install: Install new modules.

¢ change: Update existing modules.

¢ remove: Delete modules.

e uninstall: Uninstall complete installation.

-r --rootpath Directory containing the installation sources.

- --installpath (Optional) Directory in which to install.

-fo --filesonly (Optional) Only file actions will be run. No start
menu entries or registry keys are generated and no
services are installed.

NOTE: To run this operation, you do not require
administration permissions.

-mod --module Space-delimited list of module IDs.

-d --deploymenttarget Space delimited list of machine roles.

-p --packages Space-delimited list of packages.

-| --logfile (Optional) Path to the log file.

-fu --forceupdate (Optional) All data will be reinstalled.

-CS --changeservice Changes the properties for registration of the
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e Service name: Name of the service to be
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Parameter Alternative Description
or option

changed

* Properties: New properties of the service
with:

e Name: Name of the service.

e Display: Display name of the service.

e Description: Description of the service.
Example:

"Name=<New name>;Display=<New
display>;Description=<New Description>"

You only need to specify the properties that
are to be changed.

-dc --deleteconfig (Optional) Configuration data and logs are removed
in uninstall mode.

-h --help Display program help.

Example: Installing a single module

InstallManager.Cli.exe
-m install
-r c:\sourcedir

-mod QER ADS SAP LDAP ATT

Example: Updating a machine role

InstallManager.Cli.exe
-m change
-r c:\sourcedir

-d Server\JobServer\ADS
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Example: Uninstalling the One Identity Manager components

InstallManager.Cli.exe
-m uninstall
-i c:\installdir

-dc

DBCompilerCMD.exe

The DBCompilerCMD.exe program supports compiling a database.You can run the program
from the command line.

Calling syntax

DBCompilerCMD.exe
/Conn="{Connection string}"
/Auth="Module={Authentication string}"
[/LogLevel=0ff|Fatal|Error|Info|Warn|Debug|Trace]
[/IgnoreErrors=True|False]
[-W]
[ /DumpModules]
[/Modules=[CompileScriptsCore] [ExtractWhereClauses] [FillMultilLanguage]]
[/SkipModules=[CompileScriptsCore] [ExtractWhereClauses] [FillMultilLanguage]]
/WaitTimeout
[-A]
[/AutoCompileCheckInterval]
[/AutoCompileWaitSeconds]
[/AutoCompileErrorWaitSeconds]
[-S]
[-C]
[-v]
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Table 50: Program parameters and options

Parameter or option

Description

-A

/Auth

/AutoCompileCheckInterval

/AutoCompileErrorWaitSeconds

/AutoCompileWaitSeconds

/Conn
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(Optional) Automatic compilation of the database.
The database is monitored and compiled if necessary.
This runs until the program is terminated with Ctrl +
C.

(Optional) Compile only modified parts of the system.

(Optional) Messages are outputted to the console
without timestamp or severity level.

(Optional) Provides additional information (verbose).

(Optional) Wait for the processing of
DBQueue Processor tasks to complete before starting
compilation.

Authentication data. The authentication data depends
on the authentication module used. For more
information about One Identity Manager
authentication modules, see the

One Identity Manager Authorization and
Authentication Guide.

(Optional) Interval in seconds to check if the database
needs to be compiled.

Default: 30

(Optional) If an error occurs during compilation, the
next compiler run is deferred by this time interval
before actually being be performed.

Default: 60

(Optional) After a compilation request is detected,
compilation is deferred by this time interval before
actually being be performed.

Default: 0

Database connection parameter. A user with a
minimum access level of Configuration user is
required.

For more information about permissions, see the
One Identity Manager Installation Guide and the
One Identity Manager Authorization and
Authentication Guide.

Alternatively, you can enter the name of the
connection according to the registry HKEY_CURRENT_
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Parameter or option

Description

/IgnoreErrors

/LoglLevel

/Modules

/DumpModules

/SkipModules

/WaitTimeout
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USER\Software\
One Identity
\One Identity Manager\Global\Connections.

(Optional) Specifies if error messages are ignored.
Permitted values are True and False.

(Optional) Scope of output to be processed. Permitted
values are:

e Off: No logging.

e Fatal: All critical error messages are logged.
e Error: All error messages are logged.

e Info: All information is logged.

e Warn: All warnings are logged.

» Debug: Debugger outputs are logged. This
setting should only be used for testing.

* Trace: Highly detailed information is logged.
This setting should only be used for analysis
purposes. The log file quickly becomes large
and cumbersome.

(Optional) Space-delimited list of compiler modules to
be compiled. Permitted values are:

e CompileScriptsCore: Compile script
components.

e ExtractWhereClauses: Extract Where clauses
and mark as secure.

e FillMultilanguage: Extract language-
dependent texts.

Example:

FillMultiLanguage CompileScriptsCore

(Optional) Deploying the compiler module without
compiling.

(Optional) Space-delimited list of compiler modules
that must not be compiled.
Example:

FillMultiLanguage CompileScriptsCore

Maximum waiting time for DBQueue.
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Parameter or option Description

Default: 00:10:00
-? |-h Display program help.

Example:

DBCompilerCMD.exe

/Conn="Data Source=<Database server>;Initial Catalog=<Database
name>;User ID=<Database user>;Password=<Password>"

/Auth="Module=DialogUser;User=<User name>;Password=<Password>"

-W

Quantum.MigratorCmd.exe

The Quantum.MigratorCmd.exe program supports migration of a One Identity Manager
database. You can run the program from the command line.

Calling syntax for installation

quantum.migratorcmd.exe
--INSTALL
/Connection="{Connection string}"
/System=MSSQL
/Module={Module IDs}[+]
/Destination="{Directory}"
[/Password={Password}]

[/Admin="mode=create|check|extend;login={SQL Server login name};password={SQL
Server login password}]

[/Login="User=Config|User;login={SQL Server login name};password={SQL Server
login password}"]

[/Person="condition={Condition};password={Identity password}"]
[/User="DialogUser={System user};password={System user password}"]
[/PasswordPolicy="{Password policy settings}"]

[ /Group="GroupName={Group name}"|skip]
[/LogLevel="0ff|Fatal|Error|Info|Warn|Debug|Trace"]
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[/PreCheck={[+]|-] Precheck ID}]
[/Edition]

[/DialogDatabase]

[/Config]

[/PostSQL]

Calling syntax for updating

quantum.migratorcmd.exe
--UPDATE
/Connection="{Connection string}"
/Module={Module IDs}[+] /destination="{Directory}"

[/Admin="mode=create|check|extend;login={SQL Server login name};password={SQL
Server login password}]

[/SysAdmin="Data Source=<Database server>;Initial Catalog=<Database
name>;User ID=<Database user>;Password=<Password>"]

[/Login="User=Config|User;login={SQL Server login name};password={SQL Server
login password}"]

[/Person="condition={Condition};password={Identity password}"]
[/User="DialogUser={System user};password={System user password}"]
[/PasswordPolicy="{Password policy settings}"]
[/Loglevel="0ff|Fatal|Error|Info|Warn|Debug|Trace"]
[/PreCheck={[+]|-] Precheck ID}]

[/KeepUpdatePhase]

[/DialogDatabase]

[/Config]

[/PostSQL]

[/ForceFullMigration]

Calling syntax for restoring a database

quantum.migratorcmd.exe
--RESTORE
/Connection="{Connection string}"
/Destination="{Directory}"

[/Admin="mode=create|check|extend;login={SQL Server login name};password={SQL
Server login password}]
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[/Login="User=Config|User;login={SQL Server login name};password={SQL Server

login password}"]
[/Person="condition={Condition};password={Identity password}"]
[/User="DialogUser={System user};password={System user password}"]
[/PasswordPolicy="{Password policy settings}"]

[ /Group="GroupName={Group name}"|skip]
[/LogLevel="0ff|Fatal|Error|Info|Warn|Debug|Trace"]
[/PreCheck={[+]|-] Precheck ID}]

[/KeepUpdatePhase]

[/DialogDatabase]

[/Config]

[/PostSQL]

Calling syntax for deleting a database

quantum.migratorcmd.exe
--DELETE
/Connection="{Connection string}"

/Destination="{Directory}"

Calling syntax for passing parameters as a file

quantum.migratorcmd.exe @File

Table 51: Program parameters and options

Parameter or Description

option

--Delete Deletes database including all files and SQL logins.

--Delta For internal use only.

--Dump For internal use only.

--Import For internal use only.

--Install Installs new database.

--Restore This operation performs the necessary steps to make the database

--Update

(GNE IDENTITY

operational, such as initializing the DBQueue Processor or
restoring logins.The operation can be performed after a database
has been restored from a backup, for example on another server.

Updates database.
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Parameter or
option

Description

/Clear

/Format

/HashSize
/KeepUpdatePhase

/LoglLevel

/Password

/Condition
/Config

/Connection

/From
/To
/Destination

/DialogDatabase

(GNE IDENTITY
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For internal use only.
For internal use only.
For internal use only.

(Optional) If the parameter is set, the update phase is not reset to
0 after migration is complete (DialogDatabase.UpdatePhase).

(Optional) Scope of output to be processed. Permitted values are:
e Off: No logging.
e Fatal: All critical error messages are logged.
e Error: All error messages are logged.
e Info: All information is logged.
e Warn: All warnings are logged.

» Debug: Debugger outputs are logged. This setting should
only be used for testing.

e Trace: Highly detailed information is logged. This setting
should only be used for analysis purposes. The log file
quickly becomes large and cumbersome.

(Optional) Initial password for the viadmin system user when a
new database is installed.

For internal use only.
(Optional) Global JSON configuration file for variables.

Database connection parameter. A user with a minimum access
level of Administrative user is required.

For more information about permissions, see the
One Identity Manager Installation Guide and the
One Identity Manager Authorization and Authentication Guide.

Alternatively, you can enter the name of the connection according
to the registry HKEY_CURRENT_

USER\Software\

One Identity\One Identity Manager\Global\Connections.

For internal use only.
For internal use only.
Source directory .

Passes information about the database (DialogDatabase table).
The value updates the entry for the database in the
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Parameter or
option

Description

/Edition

/Group

/Admin

(GNE IDENTITY
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DialogDatabase table. This allows a new database to immediately
create a valid entry in the DialogDatabase table.

Example: "CustomerName=<your name>;ProductionLevel=2"
(Optional) Edition to be installed. Permitted values are:

e DGE: One Identity Manager Data Governance Edition

e STE: One Identity Manager Edition

(Optional) Creates custom permissions groups
(DialogGroup.GroupName). To create several permissions groups,
the parameter can be entered more than once.

Example:
/Group="GroupName=CCCCustomGroup"

The skip keyword can be used to skip creation of the permission
groups. This means that no permissions groups are created.

Example:
/Group=skip

If the parameter is not provided, the default groups CCCEditPer-
missions, CCCViewPermissions, CCCEditRole, and
CCCViewRole are created.

(Optional) Mode for creating SQL logins if granular permissions are
used.

 mode: Specifies in which mode the SQL login is created.
Permitted values are:

e create : The SQL login does not exist yet and will be
created.

e check: The SQL login already exists. This checks the
permissions for the SQL login. If the necessary
permissions are missing, an error message is
displayed.

» extend: The SQL login already exists. This extends the
permissions for the SQL login.

* login: Name of the SQL login.
» password: Password for the SQL login.

Example: Create a new SQL login "OneIM_Admin" with password
"secret".

/admin="mode=create;Login=0neIM_Admin;Password=secret”
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Parameter or
option

Description

/Login

/Module

/ModuleOwner

/Operation

/PasswordPolicy

/Person

(GNE IDENTITY

(Optional) Creates the other SQL logins if granular permissions are
used. Multiple instances of this parameter are possible.

» user: Name of the database user according to
QBMDBPrincipal.UserName.

Permitted values are:
e Config: Configuration user.
e User: End user.
* login: Name of the SQL login.

» password: Password for the SQ login.

Example: Creating SQL logins for configuration users and end
users.

/login="User=Config;Login=0neIM _Config;Password=secret"

/login="User=User;Login=0neIM_User;Password=secret"”

Comma delimited list of module IDs.

For UPDATE operation: If the module ID is followed by a plus sign
(+), only this module is updated. If no plus sign is specified, all
modules listed are updated.

For internal use only.

Alternative name of the operation.

Example: /operation=INSTALL

(Optional) Temporarily altered configuration of the default
password policy. For example, this could be used to override the
policy settings and permitted character sets (corresponding to the
QBMPwdPolicy table). The configuration is only used while the
program is running and is not saved in the database.

/PasswordPolicy="MinLen=12;MinNumbers=2"

(Optional) Configuration of an identity's password
(Person.DialogUserPassword). Multiple instances of this parameter
are possible.

e condition: A valid SQL condition for the person table.

« password: Password (plain text or password hash).

Example: Sets the "secret" password for the identity with the
internal name "Sys, admin".

/person="Condition=InternalName="'Sys, admin';
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Parameter or
option

Description

/PostSQL

/PreCheck

/SysAdmin
/System
/User

/ForceFullMigration

@file

2 1h

Password=secret"

(Optional) Name of a file (*.sql) containing SQL queries that will
be run after the database operation (Install/Update/Restore). This
enables a database configuration without other programs.

(Optional) Controls the handling of database pre-checks. The
input is given as + or - followed by the ID for the pre-check.
Multiple instances of this parameter are possible.

e +ID: The pre-check is repaired. If the pre-check is not
repairable, an error message is displayed.

» -ID: Pre-check is ignored. This only works for optional tests.

Example: /precheck=-JobqueueEmpty.

The ID can be taken from the PreCheck with ID '{@}' failed!
error message.

Connection parameter for an administrative database connection.
Database system. Permitted value is MSSQL.

(Optional) Configuration of a system user's password
(Person.DialogUserPassword). Multiple instances of this parameter
are possible.

+ DialogUser: Name of the system user
(DialogUser.UserName).

» password: Password (plain text or password hash).

(Optional) Forces a complete check and repair of the default data
during the schema update (Update). This procedure usually takes
some time. If this option is not available, the schema is updated
using a faster delta process.

As an alternative to directly issuing commands, you can name a
text file containing the commands. Every command isin a
separate line.

(Optional) Provides additional information (verbose).

Display program help.

Example: Installing a database

quantum.migratorcmd.exe

(GNE IDENTITY
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--Install

/connection="Data Source=<Database server>;Initial
Catalog=<Database>;User ID=<Database user>;Password=<Password>"

/module="TSB,ATT,CPL,HDS,POL,RMB,RMS,RPS"

/destination="C:\install"

Example: Restoring a database

quantum.migratorcmd.exe
--Restore

/connection="Data Source=<Database server>;Initial
Catalog=<Database>;User ID=<Database user>;Password=<Password>"
/destination="C:\install"

/LogLevel=Warning

/precheck=-JobqueueEmpty

AppServer.Installer.CMD.exe

The AppServer.Installer.CMD.exe program supports installing and uninstalling of
application servers. You can run the program from the command line.

| NOTE: Run the installation using the command line console in administrator mode.

Calling syntax for installation

AppServer.Installer.CMD.exe
--conn={Connection string}
--auth={Authentication string}
--appname={Application name}
[--site={site}]
[--app-pool={Application pool}]
[--source-dir={Directory}]
[--deployment-target={Machine role}]
[--allow-http]

[--windows-auth]
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[--db-windows-auth]

[--skip-file-permissions]
[--runtime-connection={Connection string}]
[--hdb-connection={History Database ID|Connection string}]

[/updateuser {User name} [/updateuserdomain {Domain}] [/updateuserpassword
{Password}]]

[
--cert-mode=existing --cert-thumbprint={Thumbprint}
I

--cert-mode=new --cert-issuer {Issuer} [--cert-key=1024|2048|4096]

--cert-mode=newfile --cert-issuer {Issuer} [--cert-key=1024|2048|4096]
[--cert-file={Path to certificate file}]

]
[--set-connection]
[--conn-id={History Database ID}]

[--verbose]

Calling syntax for uninstalling

AppServer.Installer.CMD.exe
--conn={Connection string}
--auth={Authentication string}
--appname={Application name}

--uninstall

Table 52: Program parameters and options

Parameter Alternative Description

or option
--conn --connection| Database connection parameter. To install an application
c server you require at least one user with the
Configuration user access level.
For more information about permissions, see the
One Identity Manager Installation Guide and the
One Identity Manager Authorization and
Authentication Guide.
Alternatively, you can enter the name of the connection
according to the registry HKEY_CURRENT_
USER\Software\
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Parameter
or option

Alternative

Description

--auth --auth-

props|-a

--appname

--site

--app-pool
--source-dir -s

--deployment- -t
target

--allow-http

--windows- -W
auth

--db-
windows-auth

--skip-file- -f
permissions

(GNE IDENTITY

Quest

One Identity
\One Identity Manager\Global\Connections.

Authentication data for the installation. The authen-
tication data depends on the authentication module
used.

For more information about authentication modules, see
the One Identity Manager Authorization and
Authentication Guide.

Application name.

(Optional) Website on the Internet Information Services
where the application is installed. If the parameter is not
set, Default Web Site is used (default).

(Optional) Application pool. If this parameter is set, the
installation is performed in the specified application pool.
If this parameter is not set, a new application pool is
installed (default).

(Optional) Installation source. If this parameter is set,
the installation is performed from the file system. If this
parameter is not set, the installation is performed from
the database (default).

(Optional) Machine role for the installation. This
parameter can be used more than once. Alternatively,
multiple machine role can be separated with a pipe [|]. If
this parameter is not set, the Server | Web |
Appserver machine role is used.

(Optional) If the parameter is set, HTTP is permitted. If
this parameter is not available, HTTPS is used (default).

(Optional) Type of authentication used for the web applic-
ation. If this parameter is set, Windows authentication is
used. If this parameter is not set, anonymous authen-
tication is used on IIS (default).

(Optional) Type of authentication used for the

One Identity Manager database. If this parameter is set,
Windows authentication is used. If this parameter is not
set, the SQL login from the connection parameters is
used.

(Optional) If this parameter is set, no permissions are
allocated for the IIS_USRS user. If this parameter is not
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Parameter Alternative

Description

or option
set, the permissions are allocated for the IIS_USRS
user (default).

--runtime- --run-conn (Optional) Database connection parameters used as

connection authentication for the One Identity Manager database,
for example, if the application server is run with the end
user access level. If this parameter is not set, the SQL
login from the connection parameters is used for the
installation (default).

--update-user (Optional) User for updating. If no user is given, the
same user account is used for the application pool.

--update- Active Directory domain of the user.

user-domain

--update- User password.

user-

password

--cert-mode (Optional) Type of certificate selection. Permitted values
are:

» existing: Uses an existing certificate.
* new: Uses a new certificate.
» newfile: Creates a new certificate file. (default)

--cert- Thumbprint of the certificate if an existing certificate is

thumbprint used.

--cert-issuer Issuer of the certificate if a new certificate or a new certi-
ficate file is created.

Example: "CN=Application Server"

--cert-key Length of the certificate’s key 1024, 2048 (default), and
4096 are permitted.

--cert-file (Optional) Directory path and name of the certificate file
if a new certificate file is created. If this parameter is not
set, "App_Data\SessionCertificate.pfx" is used.

--hdb-connec- (Optional) History Database connection parameter. This

tion value is a combination of the ID and the connection
parameter (pipe (|) delimited).

Example: “<History Database ID> |key1-
1=valuel;key2=value2;...”

--set connec- -S Changes the connection parameters for an installed

(GNE IDENTITY
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Parameter Alternative Description

or option

tion application.

--conn-id (Optional) Connection parameter identifier. If this
parameter is not set, the application server’s own
connection parameters are used.

--uninstall -R Removes the application server.

--verbose -V (Optional) Provides additional information (verbose).

--help -h, -? Display program help.

Parameter formats

Multiple-character options can be given in the following forms:

--conn="...

--conn

/conn="...
/conn "..."
Single-character options can be given in the following forms:

-C="...
-c " !

Je="o00"

VAT

Switches are allowed in the forms:
-R

/R

Example: Installing an application server

AppServer.Installer.CMD.exe

--conn="Data Source=<Database server>;Initial Catalog=<Database
name>;User ID=<Database user>;Password=<Password>"

--auth="Module=DialogUser;User=<User name>;Password=<Password>"

--appname=MyApplicationServer

--allow-http
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Example: Uninstalling an application server

AppServer.Installer.CMD.exe

--conn="Data Source=<Database server>;Initial Catalog=<Database
name>;User ID=<Database user>;Password=<Password>"

--auth="Module=DialogUser;User=<User name>;Password=<Password>"
--appname=MyApplicationServer

--uninstall

Example: Changing the connection parameters of the application
server
AppServer.Installer.CMD.exe

--set-connection

--appname=MyApplicationServer

--conn="Data Source=<Database server>;Initial Catalog=<Database
name>;User ID=<Database user>;Password=<Password>"

Example: Changing the parameters for connecting a
History Database
AppServer.Installer.CMD.exe

--set-connection

--appname=MyApplicationServer

--conn-id=<History Database ID>

--conn="Data Source=<Database server>;Initial Catalog=<Database
name>;User ID=<Database user>;Password=<Password>"

AutoUpdate.exe

The AutoUpate.exe program supports the automatic software update of a
One Identity Manager installation. You can run the program from the command line.
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Calling syntax for updating

AutoUpdate.exe

--conn={Connection string}

--Install={Directory}

[ - -system=MSSQL | APPSERVER ]

[--log-level=0ff|Fatal|Error|Info|Warn|Debug|Trace]

Calling syntax for generating a PowerShell start script

AutoUpdate.exe

--script {path and file name}

Table 53: Program parameters and options

Parameter Alternative
or option

Description

--conn --connection|
-C

--install --install-dir, -i

--system -s

--script

--log-level -|

(GNE IDENTITY
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Database connection parameter. A user with a minimum
access level of Configuration user is required.

For more information about permissions, see the
One Identity Manager Installation Guide and the
One Identity Manager Authorization and
Authentication Guide.

Alternatively, you can enter the name of the connection
according to the registry HKEY_CURRENT_
USER\Software\

One Identity

\One Identity Manager\Global\Connections.

Installation directory to be updated.

(Optional) Target system for the connection. Permissible
values are MSSQL (default) or APPSERVER.

Creates a PowerShell startup script with the specified file
name. The startup script should be located outside the
installation directory.

The startup script starts the AutoUpdate.exe program and
returns when both AutoUpdate.exe and Update.exe are
finished.

(Optional) Scope of output to be processed. Permitted
values are:

e Off: No logging.
e Fatal: All critical error messages are logged.

e Error: All error messages are logged.
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Parameter Alternative Description

or option
e Info: All information is logged. (default)
e Warn: All warnings are logged.
e Debug: Debugger outputs are logged. This setting
should only be used for testing.
e Trace: Highly more information is logged. This
setting should only be used for analysis purposes.
The log file quickly becomes large and
cumbersome.
--help -h, -? Displays program help.

Parameter formats

Multiple-character options can be given in the following forms:

--conn="...

--conn

/conn="...
/conn "..."

Single-character options can be given in the following forms:
-C="...

-c " !

Je="o00"

VAT

Switches are allowed in the forms:
-R

/R

Example: Updating the installation directory

AutoUpdate.exe

--conn="Data Source=<Database server>;Initial Catalog=<Database name>;
User ID=<Database user>; Password=<Password>"

--install="C:\Temp\InstallFolder"
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Example: Updating an installation directory from an application
server
AutoUpdate.exe

--system=APPSERVER

--conn="URL=https://myappserver/"

--install="C:\Temp\InstallFolder"

Example: Creating and running a PowerShell startup script

Creating the startup script:
AutoUpdate.exe

--script=C:\Temp\Update.psl
Calling the startup script:

.\Update.psl -Connection 'Data Source=<Database server>;Initial
Catalog=<Database name>; User ID=<Database user>; Password=<Password>' -
InstallDir C:\Temp\InstallFolder

SoftwareLoaderCMD.exe

The SoftwareLoaderCMD.exe program allows you to import files and export files to and from
the One Identity Manager database. You can run the program from the command line.

Calling syntax

SoftwareLoaderCMD.exe
/Conn="{Connection string}"
/Auth="{Authentication String}"
[/Root="{Path}"]

[-I]
[--Import|--Export]
/Files="{Path\files|Targets}"

[-N [-M] [-E]]
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Table 54: Program parameters and options

Parameter Description
or option

/Conn Database connection parameter. A user with a minimum access level of
Configuration user is required.

For more information about permissions, see the One Identity Manager
Installation Guide and the One Identity Manager Authorization and
Authentication Guide.

Alternatively, you can enter the name of the connection according to the
registry HKEY_CURRENT _
USER\Software\One Identity\One Identity Manager\Global\Connections.

/Auth Authentication data. The authentication data depends on the
authentication module used.

For more information about authentication modules, see the
One Identity Manager Authorization and Authentication Guide.

/Root (Optional) Files' installation directory.

- I (--Import) (Optional) Only in combination with /Files. If this parameter is not set,
only the files that are already known in the QBMFileRevision table are
imported. If this parameter is set, unknown files are also imported into
the database and an entry is created in the QBMFileRevision table.

Alternatively, the --Import command can be used.

--Export (Optional) Export files from the database to a local directory. Only in
combination with /Files

/Files List of files that are imported into the database or exported from the
database.

The files are specified including the directories below /Root. Machine roles
are pipe (|) delimited for import. No machine roles are entered for export.
The entry of wild cards (*) is permitted.

Example:
/Files="Custom.*.d1l1l|Server|Client"

/Files="CCC\Webshop\*|HTMLDevelopment"

-N (Optional) If the parameter exists, all files known in the QBMFileRevision
table and located in the directory specified in the /Root parameter are
updated. /Conn, /Auth and /Root are mandatory parameters in this
mode. -I and /Files are not taken into account.

-M (Optional) If the parameter exists, missing files will be ignored during
import. The parameter can be set in connection with parameter -N.
-E (Optional) If the parameter exists, all errors are ignored during import.
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Parameter Description
or option

The parameter can be set in connection with parameter =N.

-? Display program help.

Example: Updating files that are declared in the
QBMFileRevision table.
SoftwareLoaderCMD. exe

/Conn= "Data Source=<Database server>;Initial Catalog=<Database
name>;User ID=<Database user>;Password=<Password>"

/Auth="Module=DialogUser;User=<User name>;Password=<Password>"
/Root="c:\source"

-N

Example: Importing custom files

SoftwareLoaderCMD.exe

/Conn= "Data Source=<Database server>;Initial Catalog=<Database
name>;User ID=<Database user>;Password=<Password>"

/Auth="Module=DialogUser;User=<User name>;Password=<Password>"
/Root="c:\customsource"

-I

/Files="Custom.*.d11|Server|Client"

Related topics

» Importing and exporting individual files for the software update on page 137

DBTransporterCMD.exe

The DBTransporterCMD.exe program allows you to import transport packages into the
One Identity Manager database or export them from the database. You can run the
program from the command line.
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Calling syntax

DBTransporterCMD.exe
[-V]
[-L]
[-I|-P|-S]
[-N]
[-U]
[-A]
[-0]
/File="{Transport file}"
/Conn="{Connection string}"
/Auth="{Authentication String}"
[/MergeAction=Error|Transport|Database]
[/0Options]
[/Template]

Table 55: Program parameters and options

Parameter or Description
option

/Conn Database connection parameter. A user with a minimum access level of
Configuration user is required.

For more information about permissions, see the One Identity Manager
Installation Guide and the One Identity Manager Authorization and
Authentication Guide.

Alternatively, you can enter the name of the connection according to the
registry HKEY_CURRENT _

USER\Software\

One Identity\One Identity Manager\Global\Connections.

/Auth Authentication data. The authentication data depends on the
authentication module used. For more information about
One Identity Manager authentication modules, see the
One Identity Manager Authorization and Authentication Guide.

/File Path to the transport file.
/MergeAction  (Optional) Definition of conflict handling. Permitted values are:

e Error: An error occurred.

e Transport: (Default) Values are transferred from the transport
package.
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Parameter or Description

option

/Options

/Template

» Database: Database values are retained.

Special options for transport configuration.

Example: When transporting a synchronization project, start up config-
urations, variables and variable sets remain the same in the target
database.

/Options=0bjectFilter=KeepSettings

Example: The transport package description is redefined and the
database name removed.

/Options=Description=new description;DBName=;

Path to the transport template file in XML format. The transport
template contains the export criteria. The transport template is used to
create the transport file.

You create transport templates with the Database Transporter. For more
information, see Creating and using transport templates on page 118.

If this option is set, a log file is generated of the transport package
process. For further logging you can use the NLog functionality. For
more information about logging with NLog, see the

One Identity Manager Process Monitoring and Troubleshooting Guide.

If this option is set, errors in insertion and saving are ignored.
If this option is set, errors in insertion are ignored.

If this option is set, saves during insertion are ignored.

If this option is set, the database is not compiled.

If this option is set, the database is not set to single user mode.

If this option is set, sensitive data is removed from the transport. For
example, this will remove information about the database server, the
database, and users.

For internal use only.
(Optional) Provides additional information (verbose).

Display program help.

Example: Importing a transport package

DBTransporterCMD.exe
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-L
/File="c:\source\transport.zip"

/Conn= "Data Source=<Database server>;Initial Catalog=<Database
name>;User ID=<Database user>;Password=<Password>"

/Auth="Module=DialogUser;User=<User name>;Password=<Password>"

Example: Creating a transport package using a template file

DBTransporterCMD.exe
/Template=c:\data\<Template file>.xml
/File=c:\data\transport.zip

/Conn="Data Source=<Database server>;Initial Catalog=<Database
name>;User ID=<Database user>;Password=<Password>"

/Auth="Module=DialogUser;User=<User name>;Password=<Password>"

Related topics

» Creating transport packages with the Database Transporter on page 103

DataImporterCMD.exe

The DataImporterCMD.exe program provides support for importing data from CSV files into a
One Identity Manager database. You can run the program from the command line. The
program requires the import definition files for import. You create import definition files
using the Data Import program.

Calling syntax

DataImporterCMD.exe
/Conn="{Connection string}"
/Auth="{Authentication String}"
[/Prov="{Provider}"]
[/Definition="{Path to import definition file}"]
[/ImportFile="{Path to import file}"]
[/DefinitionPair="{Path to import definition file}|{Path to import file}"]
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[/LogLevel=0ff|Fatal|Error|Info|Warn|Debug|Trace]

[/Culture="{Language code}"]

[-p]

Table 56: Program parameters and options

Parameter or
option

Description

/Conn

/Auth

/Prov

/Definition

/ImportFile

/DefinitionPair

Database connection parameter. A user with a minimum access level of
End user is required.

For more information about permissions, see the One Identity Manager
Installation Guide and the One Identity Manager Authorization and
Authentication Guide.

Alternatively, you can enter the name of the connection according to
the registry HKEY_CURRENT _

USER\Software\

One Identity\One Identity Manager\Global\Connections.

Authentication data. The authentication data depends on the
authentication module used. For more information about

One Identity Manager authentication modules, see the

One Identity Manager Authorization and Authentication Guide.

(Optional) Database provider. The following values are permitted:
VI.DB.ViSqlFactory, VI.DB and
QBM.AppServer.Client.ServiceClientFactory, QBM.AppServer.Client.

Path to the import definition file.
Example:
C:\Path\To\Definition.xml

Path to the import file. Multiple instances of this parameter are
possible. The import definition file specified in the /Definition
parameter is used.

Example:
C:\Path\To\Import.csv

Pair of the import definition file and the import file. The files are
separated by a pipe character (|). Multiple instances of this parameter
are possible.

Example:
C:\Path\To\Definition.xml|C:\Path\To\Import.csv

/LogLevel (Optional) Scope of output to be processed. Permitted values are:
e Off: No logging.
e Fatal: All critical error messages are logged.
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Parameter or
option

Description

/Culture

Error: All error messages are logged.
e Info: All information is logged.
e Warn: All warnings are logged.

e Debug: Debugger outputs are logged. This setting should only be
used for testing.

e Trace: Highly detailed information is logged. This setting should
only be used for analysis purposes. The log file quickly becomes
large and cumbersome.

(Optional) Language used to create the file. The language is required in
order to read local character formats correctly, for example, dates.

Example: en-US
(Optional) If this parameter is used, the processing progress is shown.
(Optional) Provides additional information (verbose).

Display program help.

Example: Importing a single file

DataImporterCMD.exe

/Prov=VI.DB.ViSqlFactory, VI.DB

/Conn= "Data Source=<Database server>;Initial Catalog=<Database
name>;User ID=<Database user>;Password=<Password>"

/Auth=Module=DialogUserAccountBased

/Defintion=C:\Work\Import\Data\Def_DataImporter_Employee.xml

/ImportFile=C:\Work\Import\Data\l_Employees.csv

Example: Importing multiple files

DataImporterCMD.exe

/Prov=VI.DB.ViSqlFactory, VI.DB

/Conn= "Data Source=<Database server>;Initial Catalog=<Database
name>;User ID=<Database user>;Password=<Password>"
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/Auth=Module=DialogUserAccountBased

/DefinitionPair=C:\Work\Import\Data\Def_DataImporter_
Employee.xml|C:\Work\Import\Data\l_Employees.csv

/DefinitionPair=C:\Work\Import\Data\Def_DataImporter_
Department.xml|C:\Work\Import\Data\2_Departments.csv

/DefinitionPair=C:\Work\Import\Data\Def_DataImporter_
Locality.xml|C:\Work\Import\Data\3 Localities.csv

/DefinitionPair=C:\Work\Import\Data\Def_ DataImporter_
CostCenter.xml|C:\Work\Import\Data\4 CostCenters.csv

Related topics

e Importing data with the Data Import on page 120

SchemaExtensionCmd.exe

The SchemaExtensionCmd.exe program provides support for importing custom schema
extensions into a One Identity Manager database.

In databases with a Test environment or Development system staging level, you can use the
program to delete custom schema extensions again.

You can run the program from the command line. The program requires a control file (XML
file) for the import. To create control files, use the Schema Extension program. For more
information, see the One Identity Manager Configuration Guide.

Calling syntax

SchemaExtensionCmd.exe
/Conn="{Connection string}"
/Auth="{Authentication String}"
[/Definition="{Path to import definition file}"]
[-f]
[/LogLevel=0ff|Fatal|Error|Info|Warn|Debug|Trace]

Table 57: Program parameters and options

Parameter Description

or option
/Conn Database connection parameter. A user with a minimum access level of
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Parameter
or option

Description

/Auth

/Definition

/LogLevel

2 1h

Configuration user is required.

For more information about permissions, see the One Identity Manager
Installation Guide and the One Identity Manager Authorization and
Authentication Guide.

Alternatively, you can enter the name of the connection according to the
registry HKEY_CURRENT_
USER\Software\One Identity\One Identity Manager\Global\Connections.

Authentication data. The authentication data depends on the
authentication module used. For more information about

One Identity Manager authentication modules, see the

One Identity Manager Authorization and Authentication Guide.

Path to the control file (XML file)
Example:
C:\Path\To\Definition.xml
(Optional) Scope of output to be processed. Permitted values are:
e Off: No logging.
e Fatal: All critical error messages are logged.
e Error: All error messages are logged.
e Info: All information is logged.
e Warn: All warnings are logged.

e Debug: Debugger outputs are logged. This setting should only be
used for testing.

e Trace: Highly detailed information is logged. This setting should
only be used for analysis purposes. The log file quickly becomes
large and cumbersome.

(Optional) If this parameter is set, the system does not wait for
DBQueue Processor task processing. This can lead to errors if schema
extensions are expected that must previously be generated by the
DBQueue Processor.

(Optional) Provides additional information (verbose).

Display program help.
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Example:

SchemaExtensionCmd.exe

/Conn="Data Source=<Database server>;Initial Catalog=<Database
name>;User ID=<Database user>;Password=<Password>"

/Auth=Module=DialogUserAccountBased

/Definition=CustomExtensions.xml

CryptoConfigCMD.exe

The CryptoConfigCMD.exe program supports encryption and decryption of the
One Identity Manager database. You can run the program from the command line.

Calling syntax

CryptoConfigCMD. exe
--conn={Connection string}
--auth={Authentication string}
[ --mode=Encrypt|EncryptExisting|Decrypt]
[--private-key= {Path to private key}]

[-y]
Table 58: Program parameters and options

Parameter Alternative Description
or option

--conn --connection| Database connection parameter. A user with a minimum

—c access level of Configuration user is required.

For more information about permissions, see the
One Identity Manager Installation Guide and the
One Identity Manager Authorization and
Authentication Guide.

Alternatively, you can enter the name of the connection
according to the registry HKEY_CURRENT_
USER\Software\

One Identity

\One Identity Manager\Global\Connections.

--auth --auth- Authentication data for the installation. The authen-
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Parameter Alternative Description

or option
props|-a tication data depends on the authentication module used.
For more information about authentication modules, see
the One Identity Manager Authorization and
Authentication Guide.
--mode -m (Optional) Mode to run. Permitted values are:
e Encrypt: create a new private key and encrypt the
database (default)
e EncryptExisting: Encrypt the database with an
existing key
» Decrypt: Decrypt the database values.
--private-key -p Enter the file with the encryption information.
This path must not exist when encrypting a database. The
key can be found under this path after the encryption
process. This key file must be present when decrypting
the database.
-y (Optional) If the parameter is present, all security queries
are answered with Yes.
--verbose -V (Optional) Provides additional information (verbose).
--help -h, -? Display program help.

Parameter formats

Multiple-character options can be given in the following forms:

--conn="...

--conn

/conn="...

/conn

Single-character options can be given in the following forms:

Switches are allowed in the forms:
-R
/R
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Example: Encrypt the database with a new key

CryptoConfigCMD.exe

--conn="Data Source=<Database server>;Initial Catalog=<Database name>;
User ID=<Database user>; Password=<Password>"

--auth="Module=DialogUser;User=<User name>;Password=<Password>"

--private-key=C:\path\to\private.key

Example: Encrypt the database with an existing key

CryptoConfigCMD.exe

--conn="Data Source=<Database server>;Initial Catalog=<Database name>;
User ID=<Database user>; Password=<Password>"

--auth="Module=DialogUser;User=<User name>;Password=<Password>"

--mode=EncryptExisting

Example: Decrypt the database with an existing key

CryptoConfigCMD.exe

--conn="Data Source=<Database server>;Initial Catalog=<Database name>;
User ID=<Database user>; Password=<Password>"

--auth="Module=DialogUser;User=<User name>;Password=<Password>"
--mode=Decrypt
--private-key=C:\path\to\private.key

DBConsCheckCmd.exe

The DBConsCheckCmd.exe program supports consistency checking. You can run the program
from the command line.

Unlike the consistency checks in the Manager or the Designer, the table tests and object
tests are always carried out on the application data and system data.
Calling syntax

DBConsCheckCmd.exe
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[-1]

[-c]

[-p]

[-v]

[-x]

/Auth="{Authentication String}"
[/Category="{Category}]
/Conn="{Connection string}"
[/ConsistencyType="{Typel}"]
[/LogLevel=0ff|Fatal|Error|Info|Warn|Debug|Trace]
[/Resultfile="{File}"]
[/ResultIdToSkip="{Error ID}"]
[/TestSeverity=Info|Serious|Warning"]
[/UidConsistencyCheck="{UID}"]
[/UidConsistencyCheckToSkip="{UID}"]

Table 59: Program parameters and options

Parameter or option Description

-C (Optional) Outputs a list with all consistency checks
grouped by category. The program stops after output is
complete.

- (Optional) Outputs a list with all consistency checks
grouped by type. The program stops after output is

complete.

-p (Optional) If this parameter is used, the processing
progress is shown.

-V (Optional) Provides additional information (verbose).

-X (Optional) Test results not displayed.

/Auth Authentication data. The authentication data depends on

the authentication module used. For more information
about One Identity Manager authentication modules,
see the One Identity Manager Authorization and
Authentication Guide.

/Category (Optional) Category to use for the consistency checks.
Multiple instances of this parameter are possible.

The parameter cannot be combined with the
/ConsistencyType parameter.
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Parameter or option Description

Example: Configuration\Basics

/Conn Database connection parameter. A user with a minimum
access level of End user is required. Some consistency
checks require the configuration user or administrative
user access level.

For more information about permissions, see the
One Identity Manager Installation Guide and the
One Identity Manager Authorization and
Authentication Guide.

Alternatively, you can enter the name of the connection
according to the registry HKEY_CURRENT_
USER\Software\

One Identity

\One Identity Manager\Global\Connections.

/ConsistencyType (Optional) Type of consistency checks to be performed.
Multiple instances of this parameter are possible. If the
parameter is not specified, all types of consistency
checks are loaded. Permitted values are:

» Database: Runs consistency checks of database
test type.

» Table: Runs consistency checks of table test
type.
e Object: Runs consistency checks of object test
type.
The parameter cannot be combined with the
/UidConsistencyCheck parameter.

/LoglLevel (Optional) Scope of output to be processed. Permitted
values are:

e Off: No logging.

Fatal: All critical error messages are logged.
* Error: All error messages are logged.

e Info: All information is logged.

e Warn: All warnings are logged.

e Debug: Debugger outputs are logged. This setting
should only be used for testing.

e Trace: Highly more information is logged. This
setting should only be used for analysis purposes.
The log file quickly becomes large and
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Parameter or option

Description

/Resultfile

/ResultldToSkip

/TestSeverity

/UidConsistencyCheck

/UidConsistencyCheckToSkip

-2 | -h

cumbersome.

(Optional) Outputs the results of the consistency checks
to a separate results file. If the file already exists, it will
be overwritten.

(Optional) If the a consistency check results in errors,
unique error identifiers are assigned to each of the
results. If you supply these error IDs with this parameter
so that the error is ignored in the output and the result
file. Multiple instances of this parameter are possible.

(Optional) Severity of the consistency checks to be run.
Multiple instances of this parameter are possible.

Permitted values are:

» Info: Displays tests with the Error severity level.

» Serious: Displays tests with the Serious severity
level.

* Warning: Displays tests with the Warning severity
level.

(Optional) Provides the consistency check UID. If the
parameter is given, only this consistency check is run.
Multiple instances of this parameter are possible. If the
parameter is not given, all the consistency checks are
run.

The parameter cannot be combined with the
/ConsistencyType parameter.

Gives the UID of a consistency check not to run. If the
parameter is given, only this consistency check is not
run. Multiple instances of this parameter are possible. If
the parameter is not given, all the consistency checks
are run.

The parameter cannot be combined with the
/UidConsistencyCheck parameter.

Displays program help.

Example: Listing all consistency checks

DBConsCheckCmd.exe
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/Conn= "Data Source=<Database server>;Initial Catalog=<Database
name>;User ID=<Database user>;Password=<Password>"

/Auth="Module=DialogUser;User=<User name>;Password=<Password>"

-1

Example: Runs all available consistency checks and outputs a
result file

DBConsCheckCmd.exe

/Conn= "Data Source=<Database server>;Initial Catalog=<Database
name>;User ID=<Database user>;Password=<Password>"

/Auth="Module=DialogUser;User=<User name>;Password=<Password>"

/Resultfile="c:\temp\DBConsCheckCmd.log"

Example: Runs selected consistency checks, outputs a resulit file
and ignores an error

In the example, the two consistency checks DialogTable without Layout
information with UID QBM-C78A4C856111AF4CA839024588197F4B and Template uses
too long columns with UID QBM-F231939D9385514E9566F2900D8512E2 are run.

An error with the error ID 1a9cef@b6bd93434c2997341d91f2clef420f150 is ignored.
DBConsCheckCmd. exe

/Conn= "Data Source=<Database server>;Initial Catalog=<Database
name>;User ID=<Database user>;Password=<Password>"

/Auth="Module=DialogUser;User=<User name>;Password=<Password>"
/Resultfile="c:\temp\DBConsCheckCmd.log"
/UidConsistencyCheck="QBM-C78A4C856111AF4CA839024588197F4B"
/UidConsistencyCheck="QBM-F231939D9385514E9566F2900D8512E2"
/ResultIdToSkip="1a9cefOb6bd93434c2997341d91f2clef420f150"

Related topics

» Checking data consistency on page 88
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DatabaseAgentServiceCmd.exe

The DatabaseAgentServiceCmd.exe program deploys the Database Agent Service. The
Database Agent Service handles the database's internal tasks. For more information, see
the One Identity Manager Configuration Guide.

You can run the program from the command line.

Calling syntax

DatabaseAgentServiceCmd.exe

/conn "{Connection string}"

[/alive "{Path to file}"]

[-f]
[-s]
[-c]

Table 60: Program parameters and options

Parameter Description
or option
/Conn Database connection parameter. A user with a minimum access level of
Administrative user is required.
For more information about permissions, see the One Identity Manager
Installation Guide and the One Identity Manager Authorization and
Authentication Guide.
/alive (Optional) Path of file that show the Database Agent Service's status. The
status is checked on a 15 minute cycle.
-f (Optional) The Database Agent Service ignores the migration preparation
phases and runs even with older versions of the database.
-S (Optional) Messages are not output on the command line.
-C (Optional) Continue operating in the event of serious errors.
-? | -h Displays program help.
Create-web-dir.exe

With the program Create-web-dir.exe you can create a One Identity Manager installation
from a directory containing a One Identity Manager setup or from an installed
One Identity Manager database. You can find the program on the installation media in the
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Modules\QBM\dvd\AddOn\SDK\LinuxWebInstall directory. You can run the program from the
command line.

Calling syntax

create-web-dir.exe
[ --mode=web | standalone]
--setup={Directory}|[--db-system=MSSQL | APPSERVER]
--db="{Connection string}"
--dest={Directory}
[ --modules={Module IDs}]
--targets= "{Targets}"
[--nlog={Path}\nlog.config]
[--web-config={Path}\appsettings.json]
[--web-app={URL}]
[--web-app-project={Web project}]
[--web-app-product={Product}]
[--web-app-auth={Authentifier}]
[--web-app-auth2={Authentifier}]
[--session-cert={Path}\SessionCertificate.pfx]
[--create-session-cert]
[--session-cert-issuer="{Issuer}"]
[--appserver-url={URL}]
[--auth="Module={Authentication string}"]
[--server-name --targets-from-server --config-from-server]
[--variable{Key=Value}]
[--nologo]

Calling the program

e Windows: C:/installer/create-web-dir.exe

e Linux: mono /installer/create-web-dir.exe

Table 61: Program parameters and options

Parameter Alternative Description

or option

--mode Installation mode. Permitted values are web (default) and
standalone.
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Parameter Alternative Description

or option

--setup -S Directory that contains the One Identity Manager setup
and from which the installation is to be compiled. Specify
either the directory containing the One Identity Manager
setup or a database connection.

--db-system Database system that should be connected as a source.
Permissible values are MSSQL (default) or APPSERVER,

--db -connect Connection parameters to the database from which the
installation is to be made. Specify either the directory
containing the One Identity Manager setup or a database
connection.

--dest -d Destination directory for the installation.

--targets -t Comma-delimited list of machine roles to be installed.

--modules -m Comma-delimited list of module IDs for installation.
Optional, if the installation is to be done from an existing
database.

--nlog -n (Optional) Path for the configuration file NLog.config.

--web-config -w (Optional) Path for configuration file appsettings.json.

--web-app (Optional) URL for which a web application is to be
created in the database.

--web-app- (Optional) Name of the product for the web application

product (QBMProduct.Ident_Product) or UID of the product for the
web application (QBMProduct.UID_DialogProduct).

--web-app- (Optional) Name of the primary authentication module

auth (DialogAuthentifier.Ident_DialogAuthentifier) or UID
of the primary authentication module
(DialogAuthentifier.UID_ DialogAuthentifier) for the
web application.

--web-app- (Optional) Name of the secondary authentication module

auth2 (DialogAuthentifier.Ident_DialogAuthentifier) or UID
of the secondary authentication module
(DialogAuthentifier.UID_ DialogAuthentifier) for the
web application.

--session- -C (Optional) Path and name of the certificate file.

cert

--Create- (Optional) Generate a new certificate if the specified

session-cert
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Parameter Alternative Description

or option

--session- (Optional) Publisher for the generated certificate file.

cert-issuer Standard: "CN=Application Server"

--appserver- (Optional) URL of the application server to which the web

url application is to be connected.

--auth (Optional) Authentication data. The authentication data
depends on the authentication module used. For more
information about One Identity Manager authentication
modules, see the One Identity Manager Authorization and
Authentication Guide.

--config- (Optional) Fetches the configuration of the

from-server

--targets-
from-server

--server-
name
--variable

--nologo

--help

One Identity Manager Service for the Job server from the
database and creates the configuration file in the
destination directory. If this parameter is set, the --
server-name parameter is required.

(Optional) Fetches the Job server machine roles from the
database. If this parameter is set, the --server-name
parameter is required.

(Optional) Name of the Job server in the database
(QBMServer table).

-V (Optional) Replace the variables in the template files
(NLog.config, appsettings.json) specified with
%VariableName%. (Key=Value).

(Optional) Specifies whether to display the startup
banner and copyright information.

-h, -? Display program help.

Example: Installing an application server from a directory

create-web-dir.exe

-s=I:\Main\2020.07.28.001

-d=C:\Work\Install

m=ADS, ARS, CAP, CPL,DPR, EBS, EX®, LDP,NDO, QBM, QER, RMB, RMS , SAC, SAP, SBW, SHR, S

PO, TSB
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t=Server\Web\AppServer,Server\Web\AppServer\SearchCrawler,Server\Web\Ap
pServer\SearchIndex

-w=\work\Config\appsettings.json
-n=\work\Config\nlog.config

-c=\work\SessionCertificate.pfx

Example: Installing an application server from the database

create-web-dir.exe
-d=C:\Work\Install

--db-connect="Data Source=<Server>;Initial Catalog=<Database>;User
ID=<DB User>;Password=<Password>"

t=Server\Web\AppServer,Server\Web\AppServer\SearchCrawler,Server\Web\Ap
pServer\SearchIndex

-w=\work\Config\appsettings.json
-n=\work\Config\nlog.config

-c=\work\SessionCertificate.pfx

Example: Installing a Job server from the database with the default
machine roles
create-web-dir.exe

--mode=standalone

-d=C:\Work\Install

--db-connect="Data Source=<Server>;Initial Catalog=<Database>;User
ID=<DB User>;Password=<Password>"

-t=Server\Jobserver
--server-name=Serverl

--targets-from-server

@NE IDENTITY One Identity Manager 9.3 Operational Guide 189

by Quest Appendix: Command line programs




Appendix B

Configuration of settings for the
One Identity Manager tools

General configuration settings for One Identity Manager tools can be specified in a
appsettings.json configuration file. The settings apply globally to all
One Identity Manager tools.

Table 62: General configuration settings

Setting Description
Cache User-defined cache directory for data from the database.
AssemblyCache User-defined cache directory for storing script assemblies.

CacheReloadInterval  Time in seconds after which the local cache should be updated.
This parameter overwrites the setting in the Common |
CacheReload | Interval configuration parameter.

NoReloadBeep If this is set, it mutes the beep made when cached system data is
being reloaded.

For an example configuration, see the appsettings.json configuration file in the
One Identity Manager installation directory. To use the settings in the sample
configuration, remove the comments and save the changes.

Example: Example configuration in the appsettings.json
configuration file

e N

"RuntimeDirs": {

// Set the cache directories to a user defined place

// "Cache": "C:\\Temp\\OneIM\\AppServerCache\\DB",

// "AssemblyCache": "C:\\Temp\\OneIM\\AppServerCache\\Assemblies"
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}s

"ConnectionBehaviour": {
// "CacheReloadInterval": "30",
// "NoReloadBeep": "true"

}

Use application-specific configuration files for special configuration settings of individual
One Identity Manager components.

The configuration files are stored in the One Identity Manager installation directory with the
name appsettings.<appName>.json, where appName is the name of the
One Identity Manager component.

Example: appsettings.Manager.json

Related topics

» Loading configuration values from Azure Key Vault on page 191

Loading configuration values from
Azure Key Vault

It is possible to load secrets, such as connection strings, from Azure Key Vault and use
them in the appsettings.json configuration file. To do this, configure the Azure Key Vault
configuration provider.

Fore more information, see under Azure Key Vault in the Microsoft documentation.

Table 63: Configuration settings for Azure Key Vault

Setting Description

KeyVaultName Name of the Azure Key Vault. You will find the name in the Microsoft
Azure Management Portal (https://portal.azure.com/).

Prefix If there is only a subset of values available as configuration options,
define a prefix.

Secrets are filtered according to this prefix, the prefix itself is removed
from the resulting configuration setting.

KeyDelimiter Character string used to delimit hierarchy levels in the configuration.
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Setting Description

The default delimiter is two hyphens (--). Colons (:) are not supported
as delimiters.

Example: Using Azure Key Vault configuration providers

e 7

"ConfigProviders": {
"AzureKeyVault": {
"Class": "AzureKeyVault",
// Alternatively, the full name: "Class": "VI.Base.Con-
fig.AzureKeyVault.AzureKeyVaultConfigProvider, VI.Base.Config.AzureKeyVault",
"KeyVaultName": "Key Vault Name",
"Prefix": "Prefix",
"KeyDelimiter": "--"
}
}

Example: Determining connection strings for application servers

Configure the following settings for the Azure Key Vault in the appsettings.json
configuration file.

r z

"ConfigProviders": {
"AzureKeyVault": {
"Class": "AzureKeyVault",
"KeyVaultName": "OneIM-General-KeyVault",
"Prefix": "OneIM-DEV-",
"KeyDelimiter": "-"

& J
The secret with the name OneIM-DEV-ConnectionStrings-AppServerDb is mapped in

the configuration as ConnectionStrings:AppServerDb. This corresponds to this
section in the appsettings.json configuration file.

e 3
{
"ConnectionStrings": {
"AppServerDb": "..."
}
}
- J
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About us

One Identity solutions eliminate the complexities and time-consuming processes often
required to govern identities, manage privileged accounts and control access. Our solutions
enhance business agility while addressing your IAM challenges with on-premises, cloud and
hybrid environments.

Contacting us

For sales and other inquiries, such as licensing, support, and renewals, visit
https://www.oneidentity.com/company/contact-us.aspx.

Technical support resources

Technical support is available to One Identity customers with a valid maintenance contract
and customers who have trial versions. You can access the Support Portal at
https://support.oneidentity.com/.

The Support Portal provides self-help tools you can use to solve problems quickly and
independently, 24 hours a day, 365 days a year. The Support Portal enables you to:

e Submit and manage a Service Request

» View Knowledge Base articles

e Sign up for product notifications

» Download software and technical documentation

e View how-to videos at www.YouTube.com/Oneldentity
e Engage in community discussions

e Chat with support engineers online

e View services to assist you with your product
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